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Capitolo 1. Introduzione a GnuCash
Cos’è GnuCash?

GnuCash è un’applicazione per la gestione delle finanze personali e di piccole attività. È progettato per
essere facile da usare, ma comunque potente e flessibile. GnuCash permette di registrare le entrate e le
uscite, di riconciliare i conti bancari, di monitorare le azioni e di amministrare le finanze della propria
attività professionale. È basato sulle leggi fondamentali della contabilità per assicurare registrazioni in
bilancio e resoconti accurati.
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Capitolo 2. Utilizzare questo
documento e ottenere assistenza

Questo documento è consultabile in due modi:

• tramite le descrizioni dei componenti dell’interfaccia grafica (GUI) si accede alle spiegazioni delle op-
zioni disponibili e alle loro funzioni, con collegamenti alle descrizioni più approfondite e alle istruzioni
di utilizzo; Capitolo 4, Panoramica delle finestre e delle opzioni del menu di GnuCash;

• classificando operazioni, compiti, o funzioni a seconda che si tratti di un conto, di una transazione, di
un resoconto o altre operazioni particolari. Per esempio possono essere:

• Operazioni sui conti - Capitolo 5, Impostare, modificare e lavorare con i conti

• Operazioni con transazioni e registro - Capitolo 6, Operazioni comuni per le transazioni

• Strumenti e assistenti - Capitolo 7, Strumenti e assistenti

• Resoconti e grafici - Capitolo 8, Resoconti e diagrammi

• Personalizzazione - Capitolo 9, Personalizzare GnuCash

Accedere all’aiuto
Questa finestra viene visualizzata accedendo al menu Aiuto e scegliendo o Guida ai concetti e manuale
oppure Sommario (F1). la sezione chiamata «Struttura dei conti - Menu Aiuto»

La finestra di aiuto ha una barra degli strumenti il cui significato è descritto nel seguito.

• Indietro mostra l’argomento visualizzato in precedenza.

• Avanti mostra l’argomento visualizzato in precedenza.

• Aiuto permette di accedere alle pagine di aiuto di GNOME.

• Cerca Inserire qui il termine da ricercare nell’Aiuto di GNOME. Non cerca nell’aiuto di GnuCash.

Il lato destro della finestra di aiuto mostra la pagina attualmente aperta. Il lato sinistro contiene invece la
lista degli argomenti. Selezionando uno degli argomenti dell’aiuto, la corrispondente pagina verrà aperta
nella finestra di destra.

Guida ai concetti e manuale di GnuCash
La guida è il complemento a questo aiuto; spiega infatti i concetti utilizzati in GnuCash e presenta un esem-
pio che accompagna l’utente attraverso tutte le fasi dell’utilizzo di GnuCash per gestire i propri conti. La
guida verrà aperta se si sceglie Aprire la guida per i nuovi utenti nella finestra di Benvenuto in GnuCash!.

Per aprire questa guida selezionare Aiuto → Guida ai concetti e manuale dal menu.

Si raccomanda di leggere questa guida se si sta utilizzando GnuCash per la prima volta o se non si ha
familiarità con i concetti della contabilità.
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Assistenza on-line di GnuCash
Citando il suggerimento del giorno «gli sviluppatori di GnuCash sono facilmente contattabili». GnuCash
ha diverse liste di discussione dedicate:

• Lista degli utenti <gnucash-user@gnucash.org>: è indirizzata alle domande degli utenti e alle
discussioni in generale. Gli sviluppatori e alcuni utenti molto disponibili, si ritrovano qui.

• Lista degli sviluppatori <gnucash-devel@gnucash.org>: vengono discusse le questioni ri-
guardanti la progettazione e lo sviluppo di GnuCash, e la presentazione di patch.

• È anche possibile utilizzare la chat di IRC e discutere in diretta con gli sviluppatori! Unisciti a loro su
#gnucash at irc.gnome.org. Altre risorse sono disponibili sul  sito di GnuCash [http://www.gnucash.org]
come i collegamenti al WIKI e a Bugzilla.

http://www.gnucash.org
http://www.gnucash.org
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Capitolo 3. Per iniziare
Avviare GnuCash

GnuCash può essere avviato dal menu principale del proprio sistema selezionando la relative voce del
menu.

In alternativa può essere avviato da linea di comando con il comando gnucash.

Durante l’avvio di GnuCash verrà mostrata la schermata di avvio di GnuCash in cui sono visualizzate
alcune informazioni relative al programma e al processo di caricamento.

Schermata Impossibile trovare i valori predefiniti
Quando GnuCash viene avviato per la prima volta, sarà presentata la schermata titolata Impossibile trovare
i valori predefiniti con tre scelte possibili:

• Esci — esce da GnuCash.

• Salta — prosegue l’avvio senza impostare alcun valore predefinito di visualizzazione per GnuCash.

• Imposta — visualizzerà la schermata di Aggiornamento dei dati di configurazione di GnuCash (la se-
zione chiamata «Assistente per l’Aggiornamento dei dati di configurazione di GnuCash») che avvia la
procedura di impostazione.

Assistente per l’Aggiornamento dei dati di configurazio-
ne di GnuCash

L’assistente per l’Aggiornamento dei dati di configurazione di GnuCash, si avvia con una schermata che
visualizza una breve descrizione della sue funzionalità. I tre pulsanti sul fondo della finestra non cambie-
ranno fino all’ultima schermata della procedura guidata.

• Annulla — esce dall’assistente.

Avvertimento

Se si preme questo pulsante, qualsiasi selezione fatta fino a questo punto verrà persa.

• Indietro — fa apparire la schermata precedente in modo da poter modificare una selezione fatta in quella
finestra.

• Avanti — permette di avanzare nella procedura guidata.

La seconda schermata è dedicata alla Scelta del metodo di configurazione di gconf per GnuCash. In que-
sta pagina vengono descritte le opzioni Aggiorna il percorso di ricerca e Installa nella cartella home, e le
relative conseguenze della scelta. Scegliendo Aggiorna il percorso di ricerca verrà modificato il percorso
.gconf nella cartella home dell’utente. L’altra scelta, Installa nella cartella home installerà i file di con-
figurazione nella cartella .gconf contenuta nella cartella home dell’utente.

Dopo aver effettuato la scelta, premere Avanti per procedere alla schermata successiva.

Se è stata scelta l’opzione Installa nella cartella «home» la pagina successiva fornirà tre scelte:
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• GnuCash installerà i dati.

• L’utente installerà i dati.

• I dati sono già stati installati in un’altra finestra.

Se è invece stata scelta l’opzione Aggiorna il percorso di ricerca la pagina successiva fornirà tre scelte:

• GnuCash aggiornerà il percorso di ricerca.

• L’utente aggiornerà il percorso di ricerca.

• Il percorso di ricerca è già stato aggiornato in un’altra finestra.

La schermata finale presenta i soliti tre pulsanti, con la differenza che il pulsante Avanti è stato sostituito
con Applica. Premendo quest’ultimo pulsante verranno applicate le scelte effettuate nella procedura e verrà
completata la procedura per i valori predefiniti iniziali. Verrà quindi aperta la schermata di Benvenuto in
GnuCash! (la sezione chiamata «Schermata di Benvenuto in GnuCash!»).

Schermata di Benvenuto in GnuCash!
Dopo il completamento della procedura, verrà visualizzata la finestra di Benvenuto in GnuCash! che pre-
senta un menu con tre scelte possibili:

• Creare un nuovo gruppo di conti — Avvia l’assistente per Impostare una nuova struttura dei conti (la
sezione chiamata «Impostare una nuova struttura dei conti»). Selezionare questa opzione per essere
assistiti nella creazione di un gruppo di conti.

• Importare file QIF — Avvia l’assistente per l’Importazione dei file QIF (la sezione chiamata «Impor-
tare i file QIF»). Selezionare questa opzione se si devono importare in GnuCash dei file di Quicken
(estensione .qif) provenienti da un’altra applicazione finanziaria.

• Aprire la guida per i nuovi utenti — Apre la guida ai concetti e manuale di GnuCash. Selezionare questa
opzione se si è alla prima esperienza con GnuCash e con i concetti di contabilità.

Nota

È possibile eseguire le operazioni elencate anche dopo aver effettuato una scelta nella finestra, ma
il menu di Benvenuto in GnuCash! non verrà visualizzato di nuovo. Per provare le altre scelte in
un secondo momento, consultare la sezione chiamata «Impostare una nuova struttura dei conti»,
la sezione chiamata «Importare i file QIF» e la sezione chiamata «Guida ai concetti e manuale di
GnuCash» per sapere come avviarle dal menu di GnuCash.

Questa schermata è stata pensata per consentire all’utente di GnuCash di iniziare immediatamente a uti-
lizzare il programma. Il pulsante Annulla permette di chiudere la schermata. Premendolo verrà richiesto
se Mostrare di nuovo la finestra di benvenuto. Per non far visualizzare di nuovo la schermata di Benvenuto
in GnuCash! fare clic sul pulsante No. Fare clic su Sì o premere il tasto Invio della tastiera per selezio-
nare l’opzione predefinita che prevede la riapertura al prossimo avvio della schermata di Benvenuto in
GnuCash!.

Nota

Qualsiasi opzione venga selezionata, verrà aperta una finestra di GnuCash minimale. Le opera-
zioni disponibili in questa finestra sono descritte in Capitolo 4, Panoramica delle finestre e delle
opzioni del menu di GnuCash.
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Impostare una nuova struttura dei conti
Questa procedura assiste l’utente nella creazione di un gruppo di conti in GnuCash. Apparirà se verrà
selezionato Crea nuova struttura conti nel menu di Benvenuto in GnuCash!.

Verrà così creato un nuovo file vuoto di GnuCash e avviato automaticamente l’assistente per
l’Impostazione di una nuova struttura dei conti.

Suggerimento

Per avviare l’assistente manualmente, andare in File → Nuovo per creare un nuovo file. Per

avviare l’assistente all’interno di un file aperto, andare in Operazioni → Nuova struttura conti...
quando è visualizzata la scheda della struttura dei conti.

1. L’assistente per l’Impostazione di una nuova struttura dei conti si apre con una schermata che descrive
brevemente la sua funzione. I tre pulsanti in basso nella finestra non cambieranno durante tutte le fasi
di utilizzo dell’assistente.

• Annulla — esce dall’assistente e annulla la creazione di una nuova struttura dei conti.

Avvertimento

Se si preme questo pulsante, qualsiasi selezione fatta fino a questo punto verrà persa.

• Indietro — fa apparire la schermata precedente in modo da poter modificare una selezione fatta in
quella finestra.

• Avanti — permette di avanzare nella procedura guidata.

2. La schermata successiva permette la Scelta della valuta da utilizzare come predefnita per i conti.

• La lista a comparsa Valuta: è impostata al valore configurato nella scheda Conti delle Preferenze di
GnuCash (la sezione chiamata «Conti»). Per assegnare ai propri conti una valuta predefinita diffe-
rente, basta selezionarla dalla lista.

• Il tasto Avanti è utilizzato per confermare la selezione e procedere alla schermata successiva.

3. La schermata successiva riguarda la Scelta dei conti da creare.

Verrà visualizzata una schermata suddivisa in tre parti

• La parte in alto a sinistra presenta una lista di Categorie per le strutture di conti più comunemente
utilizzate. Selezionare dalla lista quella che si desidera utilizzare. È possibile selezionare tutte le
categorie che si desidera.

• La porzione in basso a sinistra presenta una Descrizione della categoria che mostra una descrizione
dettagliata della categoria selezionata.

• La porzione di destra riporta la lista dei Conti che verranno creati dalla categoria selezionata.

• Il pulsante Seleziona tutto permette di includere tutte le categorie disponibili.

• Il pulsante Cancella tutto permette di deselezionare tutte le categorie selezionate.

4. La schermata successiva riguarda l’Impostazione dei conti selezionati che prevede l’inserimento dei
Bilanci di apertura e l’eventuale marcatura dei conti come Segnaposto.
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Nota

I conti dei capitali non hanno un bilancio di apertura pertanto questo campo è bloccato e
impostato a zero da GnuCash.

Nota

I conti segnaposto sono utili per creare una struttura dei conti e normalmente non hanno né
transazioni né bilancio di apertura.

Seguire le istruzioni a video su come selezionare un conto e inserire il bilancio di apertura. Un singolo
clic permette di selezionare un conto.

• Sul lato sinistro della schermata, c’è una lista dei Nomi dei conti. Selezionare un conto con un singolo
sul clic sul suo nome: verrà così aperto il campo del nome per applicare dei cambiamenti.

• Il lato destro fornisce delle opzioni selezionabile attraverso le quali è possibile indicare se il conto
è un Segnaposto e un campo per aggiungere il Bilancio d’apertura per il conto selezionato. Anche
qui un singolo clic nella colonna del Bilancio d’apertura o nella colonna Segnaposto apre il relativo
campo per effettuare dei cambiamenti.

5. La schermata di Conclusione della configurazione dei conti è l’ultima e fornisce una descrizione delle
tre scelte possibili per terminare l’assistente.

• Annulla — esce dall’assistente e annulla la creazione di una nuova struttura dei conti.

Avvertimento

Se si preme questo pulsante, qualsiasi selezione fatta fino a questo punto verrà persa.

• Indietro — fa apparire la schermata precedente in modo da poter modificare una selezione fatta in
quella finestra.

• Applica — crea i conti che sono stati selezionati.

Si dovrebbe ora avere una struttura dei conti nella finestra principale di GnuCash.

Importare i file QIF
Questo assistente assiste nell’importazione di file Quiken (QIF). Verrà aperto se si seleziona Importare
file QIF nella finestra di Benvenuto in GnuCash!.

Per avviare manualmente l’assistente, andare in File → Importa... → Importa QIF....

Nel seguito tutte le schermate che possono essere visualizzate in questo assistente sono descritte in ordine
di apparizione.

1. L’ assistente per l’Importazione dei file QIF si avvia presentando una finestra contenente una breve
descrizione delle sue funzionalità. I tre pulsanti in basso nella finestra non cambieranno durante tutte
le fasi di utilizzo dell’assistente.

• Annulla — esce dal processo e annulla l’importazione di file QIF.
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Avvertimento

Se si preme questo pulsante, qualsiasi selezione fatta fino a questo punto verrà persa.

• Indietro — fa apparire la schermata precedente in modo da poter modificare una selezione fatta in
quella finestra.

• Avanti — permette di avanzare nella procedura guidata.

2. Nella schermata successiva verrà richiesto di Scegliere un file QIF da caricare. Il pulsante Seleziona... in
questa finestra permette di accedere alla lista di file e cartelle aprendo il dialogo per Scegliere il file QIF.

Navigare fino alla posizione in cui sono stati salvati i propri file QIF; selezionare il primo fra quelli che
si desidera importare e premere Importa. La schermata successiva visualizzerà il nome del file nella
finestra per Scegliere il file QIF da importare..

Nota

Se il file che si sta caricando non possiede una data QIF verrà visualizzata la finestra per Im-
postare un formato di data per il file QIF. Selezionare quello appropriato dal menu a comparsa
e continuare.

Nota

Se il file che si sta caricando non contiene un nome del conto verrà visualizzata la finestra
per Impostare il nome predefinito del conto QIF. Diversamente verrà invece visualizzata la
finestra descritta nella prossima sezione dove saranno visualizzati i file QIF caricati.

• Il campo del Nome del conto: permette di impostare un nome del conto per il file QIF.

3. La pagina successiva visualizza i File QIF che sono stati caricati. È possibile tornare alla pagina pre-
cedente e selezionare altri file QIF. Qui è anche possibile eliminare qualsiasi file che sia stato caricato
per errore.

• Il pannello superiore visualizza l’elenco dei file QIF che sono stati caricati.

• Il pulsante Carica un altro file riporta alla schermata precedente per aggiungere alla lista un ulteriore
file QIF.

• Il pulsante Scarta il file selezionato permette, dopo aver selezionato un file nell’elenco presente nel
riquadro superiore, di rimuoverlo dall’elenco.

Quando sono stati selezionati tutti i file QIF da importare, fare clic sul pulsanti Avanti.

4. A seconda del tipo di dati contenuti nei file QIF da importare, verranno visualizzate una o più delle
seguenti schermate:

Conti e azioni Questa schermata fornisce una descrizione del processo di associazione di Conti e
azioni che avverrà nella schermata successiva relativa all’Associazione dei conti
QIF ai conti di GnuCash.
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Suggerimento

Questa e le altre schermate informative dell’assistente all’Importazione
di file QIF possono essere disabilitate nella scheda Online Banking (la
sezione chiamata «Online Banking») delle Preferenze di GnuCash.

La pagina successiva permette l’Associazione dei conti QIF ai conti di GnuCash.
Verrà mostrata una lista di Nomi dei conti QIF a sinistra e, a destra, il Nome del
conto GnuCash suggerito. La colonna Nuovo? indica se il nome del conto di Gnu-
Cash verrà creato dalla procedura di importazione.

Per cambiare il conto di GnuCash è necessario selezionare il conto QIF; apparirà
una finestra in cui sarà possibile selezionare un altro conto o crearne uno nuovo.

• Selezionare un conto dalla lista per utilizzarne uno già esistente.

• Il pulsante Nuovo conto permette di aggiungere un nuovo nome di conto come
sottoconto (figlio) del conto selezionato.

• Il pulsante OK permette di confermare la selezione.

• Il pulsante Annulla permette di uscire dalla finestra di dialogo scartando tutte le
scelte effettuate.

Categorie di en-
trate e uscite

Questa schermata fornisce una descrizione del processo di associazione delle Cate-
gorie di entrate e uscite nella schermata successiva relativa all’Associazione delle
categorie QIF ai conti di GnuCash.

Suggerimento

Questa e le altre schermate informative dell’assistente all’Importazione
di file QIF possono essere disabilitate nella scheda Online Banking (la
sezione chiamata «Online Banking») delle Preferenze di GnuCash.

La pagina successiva permette l’Associazione delle categorie QIF ai conti di Gnu-
Cash. Verrà mostrata una lista di Nomi della categoria QIF a sinistra e, a destra,
il Nome del conto GnuCash suggerito. La colonna Nuovo? indica se il nome del
conto di GnuCash verrà creato dalla procedura di importazione.

Per cambiare il conto di GnuCash è necessario selezionare la categoria QIF; appa-
rirà una finestra in cui sarà possibile selezionare un altro conto o crearne uno nuovo.

• Selezionare un conto dalla lista per utilizzarne uno già esistente.

• Il pulsante Nuovo conto permette di aggiungere un nuovo nome di conto come
sottoconto (figlio) del conto selezionato.

• Il pulsante OK permette di confermare la selezione.

• Il pulsante Annulla permette di uscire dalla finestra di dialogo scartando tutte le
scelte effettuate.

Beneficiari e
promemoria

Questa schermata fornisce una descrizione del processo di associazione di Bene-
ficiari e promemoria che avverrà nella schermata di Associazione di beneficiari e
promemoria ai conti di GnuCash.
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Suggerimento

Questa e le altre schermate informative dell’assistente all’Importazione
di file QIF possono essere disabilitate nella scheda Online Banking (la
sezione chiamata «Online Banking») delle Preferenze di GnuCash.

La pagina successiva permette l’Associazione di beneficiari e promemoria ai conti
di GnuCash. Verrà mostrata una lista di Nomi di beneficiari e promemoria QIF a
sinistra e, a destra, i Nomi dei conti di GnuCash suggeriti. Il conto predefinito di
GnuCash utilizzato in questa fase ha un nome Non specificato. La colonna Nuovo?
indica se il nome del conto di GnuCash verrà creato dalla procedura di importa-
zione.

Per cambiare il conto di GnuCash è necessario selezionare il beneficiario e prome-
moria QIF; apparirà una finestra in cui sarà possibile selezionare un altro conto o
crearne uno nuovo.

• Selezionare un conto dalla lista per utilizzarne uno già esistente.

• Il pulsante Nuovo conto permette di inserire un nuovo nome di conto come sot-
toconto del conto selezionato.

• Il pulsante OK permette di confermare la selezione.

• Il pulsante Annulla permette di uscire dalla finestra di dialogo scartando tutte le
scelte effettuate.

5. La schermata successiva consente di Immettere la valutadel file QIF. La lista a comparsa fornisce la
valuta predefinita configurata nella scheda Conti (la sezione chiamata «Conti»)delle Preferenze di Gnu-
Cash. Per utilizzarne una diversa, selezionarla dalla lista.

Dopo aver selezionato la valuta, premere Avanti.

6. A seconda del tipo di dati contenuti nei file QIF da importare, potrebbero essere visualizzate una o più
delle seguenti schermate:

Commodity
scambiabili

Questa schermata fornisce una descrizione del processo delle Commodity scam-
biabili.

Suggerimento

Questa e le altre schermate informative dell’assistente all’Importazione
di file QIF possono essere disabilitate nella scheda Online Banking (la
sezione chiamata «Online Banking») delle Preferenze di GnuCash.

Una serie di schermate per ogni azione, fondo comune o commodity, visualizza il
cambio, il nome comnpleto e il simbolo per ogni commodity elencata nel file QIF
che si sta importando in modo che sia possibile controllarne le informazioni prima
di procedere.

Transazioni cor-
rispondenti

Questa schermata fornisce una descrizione del processo di associazione delle Tran-
sazioni corrispondenti che avverrà nella seguente schermata di Selezione dei pos-
sibili duplicati.
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Suggerimento

Questa e le altre schermate informative dell’assistente all’Importazione
di file QIF possono essere disabilitate nella scheda Online Banking (la
sezione chiamata «Online Banking») delle Preferenze di GnuCash.

La schermata successiva permette di Selezionare i possibili duplicati tra le transa-
zioni. Le transazioni importate sono visualizzate nel riquadro di sinistra e le possi-
bili transazioni corrispondenti sono riportate a destra.

• Il riquadro di sinistra mostra l’elenco delle transazioni importate tra cui selezio-
nare i duplicati.

• Il riquadro di destra mostra l’elenco dei possibili duplicati delle transazioni sele-
zionate per l’importazione. Selezionare quella con la corrispondenza più adatta

7. L’ultima schermata, Aggiornare i conti di GnuCash, fornisce una lista di tre scelte possibili per uscire
dall’assistente.

• Annulla — esce dal processo e annulla l’importazione di file QIF.

Avvertimento

Se si preme questo pulsante, qualsiasi selezione fatta fino a questo punto verrà persa.

• Indietro — fa apparire la schermata precedente in modo da poter modificare una selezione fatta in
quella finestra.

• Avanti — importa i dati e crea i conti specificati.

A questo punto i conti dovrebbero essere stati importati correttamente.

Suggerimento del giorno
La finestra del Suggerimento del giorno si apre all’avvio di GnuCash a meno che questa funzione non sia
stata disabilitata. I suggerimenti del giorno forniscono dei consigli sulle caratteristiche e sull’utilizzo di
GnuCash. In basso nella finestra sono presenti tre pulsanti che permettono di muoversi tra i suggerimenti.

• Chiudi — chiude la finestra del Suggerimento del giorno.

• Indietro — visualizza il suggerimento precedente.

• Avanti — visualizza il suggerimento successivo.

• L’opzione Visualizza i suggerimenti all’avvio è utile per abilitare o disattivare il Suggerimento del
giorno all’avvio di GnuCash.

È anche possibile configurare l’opzione di avvio del Suggerimento del giorno nella scheda Generali delle
Preferenze di GnuCash. Il Suggerimento del giorno può anche essere avviato manualmente dal menu Aiuto

→ Suggerimento del giorno.
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Capitolo 4. Panoramica delle finestre e
delle opzioni del menu di GnuCash

La finestra principale di GnuCash mostra i conti, i resoconti, le voci dei menu e gli strumenti disponibili per
l’elaborazione dei propri dati finanziari. Questa sezione fornisce una panoramica delle differenti finestre
e sezioni di finestre che si incontreranno utilizzando GnuCash.

I collegamenti nelle varie tabelle forniranno ulteriori dettagli sull’argomento.

Finestre e menu di GnuCash
Finestra principale di GnuCash

L’accesso alle schermate secondarie utilizzate più comunemente e agli strumenti del conto, avviene attra-
verso questa finestra.

Figura 4.1. La finestra principale di GnuCash

Le parti in cui è suddivisa la finestra principale di GnuCash.

All’avvio di GnuCash, dopo un paio di finestre (Schermata di avvio e suggerimento del giorno) apparirà
la finestra principale. Questa è suddivisa nelle seguenti sezioni (vedere Figura 4.1, «La finestra principale
di GnuCash» per un riferimento):

Barra del titolo Mostra il nome del file aperto e il nome della scheda
visualizzata

Barra del menu Visualizza le voci di menu disponibili
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Barra degli strumenti Visualizza i pulsanti della barra degli strumenti di-
sponibili

Barra delle schede Elenca i resoconti, i registri e le strutture dei conti
aperti

Riquadro principale Lo spazio di visualizzazione principale in cui viene
mostrato il contenuto della scheda selezionata

Barra di riepilogo Mostra un riepilogo dei dati finanziari

Barra di stato Contiene una breve descrizione delle voci di menu e
una barra di avanzamento

Nota

I contenuti e le opzioni all’interno dei vari menu secondari delle varie sezioni della finestra prin-
cipale di GnuCash potranno variare in funzione della finestra attiva.

La struttura dei conti è individuata con il nome Conti nella barra delle schede; qui, vengono visualizzati
tutti i propri conti e un riepilogo dei rispettivi saldi. I conti sono raggruppati a seconda della tipologia
basandosi sullo standard utilizzato nella contabilità.

Suggerimento

Per aprire un ulteriore finestra della struttura dei conti, andare in Visualizza → Nuova pagina dei
conti; verrà aperta la struttura dei conti nella finestra esistente.

Suggerimento

Per aprire una nuova finestra con una struttura dei conti, andare in Finestre → Apri la pagina in
una nuova finestra.

La scheda dei conti
Figura 4.2. Una visualizzazione della struttura ad albero dei conti.

Questa è un’immagine della scheda Conti.
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Struttura dei conti - Menu

La barra del menu per la finestra della struttura dei conti contiene le seguenti opzioni:

Struttura dei conti - Menu File

La tabella seguente descrive le opzioni del menu File.

Premendo l’opzione File sulla barra del menu, comparirà un menu «a discesa» contenente le opzioni
descritte in Tabella 4.1, «Struttura dei conti - Menu File - Permette l’accesso ai file, alle operazioni sui
conti e alla stampa.».

Tabella 4.1. Struttura dei conti - Menu File - Permette l’accesso ai file, alle
operazioni sui conti e alla stampa.

Voce del menu Descrizione

Nuovo file (Ctrl+N) Crea un nuovo file dei dati (per iniziare con dei nuovi conti e dei
nuovi dati)

Apri... (Ctrl+O) Apre un file dei dati di GnuCash già esistente.

Importa → Apre il menu secondario che permette l’importazione
dei file creati con altri programmi finanziari.

Importa QIF... Avvia il processo di importazione
di file QIF.

Importa OFX/QFX... Avvia il processo di importazione
di file OFX/QFX.

Importa file CSV o a larghezza
fissa...

Avvia il processo di importazione
di file CSV o a larghezza fissa.

Ripeti file log di GnuCash... Avvia la ripetizione di un file di
log di GnuCash. Utilie per recu-
perare i dati dopo un crash del
programma.

Importa MT940 .

Importa MT942 .

Importa DTAUS .

Importa DTAUS e invia .

Salva (Ctrl+S) Salva il file attualmente aperto.

Salva come... (Maiusc+Ctrl+S) Salva il file attualmente aperto con un altro nome.

Avvertimento

NON salvare i file dei dati in ~/.gnucash/books.

Imposta pagina...
(Maiusc+Ctrl+P)

Permette di selezionare la dimensione del foglio, la disposizione e i
margini per la stampa.

Apre il menu secondario con le
voci relative all’esportazione dei

conti. →

Apre il menu per l’esportazione.
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Voce del menu Descrizione

Esporta conti Esporta la struttura dei conti in
un nuovo file. I dati non vengono
esportati.

Proprietà (Alt+Inserisci) Impostazione delle opzioni per il file di GnuCash corrente.

File aperti di recente Lista numerata dei file aperti più di recente daGnuCash.

Esci (Ctrl+Q) Esce da GnuCash.

Struttura dei conti - Menu Modifica

Tabella 4.2. Struttura dei conti - Menu Modifica - Accede alle operazioni e alle
preferenze dei conti e dei dati.

Voce del menu Descrizione

Modifica conto (Ctrl+E) Modifica il nome e le caratteristiche del conto se-
lezionato. la sezione chiamata «Modificare un con-
to»

Cancella conto... (Cancella) Rimuove un conto. Consultare la la sezione chia-
mata «Cancellare un conto»

Rinumera sottoconti... Avvia l’assistente per la rinumerazione dei conti.
Consultare la sezione chiamata «Rinumerare i sot-
toconti».

Nota

Questa voce è disponibile solo se è stato
selezionato un conto che possiede almeno
un sotto-conto.

Apri conto Apre la finestra del registro per il conto seleziona-
to.

Apri sottoconti Apre una finestra del registro che visualizza tutte
le transazioni per il conto selezionato e per tutti i
suoi sottoconti.

Trova... (Ctrl+F) Permette di impostare i criteri di ricerca per una
specifica transazione. Consultare la la sezione
chiamata «Trovare le transazioni» per maggiori
dettagli sulla funzione di ricerca.

Preferenze (GnuCash → Preferenze su Mac OS
X).

Personalizzazione di GnuCash per quanto riguarda
la posizione, lo stile e tante altre opzioni. Consulta-
re la sezione chiamata «Impostare le preferenze».

Fogli di stile Permette di modificare e personalizzare i fogli di
stile. Vedere la la sezione chiamata «Modificare i
fogli di stile».

Opzioni resoconto tasse Imposta le caratteristiche delle tasse per uno o più
conti (solo per Stati Uniti).
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Struttura dei conti - Menu Visualizza

Tabella 4.3. Struttura dei conti - Menu Visualizza - modifica la vista della finestra.

Voce del menu Descrizione

Barra degli strumenti Selezione per abilitare o disabilitare la visualizza-
zione della barra degli strumenti.

Barra di riepilogo Selezione per abilitare o disabilitare la visualizza-
zione della barra di riepilogo.

Barra di stato Selezione per abilitare o disabilitare la visualizza-
zione della barra di stato.

Filtra per... Imposta il filtro per i conti visualizzati nella fine-
stra della struttura dei conti.

Aggiorna (Ctrl+R) Ridisegna la schermata visualizzata.

Nuova pagina dei conti Apre una nuova scheda in cui è visualizzata la
struttura dei conti.

Struttura dei conti - Menu Operazioni

Tabella 4.4. Struttura dei conti - Menu Operazioni - Permette di impostare le
transazioni pianificate, di riparare i conti, di effettuare dei frazionamenti azionari,
di trasferire del denaro e di riconciliare le transazioni.

Voce del menu Descrizione

Operazioni online → Questa voce del menu è mostrata solamen-
te se è abilitato l’Online Banking GnuCash

Ricevi saldo

Ricevi transazioni Scarica le transazioni dai conti
online

Inoltra transazione... Invia una o più transazioni a un
conto online

Transazione interna...

Addebito diretto...

Transazioni pianificate → menu secondari della voce «transazioni pianificate»

Editor transazioni pianificate Richiama lo strumento di modi-
fica di una transazione pianifica-
ta. Vedere la la sezione chiamata
«Finestra di modifica della tran-
sazione pianificata»

Dall’ultimo avvio Mostra le transazioni pianifica-
te dall’ultimo avvio di GnuCash.
la sezione chiamata «Assistente
dall’ultimo avvio»

Rimborso di mutui e ipoteche... Avvia l’assistente di rimborso di
mutui e ipoteche per impostare le
rate. la sezione chiamata «Assi-
stente per mutui e ipoteche»



Panoramica delle finestre e del-
le opzioni del menu di GnuCash

17

Voce del menu Descrizione

Bilancio → Menu secondario per l’impresa

Nuovo bilancio preventivo Apre la finestra per la creazione
di un nuovo bilancio preventivo.

Apri bilancio preventivo Apre un bilancio esistente.

Nuovo conto... Crea un nuovo conto e apre la finestra delle proprietà del conto.

Nuova struttura conti... Avvia l’assistente per la creazione di una Nuova struttura conti.

Trasferimenti... (Ctrl+T) Avvia la procedura di trasferimento tra conti.

Riconcilia... Avvia la procedura di riconciliazione. la sezione chiamata «Finestra
delle informazioni di riconciliazione»

Frazionamento azionario... Avvia l’assistente per il frazionamento azionario. Ulteriori dettagli
nella la sezione chiamata «Registrare un frazionamento azionario».

Visualizza lotti... Apre la schermata dei lotti nel conto.

Liquidazione automatica... Apre la schermata di liquidazione automatica dove è possibile inse-
rire le informazioni per la liquidazione automatica.

Controlla e ripara → Menu secondari della voce Controlla e ripara

Controlla e ripara conto Ricerca e ripara le transazioni
non in bilancio e le suddivisioni
orfane nel conto selezionato.

Controlla e ripara sottoconti Ricerca e ripara le transazioni
non in bilancio e le suddivisioni
orfane nel conto selezionato e nei
suoi sottoconti.

Controlla e ripara tutti Ricerca e ripara le transazioni
non in bilancio e le suddivisioni
orfane in tutti i conti.

Ripristina avvisi... GnuCash visualizza degli avvisi quando si cerca di effettuare deter-
minate operazioni, come rimuovere una transazione o le suddivisio-
ni da una transazione. La finestra di avviso presenta l’opzione di non
visualizzare più questi messaggi alla ripetizione dell’operazione. Le
opzioni Ricordalo e non chiedermelo di nuovo e Ricordalo e non
chiedermelo di nuovo in questa sessione, permettono di disabilitarli.
L’opzione Ripristina avvisi permette di ripristinare gli avvisi prede-
finiti, cioè abilita la visualizzazione dei messaggi.

Rinomina pagina Apre la casella per rinominare la scheda o la pagina corrente.

Struttura dei conti - Menu Impresa

Tabella 4.5. Struttura dei conti - Menu Impresa - permette l’accesso alle funzioni
di GnuCash dedicate all’impresa.

Voce del menu Descrizione

Cliente → Seleziona le operazioni relative al cliente.

Nuovo cliente... Avvia la scheda per la creazione
di un nuovo cliente.
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Voce del menu Descrizione

Trova cliente... Avvia la procedura di ricerca di
un cliente.

Nuova fattura... Avvia la scheda per la creazione
di una nuova fattura.

Trova fattura... Avvia la procedura di ricerca di
una fattura.

Nuovo lavoro... Avvia la scheda per la creazione
di un nuovo lavoro.

Trova lavoro... Avvia la procedura di ricerca di
un lavoro.

Procedura di pagamento... Avvia l’assistente per la proce-
dura di pagamento. È necessario
aver selezionato un conto del tipo
debiti correnti per proseguire.

Venditore → Seleziona le operazioni relative al venditore.

Nuovo venditore... Avvia la scheda per la creazione
di un nuovo venditore.

Trova venditore... Avvia la procedura di ricerca di
un venditore.

Nuova ricevuta... Avvia la scheda per la creazione
di una nuova ricevuta.

Trova ricevuta... Avvia la procedura di ricerca di
una ricevuta.

Nuovo lavoro... Avvia la scheda per la creazione
di un nuovo lavoro.

Trova lavoro... Avvia la procedura di ricerca di
un lavoro.

Procedura di pagamento... Avvia l’assistente per la proce-
dura di pagamento. È necessario
aver selezionato un conto del tipo
debiti correnti per proseguire.

Dipendente → Seleziona le operazioni relative al dipendente.

Nuovo dipendente... Avvia la scheda per la creazione
di un nuovo dipendente.

Trova dipendente... Avvia la procedura di ricerca di
un dipendente.

Nuova nota spese... Avvia la scheda per la creazione
di una nuova nota spese.

Trova nota spese... Avvia la procedura di ricerca di
una nota spese.

Procedura di pagamento... Avvia l’assistente per la proce-
dura di pagamento. È necessario
aver selezionato un conto del tipo
debiti correnti per proseguire.
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Voce del menu Descrizione

Tabella imposte di vendita Visualizza e permette di modificare la lista di tabelle delle imposte.

Editor termini di pagamento Visualizza e permette di modificare la lista dei termini di pagamen-
to.

Promemoria scadenze ricevute Visualizza e permette di modificare la lista dei promemoria delle
scadenze per le ricevute.

Struttura dei conti - Menu Resoconti

Questa rappresenta solamente una breve lista di ogni resoconto o grafico disponibile. Ognuno di essi può
essere personalizzato attraverso il pulsante Opzioni della barra degli strumenti e il foglio di stile utilizzato.

Tabella 4.6. Struttura dei conti - Menu Resoconti - Permette la scelta dei resoconti
e dei grafici forniti da GnuCash.

Voce del menu Descrizione

Attività e passività →

Portafoglio avanzato

Istogramma delle attività

Grafico a torta delle attività

Saldo medio

Stato patrimoniale

Stato patrimoniale usando egui-
le-gnc

Giornale generale

Libro mastro generale

Portafoglio degli investimenti

Istogramma delle passività

Grafico a torta delle passività

Istogramma del patrimonio netto

Grafico a dispersione del prezzo

Resoconti per gli affari →

Resoconto venditori

Fattura semplice

Resoconto dipendenti

Fattura elaborata

Resoconto di lavoro

Payable Aging

Fattura stampabile

Receivable Aging

Resoconto tasse

Resoconto clienti
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Voce del menu Descrizione

Entrate e Uscite →

Flusso di liquidi

Prospetto dei capitali

Istogramma delle uscite

Grafico a torta delle uscite

Uscite per giorno della settimana

Grafico delle entrate e delle usci-
te

Istogramma delle entrate

Grafico a torta delle entrate

Prospetto delle entrate

Entrate per giorno della settima-
na

Bilancio di previsione

Profitti e perdite

Esempi e personalizzazioni →

Resoconto di benvenuto di esem-
pio

Resoconto multicolonna persona-
lizzato

Semplice resoconto con esempi

Sommario del conto Questo resoconto mostra il saldo del conto selezionato.

Resoconti personalizzati Apre la finestra per la gestione dei resoconti creati dall’utente.

Resoconto tasse ed esportazione
TXF

Crea un resoconto per le tasse (US) e/o esporta i dati per un software
di elaborazione delle tasse (TXF).

Resoconto delle transazioni

Struttura dei conti - Menu Strumenti

Tabella 4.7. Struttura dei conti - Menu Strumenti - Permette l’accesso a diversi
strumenti e editor

Voce del menu Descrizione

Impostazione dell’Online Banking... Avvia la procedura guidata per la configurazione
dell’Online Banking se GnuCash è stato compilato
con il supporto per l’online banking. la sezione chia-
mata «Procedura guidata per l’HBCI (Online Ban-
king)»

Editor prezzi Strumento per la modifica o l’immissione dei prezzi
di titoli e fondi. Maggiori dettagli nella la sezione
chiamata «Editor prezzi»
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Voce del menu Descrizione

Editor titoli Strumento per la modifica o l’immissione di azioni e
commodity. Ulteriori dettagli nella la sezione chia-
mata «Editor titoli»

Calcolatore di prestiti Ulteriori dettagli nella la sezione chiamata «Calco-
latore di prestiti»

Chiudi libro Apre una schermata in cui è possibile inserire le in-
formazioni necessarie alla chiusura del libro conta-
bile corrente.

Libro mastro generale Vedere la la sezione chiamata «Libro mastro gene-
rale»

Struttura dei conti - Menu Finestre

Tabella 4.8. Struttura dei conti - Menu Finestre

Voce del menu Descrizione

Nuova finestra Apre una nuova finestra vuota di GnuCash.

Apri la pagina in una nuova finestra Sposta la scheda corrente in una nuova finestra.

Struttura dei conti - Menu Aiuto

Tabella 4.9. Struttura dei conti - Menu Aiuto - Permette l’accesso a questo
documento e alla guida ai concetti e manuale.

Voce del menu Descrizione

Guida ai concetti e manuale Spiegazione dei principi di contabilità e di come ap-
plicarli in GnuCash

Suggerimento del giorno Mostra delle brevi note relative a funzioni che po-
trebbero non essere conosciute.

Sommario Apre questo documento.

Informazioni Mostra la schermata delle informazioni contenente
la versione, la licenza e i ringraziamenti di GnuCash.

Struttura dei conti - Pulsanti e icone della barra degli
strumenti

La finestra principale di GnuCash mette a disposizione una serie di pulsanti e icone utili per accedere
facilmente alle funzioni più comunemente utilizzate nella scheda attiva. La barra degli strumenti può

essere facilmente nascosta o visualizzata selezionando la voce Visualizza → Barra degli strumenti. Le
opzioni visualizzate nella barra variano a seconda delle operazioni disponibili nella scheda attiva.

Una breve descrizione della funzione di pulsante della barra degli strumenti viene visualizzata quando il
puntatore del mouse viene mantenuto al di sopra di esso per qualche secondo.
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Tabella 4.10. Barra degli strumenti - Finestra dell struttura dei conti

Pulsanti della Barra degli strumenti Descrizione

Salva (Ctrl+S) Esegue il salvataggio del file dei dati, inserendo tutte
le transazioni nel file.

Chiudi (Ctrl+W) Chiude la pagina dei conti attualmente visualizzata

Nota

Questa icona non è disponibile se è aper-
ta una sola scheda; è disponibile per quelle
successive che vengono aperte.

Apri Apre il registro delle transazioni per il conto sele-
zionato.

Modifica Permette di variare le caratteristiche del conto sele-
zionato. la sezione chiamata «Modificare un conto»

Nuovo Avvia la procedura per la creazione di un nuovo con-
to. la sezione chiamata «Creare un nuovo conto».

Cancella Rimuove il conto selezionato. la sezione chiamata
«Cancellare un conto»

Barra delle schede
La barra delle schede visualizza in stile «fascicolatore» le schede per i registri delle transazioni, per i
resoconti e per la struttura dei conti aperti.

Riquadro principale - Struttura dei conti
La schermata della struttura dei conti visualizza la struttura dei conti in ordine gerarchico. Questo permette
l’organizzazione dei conti in base alla tipologia.

Suggerimento

Il triangolo (o il segno "+") a fianco del nome del conto, è utilizzato per aprire o chiudere la
struttura dei conti. Quando si preme su di esso, l’orientamento della punta cambia da rivolta verso
destra a rivolta verso il basso (diventa un segno "-"), per indicare che la struttura ad albero è
aperta. Più a destra rispetto al nome del conto principale, saranno visibili uno o più sottoconti
che potranno a loro volta avere, a fianco del loro nome, un altro simbolo triangolare (segno "+");
questo indica la presenza di un altro livello di sottoconti.

Nel riquadro principale sono mostrate, di default, quattro colonne: Nome del conto, Tipo, Descrizione e
Totale. Per ogni conto, queste informazioni, se disponibili, sono

Suggerimento

Le colonne visualizzate nella struttura dei conti possono essere personalizzate. Fare clic sull’icona
all’estrema destra del riquadro della struttura dei conti per visualizzare una lista a comparsa delle
colonne attivabili. Fare clic sul nome della colonna per aggiungerla alla finestra. Fare clic di
nuovo sul nome per nasconderla.

Lo stile di visualizzazione predefinito per la finestra della struttura dei conti, è quello a "fascicolatore".
Questo è indicato dalla presenza di una scheda nella riga delle schede della finestra principale. Altre schede
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appariranno a fianco di questa allorché vengano aperti anche dei resoconti, dei registri del conto o altre
strutture dei conti.

Barra di riepilogo
La barra di riepilogo visualizza dei saldi relativi al tipo di conto aperto. Normalmente i conti visualizzano
il saldo attuale, qualsiasi saldo futuro, un saldo per le operazioni liquidate e un saldo di riconciliazione. I
conti per le azioni, comunque, visualizzano le quote totali e il loro valore. La barra di riepilogo può essere

nascosta o visualizzata selezionando la voce Visualizza → Barra di riepilogo dal menu.

Barra di stato
La barra di stato visualizza dei suggerimenti che forniscono maggiori dettagli sulla voce del menu sele-
zionata e mostra anche una barra di avanzamento quando si sta aprendo o salvando un file o generando
un resoconto. La barra di stato può essere nascosta o resa visibile selezionando la voce Barra di stato
presente nel menu Visualizza.

Registro del conto/Libro mastro generale
Registro del conto e finestra del libro mastro generale

Questa finestra è utilizzata per l’inserimento e la modifica dei dati del conto; fornisce anche degli strumenti
per la pianificazione futura delle transazioni, per cercare e per creare dei resoconti sulle transazioni e per
la stampa degli assegni.

Per aprire la finestra del registro di un conto, selezionare quest’ultimo nella struttura dei conti e poi andare

in File → Apri conto o premere Ctrl+O: verrà aperta una nuova finestra con il registro del conto. Il pulsante
Apri nella barra degli strumenti della finestra della struttura dei conti o il pulsante Salta nella finestra del
registro, sono delle possibili alternative.

Figura 4.3. La visualizzazione del registro del conto.

Questa è una schermata della scheda Registro del conto.

Suggerimento

L’aspetto del registro del conto è personalizzabile (vedere la sezione chiamata «Cambiare la vi-
sualizzazione del registro»).
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Nota

I metodi di inserimento delle transazioni sono descritti in maggior dettaglio in la sezione chiamata
«Pianificare le transazioni»

Menu del registro dei conti
La barra del menu per la finestra del registro delle transazioni, contiene le seguenti opzioni:

Registro del conto - Menu File

La tabella seguente descrive le opzioni del menu File.

Selezionando la voce File sulla barra del menu, comparirà un menu a discesa contenente le opzioni de-
scritte in Tabella 4.11, «Registro del conto - Menu File - Permette l’accesso ai file, alle operazioni sui
conti e alla stampa.».

Tabella 4.11. Registro del conto - Menu File - Permette l’accesso ai file, alle
operazioni sui conti e alla stampa.

Voce del menu Descrizione

Nuovo file (Ctrl+N) Crea un nuovo file dei dati (per iniziare con dei nuovi conti e dei
nuovi dati)

Apri... (Ctrl+O) Apre un file dei dati di GnuCash già esistente.

Importa → Apre il menu secondario che permette l’importazione
dei file creati con altri programmi finanziari.

Importa QIF... Avvia il processo di importazione
di file QIF.

Importa OFX/QFX... Avvia il processo di importazione
di file OFX/QFX.

Importa file CSV o a larghezza
fissa...

Avvia il processo di importazione
di file CSV o a larghezza fissa.

Ripeti file log di GnuCash... Avvia la ripetizione di un file di
log di GnuCash. Utilie per recu-
perare i dati dopo un crash del
programma.

Importa MT940 .

Importa MT942 .

Importa DTAUS .

Importa DTAUS e invia .

Salva (Ctrl+S) Salva il file attualmente aperto.

Salva come... (Maiusc+Ctrl+S) Salva il file attualmente aperto con un altro nome.

Avvertimento

NON salvare i file dei dati in ~/.gnucash/books.

Stampa assegni... (Ctrl+P) Avvia l’assistente per la stampa degli assegni. Consultare la sezione
chiamata «Stampare gli assegni».
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Voce del menu Descrizione

Imposta pagina...
(Maiusc+Ctrl+P)

Permette di selezionare la dimensione del foglio, la disposizione e i
margini per la stampa.

Apre il menu secondario con le
voci relative all’esportazione dei

conti. →

Apre il menu secondario con le voci relative all’esportazione dei
conti.

Esporta conti Esporta la struttura dei conti in
un nuovo file. I dati non vengono
esportati.

Proprietà (Alt+Inserisci) Impostazione delle opzioni per il file di GnuCash corrente.

File aperti di recente Lista numerata dei file aperti più di recente daGnuCash.

Chiudi (Ctrl+W) Chiude la struttura dei conti, il registro delle transazioni o il reso-
conto aperti. Per la struttura dei conti iniziale questa voce non è di-
sponibile (non è selezionabile).

Esci (Ctrl+Q) Esce da GnuCash.

Registro del conto - Menu Modifica

Tabella 4.12. Registro del conto - Menu Modifica - Accede alle operazioni e alle
preferenze dei conti e dei dati.

Voce del menu Descrizione

Taglia (Ctrl+X) Esegue una operazione standard di Taglio.

Copia (Ctrl+C) Esegue una operazione standard di Copia.

Incolla (Ctrl+V) Esegue una operazione standard di incollaggio.

Modifica conto Apre la scheda per la modifica delle caratteristiche
e dei parametri del conto.

Trova... (Ctrl+F) Permette di impostare i criteri di ricerca per una
specifica transazione. Consultare la la sezione
chiamata «Trovare le transazioni» per maggiori
dettagli sulla funzione di ricerca.

Preferenze (GnuCash → Preferenze su Mac OS
X).

Personalizzazione di GnuCash per quanto riguarda
la posizione, lo stile e tante altre opzioni. Consulta-
re la sezione chiamata «Impostare le preferenze».

Fogli di stile Permette di modificare e personalizzare i fogli di
stile.

Opzioni resoconto tasse Imposta le caratteristiche delle tasse per uno o più
conti (US). Assign tax form and line to account.

Registro del conto - Menu Visualizza

Tabella 4.13. Registro del conto - Menu Visualizza - Modifica le opzioni di
visualizzazione della finestra di GnuCash.

Voce del menu Descrizione

Barra degli strumenti Selezione per abilitare o disabilitare la visualizzazione della barra
degli strumenti.
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Voce del menu Descrizione

Barra di riepilogo Opzione per abilitare o disabilitare la visualizzazione della barra di
riepilogo.

Barra di stato Opzione per abilitare o disabilitare la visualizzazione della barra di
stato.

Libro mastro basilare Opzione per la scelta dello stile di visualizzazione del registro.

Mastro a espansione automatica Opzione per la scelta dello stile di visualizzazione del registro.

Giornale della transazione Opzione per la scelta dello stile di visualizzazione del registro.

Doppia linea Opzione per abilitare o disabilitare la visualizzazione a doppia linea.

Ordina per... Imposta il criterio di ordinamento della schermata delle transazioni.
Fare clic per aprire la scheda delle opzioni. Per chiudere la scheda
delle opzioni premere i pulsanti Annulla o OK.

Ordine standard Mantiene l’ordine normale del
conto

Data Ordina per data

Data di immissione Ordina per data di immissione.

Data dell’estratto conto Ordina per data dell’estratto con-
to (elementi non riconciliati per
ultimi).

Numero Ordina per numero.

Importo Ordina per importo.

Promemoria Ordina per promemoria.

Descrizione Ordina per descrizione.

Operazioni Ordina per operazione

Note Ordina per campo delle note

Filtra per... Imposta il filtro per i conti visualizzati nella struttura dei conti o nel-
la schermata del registro delle transazioni.

Aggiorna (Ctrl+R) Ridisegna la schermata visualizzata.

Nuova pagina dei conti Apre una nuova scheda in cui è
visualizzata la struttura dei conti.

Registro del conto - Menu Transazione

Tabella 4.14. Registro del conto - Menu Transazione - accede alle operazioni di
modifica della transazione.

Voce del menu Descrizione

Taglia transazione Taglia la transazione selezionata e la mantiene in
memoria.

Copia transazione Copia la transazione selezionata nella memoria.

Incolla transazione Incolla la transazione selezionata dalla memoria.

Duplica transazione Inserisce nel registro una copia della transazione
selezionata.

Elimina transazione Cancella la transazione selezionata.
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Voce del menu Descrizione

Rimuovi suddivisioni dalla transazione Rimuove tutte le suddivisioni dalla transazione se-
lezionata.

Inserisci transazione Inserisce nel registro la transazione a cui si sta la-
vorando

Annulla transazione

Invalida transazione Invalida la transazione selezionata.

Riconvalida transazione Riconvalida la transazione selezionata.

Aggiungi transazione di inversione

Registro del conto - Menu Operazioni

Tabella 4.15. Registro del conto - Menu Operazioni - Permette di impostare le
transazioni pianificate, di riparare i conti, di effettuare dei frazionamenti azionari,
di trasferire del denaro e di riconciliare le transazioni.

Voce del menu Descrizione

Operazioni online → Questa voce del menu è mostrata solamen-
te se è abilitato l’Online Banking GnuCash

Ricevi saldo

Ricevi transazioni Scarica le transazioni dai conti
online

Inoltra transazione... Invia una o più transazioni a un
conto online

Transazione interna...

Addebito diretto...

Transazioni pianificate → menu secondari della voce «transazioni pianificate»

Editor transazioni pianificate Richiama lo strumento di modi-
fica di una transazione pianifica-
ta. Vedere la la sezione chiamata
«Finestra di modifica della tran-
sazione pianificata»

Dall’ultimo avvio Mostra le transazioni pianifica-
te dall’ultimo avvio di GnuCash.
la sezione chiamata «Assistente
dall’ultimo avvio»

Rimborso di mutui e ipoteche... Avvia l’assistente di rimborso di
mutui e ipoteche per impostare le
rate. la sezione chiamata «Assi-
stente per mutui e ipoteche»

Bilancio → Menu secondario per l’impresa

Nuovo bilancio preventivo Apre la finestra per la creazione
di un nuovo bilancio preventivo.

Apri bilancio preventivo Apre un bilancio esistente.

Trasferimenti... (Ctrl+T) Avvia la procedura di trasferimento tra conti.
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Voce del menu Descrizione

Riconcilia... Avvia la procedura di riconciliazione. la sezione chiamata «Finestra
delle informazioni di riconciliazione»

Frazionamento azionario... Avvia l’assistente per il frazionamento azionario. Ulteriori dettagli
nella la sezione chiamata «Registrare un frazionamento azionario».

Visualizza lotti... Apre la schermata dei lotti nel conto.

Transazione vuota Sposta la selezione alla transazione vuote sul fondo del registro

Transazione suddivisa Espande la transazione selezionata mostrandone le suddivisioni.

Modifica tasso di cambio Modifica il tasso di cambio della transazione selezionata.

Pianifica... Crea una transazione pianificata utilizzando questa transazione co-
me modello.

Salta Salta alla transazione corrispondente nell’altro conto.

Controlla e ripara → Menu secondari della voce Controlla e ripara

Tutte le transazioni Ricerca e ripara le transazioni
non in bilancio e le suddivisioni
orfane nel conto selezionato.

Questa transazione Controlla e ripara le suddivisioni
in questa transazione.

Ripristina avvisi... GnuCash visualizza degli avvisi quando si cerca di effettuare deter-
minate operazioni, come rimuovere una transazione o le suddivisio-
ni da una transazione. La finestra di avviso presenta l’opzione di non
visualizzare più questi messaggi alla ripetizione dell’operazione. Le
opzioni Ricordalo e non chiedermelo di nuovo e Ricordalo e non
chiedermelo di nuovo in questa sessione, permettono di disabilitarli.
L’opzione Ripristina avvisi permette di ripristinare gli avvisi prede-
finiti, cioè abilita la visualizzazione dei messaggi.

Rinomina pagina Apre la casella per rinominare la scheda o la pagina corrente.

Registro del conto - Menu Impresa

Gli elementi visualizzati nel menu Impresa sono gli stessi elencati in Tabella 4.5, «Struttura dei conti -
Menu Impresa - permette l’accesso alle funzioni di GnuCash dedicate all’impresa.».

Registro del conto - Menu Resoconti

Gli elementi visualizzati nel menu Resoconti sono gli stessi elencati in Tabella 4.6, «Struttura dei conti -
Menu Resoconti - Permette la scelta dei resoconti e dei grafici forniti da GnuCash.» a cui si aggiungono
quelli elencati nel seguito.

• Resoconto del conto

• Resoconto delle transazioni del conto

Registro del conto - Menu Strumenti

Gli elementi visualizzati nel menu Strumenti sono gli stessi elencati in Tabella 4.7, «Struttura dei conti -
Menu Strumenti - Permette l’accesso a diversi strumenti e editor».



Panoramica delle finestre e del-
le opzioni del menu di GnuCash

29

Registro del conto - Menu Finestre

Gli elementi visualizzati nel menu Finestre sono gli stessi elencati in Tabella 4.8, «Struttura dei conti -
Menu Finestre».

Registro del conto - Menu Aiuto

Gli elementi visualizzati nel menu Aiuto sono gli stessi elencati in Tabella 4.9, «Struttura dei conti - Menu
Aiuto - Permette l’accesso a questo documento e alla guida ai concetti e manuale.».

Registro del conto - Icone e pulsanti della barra degli
strumenti

La finestra principale di GnuCash mette a disposizione una serie di pulsanti e icone utili per accedere
facilmente alle funzioni più comunemente utilizzate nella scheda attiva. La barra degli strumenti può
essere facilmente nascosta o visualizzata selezionando la voce Barra degli strumenti dal menu Visualizza.
Le opzioni visualizzate nella barra variano a seconda delle operazioni eseguibili nella scheda attiva.

Nota

Le opzioni specifichevisualizzate nella barra degli strumenti variano in funzione delle operazioni
disponibile nella scheda corrente.

Una breve descrizione della funzione di un pulsante è visualizzata quando il puntatore del mouse viene
mantenuto al di sopra di essa per qualche secondo.

Tabella 4.16. Barra degli strumenti della finestra del registro del conto (registro delle
transazioni)

Pulsanti della Barra degli strumenti Descrizione

Salva (Ctrl+S) Esegue il salvataggio del file dei dati, inserendo tutte
le transazioni nel file.

Chiudi Chiude il registro.

Duplica Permette di creare una copia della transazione sele-
zionata.

Cancella Cancella dal registro la transazione selezionata.

Inserisci Registra la transazione corrente.

Annulla Annulla la transazione corrente.

Vuota Sposta il cursore nella transazione vuota alla fine del
registro.

Suddivisione Mostra tutte le suddivisioni nella transazione sele-
zionata. Questo pulsante è disattivato se è stato scel-

ta l’opzione Visualizza → Mastro a espansione au-
tomatica

Salta Salta alla transazione corrispondente nell’altro con-
to

Pianifica Crea una transazione pianificata utilizzando questa
transazione come modello.
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Pulsanti della Barra degli strumenti Descrizione

Trasferimento Avvia l’assistente per il trasferimento di fondi da un
conto a un altro.

Riconcilia Avvia il procedimento di riconciliazione per il con-
to selezionato. la sezione chiamata «Finestra delle
informazioni di riconciliazione»

Barra delle schede
La barra delle schede visualizza in stile «fascicolatore» le schede per i registri delle transazioni, per i
resoconti e per le strutture dei conti aperti.

Elenco delle transazioni
L’elenco delle transazioni visualizza tutti i movimenti che sono stati inseriti e un saldo corrente. Presenta
anche una transazione vuota da utilizzare per inserire dei nuovi movimenti. Le intestazioni delle colonne
variano in funzione del tipo di conto a cui il registro si riferisce. Le intestazioni più comunemente visua-
lizzate sono Data, Descrizione, Trasferimento e Saldo.

Il menu Visualizza permette di modificare lo stile di visualizzazione dell’elenco delle transazioni variando
il numero di elementi visualizzati, utilizzando un criterio di ordinamento differente oppure cambiando lo
stile per poter visualizzare più facilmente le transazioni. Il pulsante Suddivisione permette di mostrare
velocemente tutte le parti di una transazione.

Barra di riepilogo
La barra di riepilogo visualizza dei saldi relativi al tipo di conto aperto. Normalmente i conti visualizzano
il saldo Attuale, il saldo Futuro, un saldo per le operazioni liquidate, un saldo di riconciliazione e un saldo
Minimo previsto. I conti per le azioni, inoltre, visualizzano le quote totali e il loro valore. La barra di
riepilogo puVisualizzaBarra di riepilogo dal menu.

Barra di stato
La barra di stato funziona esattamente come già descritto in la sezione chiamata «Barra di stato».

Finestra del resoconto
Finestra di visualizzazione del resoconto

Questa finestra è visualizzata ogni qualvolta viene selezionato un resoconto o un grafico dal menu Reso-
conti.

Per aprire la finestra del resoconto, selezionare una tipologia di resoconto dalla lista fornita nel menu
Resoconti. Verrà aperta una nuova finestra dove sarà visualizzato il resoconto selezionato con uno stile
simile a quello di una pagina internet in cui sono visualizzati dei collegamenti attivabili ai dati del conto.

Nota

In funzione della tipologia selezionata, potrebbe essere necessario attendere qualche istante prima
che la generazione del resoconto sia terminata. Nella Barra di stato è comunque possibile vedere
lo stato di avanzamento della generazione tramite la barra di progressione se questa non è stata
nascosta in precedenza.
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Figura 4.4. La finestra del resoconto

Questa è un’immagine del Grafico di entrate e uscite.

Menu Resoconti
La barra del menu per la finestra dei resoconti contiene le seguenti opzioni.

Resoconti - Menu File

La tabella seguente descrive le opzioni del menu File.

Premendo l’opzione File sulla barra del menu, comparirà un menu a discesa contenente le opzioni descritte
in Tabella 4.17, «Resoconti - Menu File - Permette l’accesso ai file, alle operazioni sui conti e alla stampa.».

Tabella 4.17. Resoconti - Menu File - Permette l’accesso ai file, alle operazioni sui
conti e alla stampa.

Voce del menu Descrizione

Nuovo file (Ctrl+N) Crea un nuovo file dei dati (per iniziare con dei nuovi conti e dei
nuovi dati)

Apri... (Ctrl+O) Apre un file dei dati di GnuCash già esistente.

Importa → Apre il menu secondario che permette l’importazione
dei file creati con altri programmi finanziari.

Importa QIF... Avvia il processo di importazione
di file QIF.
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Voce del menu Descrizione

Importa OFX/QFX... Avvia il processo di importazione
di file OFX/QFX.

Importa file CSV o a larghezza
fissa...

Avvia il processo di importazione
di file CSV o a larghezza fissa.

Ripeti file log di GnuCash... Avvia la ripetizione di un file di
log di GnuCash. Utilie per recu-
perare i dati dopo un crash del
programma.

Importa MT940 .

Importa MT942 .

Importa DTAUS .

Importa DTAUS e invia .

Salva (Ctrl+S) Salva il file attualmente aperto.

Salva come... (Maiusc+Ctrl+S) Salva il file attualmente aperto con un altro nome.

Avvertimento

NON salvare i file dei dati in ~/.gnucash/books.

Aggiunge un resoconto Salva il resoconto visualizzato in un file di configurazione. In questo
modo sarà possibile eseguire lo stesso identico resoconto utilizzando

la voce del menu Resoconti → Resoconto personalizzato.

Nota

Per rendere selezionabile la voce Aggiungi resoconto, è pr-
ma necessario cambiare il nome predefinito del resoconto

attraverso le opzioni o selezionando Operazioni → Rinomi-
na pagina quando è visualizzato il resoconto.

Stampa resoconto... (Ctrl+P) Stampa il resoconto selezionato.

Imposta pagina...
(Maiusc+Ctrl+P)

Permette di selezionare la dimensione del foglio, la disposizione e i
margini per la stampa.

Apre il menu secondario con le
voci relative all’esportazione dei

conti. →

Apre il menu secondario con le voci relative all’esportazione dei
conti.

Esporta resoconto Esporta il resoconto corrente in
un file in formato HTML.

Esporta conti Esporta la struttura dei conti in
un nuovo file. I dati non vengono
esportati.

Proprietà (Alt+Inserisci) Impostazione delle opzioni per il file di GnuCash corrente.

File aperti di recente Lista numerata dei file aperti più di recente daGnuCash.

Chiudi (Ctrl+W) Chiude il resoconto corrente.

Esci (Ctrl+Q) Esce da GnuCash.
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Resoconti - Menu Modifica

Tabella 4.18. Resoconti - Menu Modifica - Accede alle operazioni e alle preferenze
dei conti e dei dati.

Voce del menu Descrizione

Copia (Ctrl+C) Esegue una operazione standard di Copia.

Trova... (Ctrl+F) Permette di impostare i criteri di ricerca per una
specifica transazione. Consultare la la sezione
chiamata «Trovare le transazioni» per maggiori
dettagli sulla funzione di ricerca.

Preferenze (GnuCash → Preferenze su Mac OS
X).

Personalizzazione di GnuCash per quanto riguarda
la posizione, lo stile e tante altre opzioni. Consulta-
re la sezione chiamata «Impostare le preferenze».

Fogli di stile Permette di modificare e personalizzare i fogli di
stile.

Opzioni del resoconto Visualizza le opzioni per lo stile di visualizzazione
del resoconto.

Opzioni resoconto tasse Imposta le caratteristiche delle tasse per uno o più
conti (US). Assign tax form and line to account.

Resoconti - Menu Visualizza

A eccezione di Filtra per..., le voci presenti nel menu Visualizza sono le stesse elencate in Tabella 4.3,
«Struttura dei conti - Menu Visualizza - modifica la vista della finestra.».

Resoconti - Menu Operazioni

Tabella 4.19. Menu Operazioni - Permette l’impostazione delle transazioni
pianificate.

Voce del menu Descrizione

Operazioni online → Questa voce del menu è mostrata solamen-
te se è abilitato l’Online Banking GnuCash

Ricevi saldo

Ricevi transazioni Scarica le transazioni dai conti
online

Inoltra transazione... Invia una o più transazioni a un
conto online

Transazione interna...

Addebito diretto...

Transazioni pianificate → menu secondari della voce «transazioni pianificate»

Editor transazioni pianificate Richiama lo strumento di modi-
fica di una transazione pianifica-
ta. Vedere la la sezione chiamata
«Finestra di modifica della tran-
sazione pianificata»
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Voce del menu Descrizione

Dall’ultimo avvio Mostra le transazioni pianifica-
te dall’ultimo avvio di GnuCash.
la sezione chiamata «Assistente
dall’ultimo avvio»

Rimborso di mutui e ipoteche... Avvia l’assistente di rimborso di
mutui e ipoteche per impostare le
rate. la sezione chiamata «Assi-
stente per mutui e ipoteche»

Bilancio → Menu secondario per l’impresa

Nuovo bilancio preventivo Apre la finestra per la creazione
di un nuovo bilancio preventivo.

Apri bilancio preventivo Apre un bilancio esistente.

Ripristina avvisi... GnuCash visualizza degli avvisi quando si cerca di effettuare deter-
minate operazioni, come rimuovere una transazione o le suddivisio-
ni da una transazione. La finestra di avviso presenta l’opzione di non
visualizzare più questi messaggi alla ripetizione dell’operazione. Le
opzioni Ricordalo e non chiedermelo di nuovo e Ricordalo e non
chiedermelo di nuovo in questa sessione, permettono di disabilitarli.
L’opzione Ripristina avvisi permette di ripristinare gli avvisi prede-
finiti, cioè abilita la visualizzazione dei messaggi.

Rinomina pagina Apre la casella per rinominare la scheda o la pagina corrente.

Resoconti - Menu Impresa

Gli elementi visualizzati nel menu Impresa sono gli stessi elencati in Tabella 4.5, «Struttura dei conti -
Menu Impresa - permette l’accesso alle funzioni di GnuCash dedicate all’impresa.».

Resoconti - Menu Resoconti

Gli elementi visualizzati nel menu Resoconti sono gli stessi elencati in Tabella 4.6, «Struttura dei conti -
Menu Resoconti - Permette la scelta dei resoconti e dei grafici forniti da GnuCash.» .

Resoconti - Menu Strumenti

Gli elementi visualizzati nel menu Strumenti sono gli stessi elencati in Tabella 4.7, «Struttura dei conti -
Menu Strumenti - Permette l’accesso a diversi strumenti e editor».

Resoconti - Menu Finestre

Gli elementi visualizzati nel menu Finestre sono gli stessi elencati in Tabella 4.8, «Struttura dei conti -
Menu Finestre».

Resoconti - Menu Aiuto

Gli elementi visualizzati nel menu Aiuto sono gli stessi elencati in Tabella 4.9, «Struttura dei conti - Menu
Aiuto - Permette l’accesso a questo documento e alla guida ai concetti e manuale.».
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Resoconti - Icone dei pulsanti della barra degli strumenti
La finestra del resoconto è dotata di una barra degli strumenti che permette un rapido accesso alle fun-
zioni utilizzate per i resoconti. La barra degli strumenti può essere nascosta o visualizzata selezionando

Visualizza → Barra degli strumenti.

Tabella 4.20. Resoconti - Pulsanti della barra degli strumenti

Pulsante della Barra degli strumenti Descrizione

Salva (Ctrl+S)

Chiudi (Ctrl+W) Chiude il resoconto attualmente visualizzato.

Indietro Sposta un passo indietro nella cronologia

Avanti Sposta un passo avanti nella cronologia

Ricarica Ricarica (aggiorna) il resoconto corrente.

Stop Termina i processi HTML in esecuzione.

Apre il menu secondario con le voci relative
all’esportazione dei conti.

Esporta il resoconto in un file di formato HTML.

Opzioni Modifica le opzioni per il tipo specifico di resocon-
to.

Stampa (Ctrl+P) Invia alla stampante il resoconto corrente.

Barra delle schede
La «barra delle schede» visualizza in stile «fascicolatore» le schede per i registri delle transazioni, per i
resoconti e per le strutture dei conti aperti.

Schermata principale del resoconto
Qui viene visualizzato il resoconto o il grafico selezionato. Le proprietà di questa finestra sono modificabili
in due modi. Selezionando il pulsante Opzioni sulla barra degli strumenti, è possibile modificare ciò che
viene mostrato dal resoconto e da quale conto vengono prelevate le informazioni. Selezionando Modifica

→ Fogli di stile... si possono modificare le proprietà della pagina web che visualizza il resoconto.

Il resoconto è in grado di agire come una pagine internet se contiene dei collegamenti a delle pagine ester-
ne. I pulsanti della barra degli strumenti permettono di muoversi Avanti e Indietro attraverso le pagine.
Facendo clic sui collegamenti ai nomi dei conti contenuti nel resoconto verranno anche aperte le informa-
zioni nella finestra del registro.

È inoltre possibile esportare il proprio resoconto e effettuarne la stampa attraverso i pulsanti della barra
degli strumenti.

Barra di riepilogo
La Barra di riepilogo non è mostrata quando è visualizzato un resoconto.

Barra di stato
La barra di stato funziona esattamente come già descritto in la sezione chiamata «Barra di stato».
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Finestra di riconciliazione
Per semplificarne la consultazione, si riporta l’elenco degli argomenti affrontati in questa sezione: la se-
zione chiamata «Finestra di riconciliazione», la sezione chiamata «Menu», la sezione chiamata «Pulsanti
della Barra degli strumenti».

La spiegazione dettagliata del processo di riconciliazione di un conto è fornita in la sezione chiamata
«Riconciliare un conto a un estratto conto».

Finestra di riconciliazione

Per aprire la finestra di Riconciliazione, selezionare Operazioni → Riconciliazione... dalla barra del menu
o il pulsante Riconciliazione dalla barra degli strumenti in una finestra del registro. Verrà aperta una
schermata di Riconciliazione in cui è necessario inserire la Data dell’estratto conto e il Saldo finale. Se
si seleziona l’opzione Includi i sottoconti, tutte le transazioni incluse nei sottoconti verranno prese in
considerazione per l’operazione di riconciliazione. Premendo il pulsante OK verrà aperta la finestra di
Riconciliazione vera e propria in cui è possibile confrontare le transazioni di deposito e di prelievo con
il proprio estratto conto.

Tabella 4.21. Componenti della finestra di riconciliazione.

Componenti Descrizione

Barra del menu Contiene i menu utilizzati nella finestra di riconci-
liazione.

Barra degli strumenti (icone e/o testo) Contiene dei pulsanti utili per accedere alle funzioni
più comunemente utilizzate nella finestra di ricon-
ciliazione del conto.

Fondi in entrata Questo riquadro a sinistra contiene un elenco di tran-
sazioni che depositano sul conto.

Fondi in uscita Questo riquadro a destra contiene un elenco di tran-
sazioni che prelevano dal conto.

Pannello del saldo Questo riquadro in basso a destra contiene un elenco
dei saldi utili per completare la riconciliazione.

Menu

La tabella seguente descrive le voci di menu presenti nella finestra di riconciliazione.

Tabella 4.22. Menu Riconcilia - permette l’accesso alle informazioni di
riconciliazione e ai comandi utili per terminare la riconciliazione o rinviarla.

Voce del menu Descrizione

Informazioni di riconciliazione... Apre la finestra delle informazioni di riconciliazio-
ne.

Termina (Ctrl+F) Completa la riconciliazione di questo conto.

Posticipa (Ctrl+P) Rinvia la riconciliazione di questo conto.

Annulla Annulla la riconciliazione di questo conto.
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Tabella 4.23. Menu Conto - permette l’accesso alle operazioni relative al conto.

Voce del menu Descrizione

Apri conto Apre il registro delle transazioni per i conti

Modifica conto Modifica il nome e le caratteristiche del conto sele-
zionato. la sezione chiamata «Modificare un conto»

Trasferimenti... (Ctrl+T) Apre la procedura di trasferimento di una transazio-
ne tra due conti.

Controlla e ripara Verifica e ripara il conto selezionato se necessario.

Tabella 4.24. Menu Transazione - accede alle operazioni di modifica della
transazione.

Voce del menu Descrizione

Nuovo Aggiunge una nuova transazione al conto.

Saldo Apre il registro del conto con una transazione di bi-
lanciamento pre-compilata.

Modifica Modifica la transazione selezionata.

Cancella Rimuove la transazione selezionata.

Tabella 4.25. Menu Aiuto - accesso all’aiuto.

Voce del menu Descrizione

Aiuto Apre questo documento di aiuto.

Pulsanti della Barra degli strumenti

La finestra di riconciliazione è dotata di una barra degli strumenti che facilita l’accesso ad alcune delle
funzioni più comunemente utilizzate per la riconciliazione.

Tabella 4.26. Barra degli strumenti della finestra di Riconciliazione

Pulsante della Barra degli strumenti Descrizione

Nuovo Aggiunge una nuova transazione al conto.

Saldo Apre il registro del conto con una transazione di bi-
lanciamento pre-compilata.

Modifica Modifica la transazione selezionata.

Cancella Rimuove la transazione selezionata.

Apri Apre il registro del conto contenente la transazione.

Termina Completa la riconciliazione di questo conto.

Nota

Questo pulsante non è attivato finché il va-
lore della Differenza nel riquadro del saldo
(in basso a destra) è 0.

Posticipa Rinvia la riconciliazione di questo conto.
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Pulsante della Barra degli strumenti Descrizione

Annulla Annulla la riconciliazione di questo conto.

Finestra della transazione pianificata
Per semplificarne la consultazione, si riporta l’elenco degli argomenti affrontati in questa sezione: la se-
zione chiamata «Menu Pianifica», la sezione chiamata «Pulsanti della Barra degli strumenti per la fine-
stra delle Transazioni pianificate», la sezione chiamata «Finestra della transazione pianificata». la sezione
chiamata «Finestra di modifica della transazione pianificata»,

La descrizione dettagliata di cosa si intende per transazione pianificata, è fornita in la sezione chiamata
«Pianificare le transazioni».

Finestra principale delle transazioni pianificate

Questa finestra è mostrata quando si seleziona la voce Operazioni → Transazioni pianificate → Editor
transazioni pianificate dalla barra del menu. Verrà aperta una finestra che visualizzerà la transazione pia-
nificata.

Componenti principali della finestra per le transazioni pianificate

Tabella 4.27. Componenti della finestra per le transazioni pianificate.

Componenti Descrizione

Barra del menu Contiene il menu utilizzato nella finestra della tran-
sazioni pianificate. Fornisce la lista standard delle
opzioni della barra del menu e in più la voce Pia-
nifica, che contiene i comandi Nuovo, Modifica e
Cancella. Se non è selezionata alcuna transazione, le
voci Modifica e Cancella non saranno selezionabili.

Barra degli strumenti (icone e/o testo) Contiene dei pulsanti utilizzabili per accedere alle
operazioni relative alle transazioni pianificate.

Schede Permettono di muoversi tra le schermate aperte.

Transazioni Il riquadro Transazioni contiene un elenco di tran-
sazioni pianificate e delle relative caratteristiche.

Prossime scadenze Il riquadro delle Prossime scadenze contiene un ca-
lendario dei mesi successivi. In questo calendario
sono evidenziati i giorni in cui sono pianificate una
o più transazioni.

È possibile modificare l’intervallo di date visualiz-
zato nel calendario selezionando un periodo diverso
dalla lista a comparsa Visualizza sulla destra.

Suggerimento

Fare clic con il mouse nel riquadro e ver-
ranno visualizzati i dettagli relativi alle
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Componenti Descrizione

transazioni pianificate per la data selezio-
nata.

Menu Pianifica

La tabella seguente descrive le opzioni del menu Pianifica disponibile nella Barr del menu all’interno della
finestra delle Transazioni pianificate.

Tabella 4.28. Menu Pianifica - permette di accedere alle operazioni di modifica della
transazione pianificata.

Voce del menu Descrizione

Nuovo Aggiunge una nuova transazione pianificata.

Modifica Modifica la transazione selezionata.

Cancella Rimuove la transazione selezionata.

Pulsanti della Barra degli strumenti per la finestra delle Transazioni
pianificate

La finestra per le Transazioni pianificate presenta una barra degli strumenti utile per accedere velocemente
alle funzioni più comunemente utilizzate per la pianificazione.

Tabella 4.29. Barra degli strumenti della finestra Transazioni pianificate

Pulsante della Barra degli strumenti Descrizione

Salva (Ctrl+S) Modifica la transazione selezionata.

Chiudi (Ctrl+W) Chiude la finestra delle Transazioni pianificate.

Nuovo Salva la pianificazione della transazione seleziona-
ta.

Modifica Modifica la transazione selezionata.

Cancella Rimuove la transazione selezionata.
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Capitolo 5. Impostare, modificare e
lavorare con i conti

In questa sezione è descritto il processo di impostazione, modifica e funzionamento dei conti di GnuCash.
In GnuCash un conto è uno strumento essenziale per organizzare la registrazione della provenienza e della
destinazione del denaro. GnuCash estende inoltre il concetto di conto reale, quali il conto bancario o un
conto di prestito, per abbracciare anche entrate e uscite. Questo permette di conoscere immediatamente
dove il denaro è stato speso e a quanto ammontano entrate ed uscite. GnuCash imposta il tipo di conto
(come descritto nella sezione seguente) per assistere nell’organizzazione e nel raggruppamento dei conti.
I tipi di conti possono essere utilizzati per creare una struttura dei conti.

Tipi di conti in GnuCash
GnuCash supporta un certo numero di tipi di conti differenti. Si raccomanda di scegliere un tipo di conto
appropriato basandosi sull’elenco riportato di seguito.

Avvertimento

The Accounts Payable and Accounts Receivable types are used internally by GnuCash’s business
features. Users should not manually modify or enter transactions in these account types.

Tabella 5.1. Tipi di conti in GnuCash.

Tipo di conto Descrizione

Debiti correnti I conti per i debiti correnti sono utilizzati nella con-
tabilità per le imprese allo scopo di registrare gli im-
porti che devono essere pagati. Esempio: l’impresa
ha comprato un bene, ma non ha pagato la ricevuta
fino a ora.

Nota

Le versioni precedenti di questo aiuto defi-
nivano D/C e C/C al contrario.

Crediti correnti I conti per i crediti correnti registrano gli importi per
cui il denaro non è ancora stato ricevuto. Esempio:
un’impresa ha venduto un bene ed ha emesso una
fattura ma il cliente non ha pagato fino a ora.

Nota

Le versioni precedenti di questo aiuto defi-
nivano D/C e C/C al contrario.

Attività I conti delle attività sono utilizzati per tenere traccia
di ciò che ha un valore e può essere utilizzato o ven-
duto per pagare dei debiti (normalmente è un conto
segnaposto).

Banca I conti di questo tipo denotano i risparmi o il conto
corrente accesi presso una banca o altra istituzione
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Tipo di conto Descrizione

finanziaria. Alcuni di questi conti possono produr-
re interessi. Questa è anche la tipologia di conto ap-
propriata per il libretto degli assegni il quale preleva
direttamente da un conto corrente.

Liquidi Il conto liquidi è utilizzato per indicare il denaro te-
nuto nel portafoglio, nella scatola delle scarpe, nel
salvadanaio o sotto al materasso.

Carta di credito Il conto carta di credito è utilizzato per identificare i
conti delle carte di credito. The Credit Card account
type is used to denote credit card accounts, both for
cards that allow floating lines of credit (e.g. VISA,
MasterCard, or Discover) and with cards that do not
permit continuing balances (e.g. American Express)

Valuta I conti della valuta erano utilizzati per scambiare le
valute, ma sono stati sostituiti dal riquadro per il tar-
sferimento di valuta presente nella finestra di trasfe-
rimento fondi (la sezione chiamata «Finestra di tra-
sferimento fondi»).

Capitale I conti del capitale sono utilizzati per registrare i bi-
lanci di apertura quando si utilizza GnuCash per la
prima volta o quando si inizia un nuovo periodo con-
tabile.

Uscite Qualsiasi spesa come il cibo, l’abbigliamento, le tas-
se ecc... Questa tipologia di conto è identificata co-
me una categoria in Quicken.

Entrate Qualsiasi entrata ricevuta da fonti quali stipendio,
interessi, dividendi ecc... Questa tipologia di conti è
indicata come una categoria in Quicken.

Passività I conti di passività sono utilizzati per registrare i de-
biti o le obbligazioni finanziarie. (Normalmente è un
conto segnaposto).

Fondo comune Un portafoglio di azioni e bond gestiti da professio-
nisti o altri investimenti comunque divisi in quote.

Azioni Una condivisione di proprietà in una corporazione,
che impegna il proprietario a tutti i rischi e premi
che questo comporta.

L’assistente per la Creazione di una nuova struttura conti descritto nella prima sezione di questo docu-
mento, è un modo pratico per impostare un gruppo di conti da utilizzare come ossatura dei tipi di conti.

Quando vengono creati dei nuovi conti, le scelte disponibili dei tipi di conti vengono colorate in grigio in
accordo con il tipo di conto padre. La lista seguente elenca le scelte possibili.

• Debiti correnti: tutti i conti a eccezione del capitale, uscite e entrate possono essere conti figli.

• Crediti correnti: tutti i conti a eccezione del capitale, uscite e entrate possono essere conti figli.

• Patrimonio: tutti i conti a eccezione del capitale, uscite e entrate possono essere conti figli.

• Banca: tutti i conti a eccezione del capitale, uscite e entrate possono essere conti figli.
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• Liquidi: tutti i conti a eccezione del capitale, uscite e entrate possono essere conti figli.

• Carta di credito: tutti i conti a eccezione del capitale, uscite e entrate possono essere conti figli.

• Valuta: tutti i conti a eccezione del capitale, uscite e entrate possono essere conti figli.

• Capitale: solo il conto capitale può essere un conto figlio.

• Uscite: solo i conti di uscite o entrate possono essere conti figli.

• Entrate: solo i conti di uscite o entrate possono essere conti figli.

• Passività: tutti i conti a eccezione del capitale, uscite e entrate possono essere conti figli.

• Fondi comuni: tutti i conti a eccezione del capitale, uscite e entrate possono essere conti figli.

• Azioni: tutti i conti a eccezione del capitale, uscite e entrate possono essere conti figli.

Creare una struttura dei conti
La struttura dei conti è come una indice delle proprie finanze. Il miglior modo per concettualizzare una
struttura dei conti è di pensarla come un albero. I rami principali rappresentano intere categorie o gruppi,
mentre le foglie dell’albero rappresentano conti bancari o categorie di uscite. Quando viene richiesto un
resoconto sommario, tipicamente solo i rami principali vengono riportati, invece che i conti individual-
mente. Per esempio, una struttura dei conti potrebbe assomigliare alla seguente:

300 Uscite | +--310 Bollette | | | +--311 Birra | | | +--312 Abbonamento TV | +--320 Uscite di lavoro | | | +--321 Dichetti | | | +--322 Dischi Blue Ray | | : :

Codici dei conti

I conti non hanno solo dei nomi; possono avere anche dei codici, per essere ordinati. Quando
viene generato un resoconto, l’ordinamento è determinato dalla numerazione. È consuetudine che
i numeri dei sottoconti non terminino con zero, mentre i conti padre abbiano numeri crescenti
dallo zero.

Avvertimento

GnuCash non impedisce che vengano utilizzati dei numeri duplicati, comunque se ne scoraggia
l’utilizzo. I codici dei conti sono trattati come numeri in base 36, quindi, se si terminano i numeri,
è possibile utilizzare le lettere dalla a alla z.

Modificare una struttura dei conti
Le modifiche alla struttura dei conti possono essere effettuate direttamente dal riquadro del Conto padre
presente nella finestra di Modifica conto. È possibile spostare un conto in qualsiasi parte della struttura.
Si raccomanda comunque di mantenere i conti raggruppati a seconda del tipo come descritto in la sezione
chiamata «Tipi di conti in GnuCash»; questo aiuta a preservare lo schema della struttura dei conti..

Per spostare il conto selezionato in un differente conto padre è sufficiente selezionare il conto nel riquadro
del Conto padre. Se viene selezionato Nuovo conto di livello principale allora il conto verrà spostato al
livello principale.
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Creare un nuovo conto
Per creare un nuovo conto selezionare Operazioni → Nuovo conto... o fare clic sul pulsante Nuovo della
barra degli strumenti quando è visualizzata la finestra della struttura dei conti. Verrà aperta la finestra per
la creazione di un Nuovo conto.

La finestre di dialogo delle proprietà per un Nuovo conto consta di due schede, quella delle preferenze
Generali e quella del Bilancio d’apertura.

Creare un nuovo conto richiede la pianificazione di alcuni dettagli che dovranno essere inseriti nella fine-
stra di dialogo per il nuovo conto.

• Il tipo di conto di cui si ha bisogno.

• Dove si deve posizionare nella struttura dei conti.

• Se è previsto un bilancio preventivo.

• Se c’è la necessità di una commodity (titolo/valuta) per il conto.

• Se si ha bisogno dell’aggiornamento online del prezzo della commodity.

Questi dettagli sono descritti nel seguito.

Scheda delle informazioni generali
La scheda Generali permette l’accesso alle informazioni di base del conto. Fornisce un modo di collegare
il conto alle informazioni sulle azioni se si tratta di un tipo di conto per la valuta, per i fondi comuni o
per le azioni. Qui, il conto può anche essere marcato come segnaposto; viene inoltre mostrato se il conto è

identificato come relativo alle tasse (che è configurato attraverso il menu Modifica → Opzioni resoconto
tasse).

Sono presenti sette riquadri nella sezione Identificazione di questa scheda.

1. Nome conto: il nome per il conto (ad esempio Conto Corrente Banca).

2. Codice conto: un codice del conto opzionale come descritto in Codici dei conti.

3. Descrizione: una descrizione opzionale per il conto.

4. Titolo/valuta:

Nota

Il campo Tipo alla voce Seleziona titolo dipende dalla selezione fatta nel pannello Tipo di
conto nella schermata Nuovo conto.

• Per i conti diversi da Azioni e Fondi comuni questa dovrebbe essere la valuta predefinita cioè EUR
(Euro) o il simbolo della propria valuta locale. Se questo conto è per una valuta estera, premere il
pulsante Seleziona... per scegliere una valuta differente dalla lista a comparsa delle valute.

• Per i conti contenenti azioni e fondi comuni; selezionare dapprima Azioni o Fondi comuni nel riqua-
dro del Tipo di conto, poi il Conto padre, infine usare il pulsante Seleziona..., per scegliere il Tipo
(normalmente il mercato dove il titolo viene scambiato) e il Titolo dalla finestra di Scelta del titolo.

Se il titolo o il fondo di cui si ha bisogno non compare nell’elenco ma se ne conosce il Tipo, è
possibile creare il titolo o il fondo. Per creare una commodity per i fondi comuni e per le azioni,
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selezionare Nuovo..., nella schermata di Scelta del titolo, per aprire la schermata del Nuovo titolo:.
Le opzioni presenti sono descritte in la sezione chiamata «Editor titoli». Inserire un Nome, il simbolo,
selezionare il Tipo e infine premere il pulsante Chiudi per creare il titolo. Dopo che il titolo è stato
creato, selezionare il Tipo: (normalmente la borsa dove il titolo viene scambiato) e il nome nella lista
a comparsa Valuta/titolo: e premere Chiudi per chiudere la finestra.

5. Frazione minima: la frazione minima che verrà registrata.

6. Colore del conto: il colore da assegnare alla scheda del registro relativo a questo conto. Fare clic sul
pulsante del colore per aprire la schermata di Selezione del colore. Per ripristinare il colore del conto
fare clic sul pulsante Predefinito.

7. Note: riquadro per inserire del testo liberamente; è utilizzato per qualsiasi nota aggiuntiva relativa al
conto.

Sotto a questi riqaudri, sono presenti delle opzioni: una indica se il conto è Relativo alle tasse (impostabile

tramite il menu Modifica → Opzioni tasse), mentre le altre due permettono di marcare il conto come
Segnaposto e Nascosto.

L’opzione Relativo alle tasse permette di marcare il conto per essere incluso nelle esportazioni relative alle
tasse. Questo attributo è visualizzato solamente nella schermata di Modifica conto ed è impostato nella

finestra delle Informazioni tasse sulle entrate (Modifica → Opzioni resoconto tasse). Consultare la sezione
sui resoconti delle tasse e sull’esportazione dei file TXF nel capitolo sui resoconti (la sezione chiamata
«Resoconti generali»).

L’opzione Segnaposto indica che il conto rappresenta solamente un segnaposto nella struttura; è utilizzato
solamente per permettere l’impostazione di una struttura dei conti.

Nota

L’opzione Segnaposto indica che il conto non deve essere utilizato per contenere i dati sulle
transazioni. Se il conto è un segnaposto, non potrà contenere delle transazioni: le transazioni
potranno essere inserite solamente negli eventuali suoi sottoconti non identificati anch’essi come
Segnaposto.

L’opzione Nascosto permette di nascondere questo conto (e ogni suo sottoconto) nella struttura dei conti
e di non visualizzarlo nella lista a comparsa dei conti nella finestra del registro. Per disabilitare questa

opzione occorre andare in Visualizza → Filtra per... nella finestra della struttura dei conti, e abilitare
l’opzione Visualizza i conti nascosti. In questo modo sarà possibile selezionare il conto e riaprire questa
finestra.

Il riquadro seguente contiene una elenco di Tipi di conto. Selezionarne uno in base alla descrizione fornita
in la sezione chiamata «Tipi di conti in GnuCash».

Il riquadro successivo contiene un albero dei conti dal quale scegliere il Conto padre. Per creare un nuovo
albero dei conti, selezionare Nuovo conto di livello principale.

Nota

Le scelte disponibili nel riquadro del Tipo di conto dipendono dalla selezione effettuata nel ri-
quadro del Conto padre. Per esempio se il Conto padre è Capitali verrà mostrato solamente il
Tipo di conto Capitale. Questo permette di mantenere una struttura dei conti coerente.
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Procedura per abilitare l’aggiornamento dei prezzi online

• GnuCash si affida a uno strumento esterno per recuperare le quotazioni via internet. Questo strumento
è un modulo di Perl denominato Finance::Quote e deve essere installato sul proprio computer indipen-
dentemente da GnuCash. Il primo passo per abilitare l’aggiornamento delle quotazioni tramite internet
consiste nell’assicurarsi che Finance::Quote sia installato correttamente.

Per sapere se il modulo di Perl Finance::Quote è già installato nel sistema, digitare «perldoc
Finance::Quote» in una finestra del terminale e verificare se c’è qualche documentazione disponibile.
Se c’è la documentazione allora il modulo è installato, altrimenti no.

L’installazione di Finance::Quote differisce a seconda del sistema operativo in uso. Per i vari sistemi
supportati, è possibile seguire le seguenti linee guida:

• Linux: la maggior parte delle distribuzioni (Fedora, openSuse, Mandriva, Ubuntu, ecc... ) forniscono
un pacchetto nei propri repository per il modulo di perl Finance::Quote. Quindi nella maggior parte
dei casi è sufficiente utilizzare il proprio gestore di pacchetti preferito (yum, apt, rpm, synaptics, yast,
ecc...) per installare il modulo. Il nome del pacchetto può variare da distribuzione a distribuzione. In
genere ha un nome del tipo «perl-Finance-Quote».

• Windows: Finance::Quote su windows richiede che sia già installato perl. Se non lo è, è prima ne-
cessario installare ActivePerl.

Il file installabile di GnuCash disponibile sulla pagina principale, contiene un piccolo programma che
assiste nell’installazione di Finance::Quote. È possibile raggiungerlo dal menu «Start» nel gruppo
GnuCash ed è chiamato «Installa la funzione di ricerca delle quotazioni online».

• Mac OS X: se GnuCash è stato installato dal pacchetto di installazione disponibile sulla pagina prin-
cipale di GnuCash, Finance::Quote è già installato.

• Se nessuno dei precedenti casi è adatto alla propria situazione, è possibile seguire le seguenti istruzioni
più generali:

1. Chiude ogni sessione di GnuCash aperta.

2. Trovare la cartella dove è installato GnuCash cercando la stringa «gnc-fq-update» (senza le vir-
golette).

3. Spostarsi in questa cartella, aprire una finestra del terminale ed eseguire come root il comando
«gnc-fq-update» (senza le virgolette). Si aprirà una sessione di aggiornamento di Perl CPAN che
installerà nel sistema, attraverso internet, il modulo Finance::Quote. Il programma gnc-fq-upda-
te è interattivo, comunque, con la maggior parte dei sistemi, si potrà rispondere «no» alla prima
domanda: «Eseguire la configurazione manuale? [sì]» e l’aggiornamento continuerà automatica-
mente da questo punto.

Quando l’installazione è terminata, eseguire il programma di test «gnc-fq-dump», nella stessa cartella,
distribuito con GnuCash per verificare se Finance::Quote è installato e funziona correttamente.

Nota

Se non ci si sente sicuri nell’esecuzione di questi passaggi, è possibile contattare la lista di di-
scussione degli utenti di GnuCash (<gnucash-user@gnucash.org>) per chiedere aiuto
o andare nell canale IRC di GnuCash su irc.gnome.org. È anche possibile saltare questi pas-
saggi e aggiornare manualmente i prezzi delle proprie azioni.
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• Creare il conto per il fondo comune o per le azioni impostando il campo titolo/valuta, come descritto
nel seguito.

Suggerimento

Quando si creano questi tipi di conti, si consiglia di creare anche dei conti delle entrate per
registrare i dividendi, i guadagni in capitale (nel lungo e nel breve periodo) e i conti per le
uscite per registrare le commissioni e le perdite ( se si considerano le perdite come uscite).

• Si creino il fondo comune o le azioni sia utilizzando l’editor titoli per le azioni o i fondi esistenti, o la
finestra del nuovo titolo perle nuove azioni o fondi.

Selezionare l’opzione Ricevi quotazioni online, il tipo di fonte per le quote e il Fuso orario.

Per la ricezione delle quotazioni via internet, è necessario avere abilitato le opzioni per la ricezione delle
quote online e il fuso orario.

• Ricevi quotazioni online - questa opzione permette di abilitare lo specifico titolo o azioni alla ricezione
delle quotazioni da una fonte online.

• Tipo di fonte per le quote: selezionare, fra le tre opzioni disponibili, il tipo di fonte da cui ricevere
le quotazioni. Le fonti Multi-riga quali «Europe» possono essere usate per superare i problemi di
connessione con un unica fonte. Scegliendo invece Singola, verranno ricercate informazioni solo
dalla fonte specificata.

Dopo aver selezionato il tipo di fonte per le quotazioni, selezionare un elemento della relativa lista
a a comparsa. Attualmente fra le fonti disponibili e supportate, si ricordano: Yahoo, Yahoo Europe,
Fidelity Investments, T. Rowe Price, the Vanguard Group, the Australian Stock Exchange (ASX) e
TIAA-CREF.

Nota

Si noti che Yahoo fornirà le quotazioni per diversi fondi comuni compresi Fidelity, T.Rowe
Price e Vanguard, e che i prezzi indicati da Yahoo dovrebbero essere identici a quelli che
è possibile reperire nei siti di origine.

Se si sceglie Yahoo Europe o Europe, è necessario indicare il codice della borsa per il titolo, come,
per esempio, PA per Parigi, BE per Berlino ecc... Esempio: 12150.PA (un titolo Peugeot sul mercato
di Parigi). Tabella A.1, «Lista dei codici delle borse per i mercati Europei» elenca i codici per i vari
mercati Europei.

Pseudo-simboli per i fondi TIAA-CREF sono elencati nella tabella Tabella A.2, «Pseudo simboli da
utilizzare per le quotazioni TIAA-CREF».

• Fuso orario - selezionare il fuso orario per la quota che si desidera ricevere. Per esempio, Yahoo
fornisce le quotazioni con il fuso orario della costa orientale degli Stati Uniti, quindi occorre scegliere
America/New York se si utilizza questa fonte per le quotazioni.

• Selezionare una commodity nell’editor dei prezzi.

• Selezionare Ricevi quotazioni nella finestra di modifica prezzo.

• Controllare l’ultimo prezzo per il titolo selezionato.

Per aggiornare le quotazioni dalla linea di comando, eseguire il comando seguente:

gnucash --add-price-quotes <nome-de-file-di-gnucash>
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Il comando gnucash --add-price-quotes <gnucash-file-name> può essere utilizzato per
ottenere il prezzo corrente delle proprie azioni. Il file specificato «<gnucash-file-name>» dipenderà dal
nome e dalla posizione del proprio file dei dati. Questo può essere individuato dal nome visualizzato nella
cornice in alto nella finestra di GnuCash prima del «-». Il nome del file può anche essere trovato nel menu
File nell’elenco dei file recentemente aperti; il primo elemento, numerato 1, è il nome del file attualmente
aperto.

Questa procedure può essere automatizzata creando un comando di crontab. Per esempio, per aggiornare
il proprio file Venerdì sera (alle 18:00) dopo la chiusura della borsa (l’orario può essere diverso a seconda
del fuso), è possibile aggiungere il comando seguente alla lista del crontab:

0 18 * * 5 gnucash --add-price-quotes $HOME/gnucash-filename > /dev/null 2>e1

Si ricordi che i «prezzi» dei fondi comuni rappresentano dei «valori di capitale netto (NAV)» e richiedono
diverse ore dopo la chiusura dei mercati per essere disponibili. Se i NAV vengono scaricati prima del
giorno in cui vengono determinati, si riceveranno i valori del giorno precedente.

Scheda del bilancio di apertura
La scheda del bilancio di apertura è visibile solo quando si crea un nuovo conto. Il bilancio di apertura
è utilizzato per registrare il saldo iniziale di un conto. Questo permette di utilizzarlo in due differenti
situazioni. Se si usa GnuCash per la prima volta per registrare delle transazioni, può essere usato come
saldo iniziale. Se i conti sono chiusi alla fine di un periodo e dei nuovi conti sono creati, è utilizzato per
chiudere e trasferire i saldi in avanti.

In questa scheda sono presenti tre riquadri. Quello superiore contiene le Informazioni sul saldo.

• Saldo: immettere il saldo con cui inizializzare il conto.

• Data: la data con cui il bilancio di apertura deve essere registrato.

Il riquadro successivo è quello del Tipo di trasferimento.

• Utilizza il conto del capitale per i bilanci di apertura: in questo modo si trasferisce il bilancio di apertura
per il conto da un conto standard del capitale chiamato bilanci di apertura.

• Selezionare il conto di trasferimento: questa opzione abilita il riquadro inferiore in modo che un conto
differente possa essere utilizzato per trasferire il bilancio di apertura.

L’ultimo riquadro è quello del Conto di trasferimento. Selezionare il conto da utilizzare per il bilancio
d’apertura scegliendo fra quelli della lista nel riquadro.

Modificare un conto
La finestra di modifica del conto consta di una sola scheda per le informazioni generali. Questa finestra
presenta le stesse informazioni che sono già state descritte in la sezione chiamata «Creare un nuovo conto».

Per accedere alla finestra di Modifica conto andare in Modifica → Modifica conto (scorciatoia di menu
Ctrl+E) o premere il pulsante Modifica della barra degli strumenti nella finestra della struttura dei conti.

Rinumerare i sottoconti
Utilizzare Rinumera sottoconti per riassegnare i codici dei conti per tutti i figli del conto padre corrente.
Per esempio, se si ha la seguente struttura dei conti:
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Tabella 5.2. Numeri iniziali dei conti.

Codice Nome

10 Colori

10-1 Rosso

10-2 Arancione

10-3 Giallo

10-4 Blu

10-5 Viola

Si voglia ora aggiungere il conto «Verde», ma si voglia anche inserirlo tra i conti «Giallo» e «Blu». Invece
di dover rinumerare tutti i conti manualmente a partire dal «Blu», si può usare il comando Rinumera
sottoconti per il conto «Colori». Nella finestra che comparirà il valore della voce prefisso dovrebbe essere
già impostata a «10», il codice del conto «Colori». Se si imposta un valore dell’intervallo pari a «5» e si
preme Rinumera, si otterrà la seguente struttura:

Tabella 5.3. Numeri dei conti rinumerati

Codice Nome

10 Colori

10-05 Rosso

10-10 Arancione

10-15 Giallo

10-20 Blu

10-25 Viola

Ora è disponibile lo spazio necessario nella numerazione dei conti per aggiungere il conto Verde con un
codice adatto per inserirlo dove si desidera.

Tabella 5.4. Numeri finali dei conti.

Codice Nome

10 Colori

10-05 Rosso

10-10 Arancione

10-15 Giallo

10-18 Verde

10-20 Blu

10-25 Viola

Cancellare un conto

Cancellare un conto significa rimuovere dal file tutte le informazioni sulle transazioni e le informazioni
del conto stesso. L’operazione di cancellazione non può essere annullata. Verrà richiesto di confermare
la rimozione del conto. Se il conto contiene ancora delle informazioni sulle transazioni, si verrà avvertiti
che il conto contiene ancora delle transazioni..
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Un effetto conseguente alla rimozione di un conto che contiene delle transazioni, è che ci si ritroverà con
dei conti non bilanciati. Questo fatto verrà indicato nel conto con un segno di spunta vicino agli importi
di debito e credito. È possibile riparare automaticamente questi conti non bilanciati utilizzando il menu

Operazioni → Controlla e ripara. Automaticamente verranno assegnati gli importi non bilanciati a un
nuovo conto denominato Sbilancio.

Riconciliare un conto a un estratto conto
In GnuCash la riconciliazioni dei conti con gli estratti conti bancari o di qualsiasi altra istituzione finan-
ziaria, è un modo di controllare l’accuratezza delle proprie transazioni (e di quelle della banca) e il saldo
dei propri conti. È anche un’operazione utile per rintracciare gli assegni non riscossi e altre transazioni
insolute.

La barra di riepilogo in fondo alla finestra del registro del conto mostra l’importo Attuale (saldo), Futuro
(saldo), Liquidato (transazioni), Riconciliato (transazioni) e Minimo previsto. Le informazioni online sul
conto possono essere utilizzate per indicare quale transazione è stata elaborata dalla banca cambiando
la colonna R (stato di riconciliazione) nella finestra del registro, da n (non riconciliata) a l (liquidata).
L’estratto conto della banca viene poi utilizzato, nella finestra di riconciliazione, per riconciliare il conto;
dopo questa operazione il campo della colonna R verrà cambiato in s (riconciliata).

La finestra di riconciliazione è accessibile dalla finestra della struttura ad albero dei conti o da quella del

registro del conto, andando in Operazioni → Riconcilia... (scorciatoia Alt+A, R).

Finestra delle informazioni di riconciliazione
La finestra delle informazioni di riconciliazione, richiede l’immissione della data dell’estratto conto e dei
saldi iniziale (imposto dall’ultima riconciliazione) e finale fornito dall’estratto conto. L’opzione Includi
i sottoconti è utile se vengono utilizzati due o più conti per registrare le operazioni del conto bancario.
Il pulsante Immissione pagamento interessi permette di aggiungere un trasferimento ai conti per degli
interessi. Se selezionato, verrà visualizzata una finestra per aggiungere un pagamento di interessi verso
il conto.

Sono presenti tre riquadri nella finestra del pagamento degli interessi: in basso si trova un pulsante deno-
minato Nessun pagamento automatico di interessi per questo conto che, alla sua pressione, chiuderà la
finestra; in alto, invece, sono richieste le informazioni sul pagamento.

• Importo: inserire l’importo degli interessi.

• Data: selezionare la data del pagamento degli interessi.

• Nr.: inserire un numero per la transazione (opzionale).

• Descrizione: inserire una descrizione per la transazione.

• Promemoria: inserire una nota riguardante la transazione (opzionale).

Il riquadro centrale presenta invece una lista di conti tra cui selezionare quello del Pagamento da. Se il
pagamento è per un credito o un prestito allora generalmente si dovrà scegliere un conto per le uscite;
se invece il pagamento è per un conto corrente o di risparmio allora, generalmente, si dovrà scegliere un
conto delle entrate. L’opzione Visualizza entrate e uscite permette di mostrare o nascondere i conti di
entrate e uscite.

Selezionare OK per inserire la transazione per gli interessi e tornare alla finestra iniziale di riconciliazione.
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Finestra di riconciliazione

Le transazioni non riconciliate presenti nei riquadri dei fondi in entrata e dei fondi in uscita, possono
essere modificate utilizzando i menu e la barra degli strumenti per accedere alle informazioni sul conto e

sulla transazione. Per posticipare la riconciliazione, selezionare la voce del menu Riconcilia → Posticipa
(scorciatoia Ctrl+P) o premere il pulsante Posticipa. Per annullare la riconciliazione, selezionare l’opzione

del menu Riconcilia → Annulla o premere il pulsante Annulla sulla barra degli strumenti.

Selezionare in questa finestra ogni transazione non riconciliata che ne ha una corrispondente sull’estratto
bancario cartaceo: così facendo apparirà un segno di spunta di colore verde nella colonna R. Il riquadro dei
saldi cambierà in funzione di ogni transazione selezionata fino a quando il saldo finale non sarà uguale a
saldo di riconciliazione e la differenza nulla. Terminata questa procedura selezionare o il pulsante Termina

sulla barra degli strumenti o la voce del menu Riconcilia → Termina (scorciatoia Ctrl+F) per completare
il processo di riconciliazione.

Finestra di riconciliazione
Il riquadro dei Fondi in entrata mostra tutte le entrate nel conto non ancora riconciliate.

• Data: la data della transazione non riconciliata.

• Nr.: il numero della transazione non riconciliata.

• Descrizione: la descrizione della transazione non riconciliata.

• Importo: l’importo della transazione non riconciliata.

• R: mostra una spunta verde se la transazione verrà riconciliata al termine della procedura.

Il riquadro Fondi in uscita mostra tutte le uscite dal conto non ancora riconciliate.

• Data: la data della transazione non riconciliata.

• Nr.: il numero della transazione non riconciliata.

• Descrizione: la descrizione della transazione non riconciliata.

• Importo: l’importo della transazione non riconciliata.

• R: mostra una spunta verde se la transazione verrà riconciliata al termine della procedura.

Il riquadro del Saldo mostra i saldi utilizzati nella riconciliazione.

• Saldo iniziale: il saldo alla fine dell’ultima riconciliazione.

• Saldo finale: il saldo presente sull’estratto conto da riconciliare.

• Saldo riconciliato: il saldo delle transazioni selezionate.

• Differenza: la differenza tra il saldo riconciliato e il saldo finale.
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Capitolo 6. Operazioni comuni per le
transazioni

Una transazione rappresenta un movimento di denaro da un conto ad un altro. Ogni volta che si spende o si
riceve del denaro, oppure si trasferisce denaro da un conto ad un altro, si parla di transazione. In GnuCash
queste operazioni coinvolgono sempre almeno due conti.

GnuCash utilizza i conti come metodo per raggruppare ed organizzare la registrazione delle transazioni.
Questa sezione descrive i metodi che GnuCash fornisce per aiutare ad inserire velocemente nel registro
le transazioni.

GnuCash permette di inserire le transazioni in diversi modi.

• Immettere le transazioni direttamente dalla finestra del registro rappresenta il metodo più immediato.

• Utilizzando la finestra del trasferimento fondi.

• Importando le transazioni o da un file QIF/OFX o attraverso "OFX online banking".

Cambiare la visualizzazione del registro
GnuCash fornisce diverse opzioni per cambiare il modo in cui viene visualizzato il registro permettendo
di mostrare con più chiarezza le transazioni. Lo stile predefinito è quello a "libro mastro basilare": con
questa modalità viene mostrata una singola linea per ogni transazione e si tratta del metodo più sintetico
per la visualizzazione dei dettagli più rilevanti.

Lo stile di visualizzazione predefinito può essere cambiato dal menu Visualizza: qui sono possibili tre
scelte. Quando al finestra del registro viene chiusa, lo stile tornerà a essere quello del libro mastro basilare.
Per rendere il cambiamento permanente occorre cambiare lo stile nella scheda Predefinite del registro delle
Preferenze di GnuCash.

• Libro mastro basilare: lo stile predefinito costituito da una riga per transazione. Le suddivisioni sono

mostrate come sommario. Il pulsante Suddivisione e lavoce del menu Operazioni → Suddividi transa-
zione sono abilitati.

• Mastro ad espansione automatica: questo stile espande automaticamente la transazione selezionata se
contiene delle suddivisioni.

• Giornale della transazione: questo stile espande tutte le transazioni in modo da poterle visualizzare
completamente.

• Doppia linea: questa opzione agisce sugli stili appena descritta visualizzando una riga aggiuntiva per
le note della transazione.

Le altre due opzioni per cambiare la visualizzazione del registro sono: Visualizza → Filtra per... per re-

stringere il numero di elementi visualizzati, e Visualizza → Ordina per.... la sezione chiamata «Registro
del conto - Menu Visualizza».

Finestra di trasferimento fondi
Il metodo descritto di seguito utilizza la finestra del trasferimento fondi per inserire una singola transazione.
Questo procedimento permette di inserire con rapidità una singola transazione senza bisogno di aprire la
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finestra del registro. Per inserire delle transazioni multiple, si consiglia di utilizzare direttamente il registro.

La finestra del trasferimento fondi è accessibile da Operazioni → Trasferisci, o premendo il pulsante
Trasferimento presente nella scheda del registro del conto.

1. Inserire nel riquadro delle Informazioni di base l’Importo, la Data e una Descrizione. Il Numero e il
Promemoria sono opzionali.

2. Selezionare il conto Trasferisci da. Se questo conto appartiene alle entrate o alle uscite abilitare
l’opzione apposita al di sotto del riquadro Trasferisci da.

3. Selezionare il conto Trasferisci da. Se questo conto appartiene alle entrate o alle uscite abilitare
l’opzione apposita al di sotto del riquadro Trasferisci da.

4. Se i due conti hanno una valuta differente, verrà abilitata la sezione per il trasferimento in valuta dove
sarà possibile inserire il Tasso di cambio o un Importo a.

5. Selezionare OK per inserire la transazione o Annulla per chiudere la finestra senza inserire la transa-
zione.

Inserire una transazione dal registro
All’apertura della finestra del registro per un conto, viene visualizzata la lista delle transazioni per quel
conto. Questa finestra presenta lo stesso nome del conto sulla scheda. I menu contengono varie funzioni
che permettono di modificare la visualizzazione delle transazioni. Anche la barra degli strumenti contiene
delle funzioni comunemente utilizzate per manipolare le transazioni; esse sono descritte nella sezione la
sezione chiamata «Registro del conto e finestra del libro mastro generale» di questo documento.

Inserimento diretto dalla finestra del registro
La finestra del registro può apparire lievemente differente in funzione delle opzioni di visualizzazione
selezionate. Nel seguito verrà descritto il processo di inserimento di una singola transazione quando lo stile
del registro è impostato a quello di "libro mastro basilare". Il cursore viene automaticamente posizionato
nel campo della data all’apertura della finestra del registro.

1. Selezionando la piccola icona a destra del campo della data, verrà visualizzato un calendario da cui è
possibile selezionare la data. Utilizzare le frecce per selezionare il mese e l’anno corretto e infine sele-
zionare il giorno. Premendo nuovamente la piccola icona verrà chiuso il calendario. È anche possibile
digitare dalla tastiera la data e GnuCash cercherà di completarla mentre si sta scrivendo.

2. Premere Tab per selezionare o spostarsi nel campo del Nr.. Qui è possibile assegnare un numero alla
transazione quale, per esempio, il numero dell’assegno. Premendo + (più) verrà automaticamente as-
segnato un numero aumentato di una unità rispetto a quello dell’ultima transazione dotata di numero.

3. Premere di nuovo Tab per selezionare o spostarsi nel campo della Descrizione. Qui è possibile inserire
il nome del beneficiario o qualsiasi altra descrizione relativa alla transazione. GnuCash tenterà di com-
pletare automaticamente il nome del beneficiario mentre si starà scrivendo.

4. A questo punto possono accadere due fatti alla pressione del tasto Tab: se GnuCash individua una
transazione esistente corrispondente, il cursore salterà in uno dei campi per l’importo, compilando au-
tomaticamente il campo del conto di trasferimento; se si seleziona un campo qualsiasi con il mouse
invece di utilizzare il tasto di tabulazione, non verrà compilato automaticamente il campo del conto
di trasferimento. Se non ci sono transazioni esistenti corrispondenti, GnuCash sposterà il cursore nel
campo del Trasferimento quando è visualizzata una sola riga per la transazione.
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5. Quando si digita all’interno del campo del conto, GnuCash tenterà di completare automaticamente il
nome del conto con quello di uno esistente. La ricerca avviene alfabeticamente, quindi digitando Us
verrà individuato la sezione Uscite della lista dei conti. Quando è stata isolata la sezione, è possibile
muoversi tra i conti figli premendo i : (due punti). Se, dopo aver digitato Us, si preme :, allora il cursore
si sposterà nel primo conto figlio nella lista dei conti. La pressione di una combinazione di tasti e di
: permette di muoversi rapidamente attraverso la struttura ad albero dei conti. L’icona triangolare a
destra del riquadro del Trasferimento rappresenta un metodo alternativo per selezionare un conto; i tasti
freccia sù e freccia giù permettono di muoversi nella lista dei conti visualizzata.

6. Il campo seguente (R) è relativo allo stato di riconciliazione della transazione ed è descritto nella sezione
la sezione chiamata «Riconciliare un conto a un estratto conto».

7. Premere ancora Tab per spostarsi nel primo campo dell’importo. I nomi delle due colonne successive
sono diversi in funzione del tipo di conto aperto. Per esempio, i conti bancari visualizzano i nomi
Deposito e Prelievo, i conti per le carte di credito mostrano Pagamento e Addebito mentre i conti per
le azioni visualizzano Quote, Prezzo, Compra e Vendi.

8. Inserire un importo per la transazione nel campo corretto. Quando la transazione è «bilanciata» premen-

do il tasto Invio, selezionando il pulsante Inserisci o andando in Transazione → Inserisci transazione

verrà aggiunta al registro la transazione. Selezionando il pulsante Elimina o andando in Transazione →
Elimina transazione verrà cancellata la transazione.

9. Le transazioni con un unico conto di trasferimento mostreranno il nome di questo conto nel campo
del Trasferimento nelle transazioni completate (il campo Trasferimento è il quarto (4) da sinistra nella
finestra del registro).

10.Per spostarsi alla transazione vuota alla fine del registro, premere il pulsante Vuota sulla barra degli

strumenti o andare in Operazioni → Transazione vuota.

Transazioni con suddivisioni multiple
La finestra del registro può apparire leggermente diversa in funzione delle opzioni di visualizzazione sele-
zionate. Nel seguito verrà descritto il processo di inserimento di una transazione con suddivisioni multiple
quando lo stile del registro è impostato a quello di libro mastro basilare. In GnuCash una suddivisione
si ha quando il denaro è trasferito da o verso due o più conti per una stessa transazione. Il cursore viene
automaticamente posizionato nel campo della data all’apertura della finestra del registro.

Le righe per i conti multipli non saranno visualizzate nella modalità a libro mastro basilare a meno che

non vengano selezionati o il pulsante Suddivisione o l’opzione Operazioni → Suddividi

1. Selezionando la piccola icona a destra del campo della data, verrà visualizzato un calendario da cui è
possibile selezionare la data. Usare le frecce per selezionare il mese e l’anno corretto e infine selezionare
il giorno. Premendo nuovamente la piccola icona verrà chiuso il calendario. È anche possibile digitare
dalla tastiera la data e GnuCash cercherà di completarla mentre si sta scrivendo.

2. Premere Tab per selezionare o spostarsi nel campo del Nr.. Qui è possibile assegnare un numero alla
transazione quale, per esempio, il numero dell’assegno. Premendo + (più) verrà automaticamente as-
segnato un numero aumentato di una unità rispetto a quello dell’ultima transazione dotata di numero.

3. Premere di nuovo Tab per selezionare o spostarsi nel campo della Descrizione. Qui è possibile inserire
il nome del beneficiario o qualsiasi altra descrizione relativa alla transazione. GnuCash tenterà di com-
pletare automaticamente il nome del beneficiario mentre si scrive.

4. A questo punto possono accadere due fatti alla pressione del tasto Tab: se GnuCash individua una
transazione esistente corrispondente, il cursore salterà in uno dei campi per l’importo, compilando au-
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tomaticamente il campo del conto di trasferimento; se si seleziona un campo qualsiasi con il mouse
invece di utilizzare il tasto di tabulazione, non verrà compilato automaticamente il campo del conto
di trasferimento. Se non ci sono transazioni esistenti corrispondenti, GnuCash sposterà il cursore nel
campo del Trasferimento quando è visualizzata una sola riga per la transazione.

5. Quando si digita all’interno del campo del Trasferimento, GnuCash tenterà di completare automatica-
mente il nome del conto. La ricerca avviene alfabeticamente, quindi digitando Us verrà individuata la
sezione Uscite della lista dei conti. Quando è stata isolata la sezione, è possibile muoversi tra i conti
figli premendo i : (due punti). Se, dopo aver digitato Ex si preme :, allora il cursore si sposterà nel
primo sottoconto nella lista dei conti. La pressione di una combinazione di lettere e dei : permette di
muoversi rapidamente attraverso la struttura ad albero dei conti. La piccola icona a destra del riquadro
del Trasferimento rappresenta un metodo alternativo per selezionare un conto.

6. Il campo seguente (R) è relativo allo stato di riconciliazione della transazione ed è descritto in la sezione
chiamata «Riconciliare un conto a un estratto conto»

7. Premere ancora Tab per spostarsi nel primo campo dell’importo. I nomi delle due colonne successive
sono diversi in funzione del tipo di conto aperto. Per esempio, i conti bancari visualizzano i nomi
Deposito e Prelievo, i conti per le carte di credito mostrano Pagamento e Addebito mentre i conti per
le azioni visualizzano Quote, Prezzo, Compra e Vendi.

8. Inserire l’importo della transazione nel campo corretto. Prima di premere Tab o Invio leggere il passo
successivo.

9. Per inserire delle ulteriori suddivisioni, premere il pulsante Suddivisione sulla barra degli strumenti

o selezionare la voce Operazioni → Suddividi transazione. Per le transazioni che contengono più di
una suddivisione, viene visualizzata la dicitura --Transazione suddivisa-- e sarà necessario utilizzare il
pulsante Suddivisione per mostrarne i dettagli.

10.La transazione verrà espansa, i titoli delle colonne dell’importo cambieranno e l’intestazione della co-
lonna Trasferimento sarà vuota. La prima riga contiene la descrizione e l’importo della transazione.
La seconda riga contiene il nome del conto attualmente aperto nel campo del Conto e l’importo della
transazione. La terza riga contiene il nome del conto di trasferimento nel campo del Conto. Se l’importo
non risulta bilanciato,GnuCash lo indicha inserendo delle celle grigie nelle colonne dell’importo e ri-
portando l’ammontare non bilanciato nell’ultima riga vuota del registro.

11.Quando viene selezionata una delle righe più corte, le intestazioni delle colonne cambiano. La prima e
l’ultima (Data e Saldo) non avranno un titolo; Nr. cambierà in Operazione, Descrizione in Promemoria
e la colonna vuota del Trasferimento cambierà il titolo in Conto. Le ultime due colonne dell’importo
visualizzeranno i titoli descritti al passo sette.

12.I campi Operazione e Promemoria sono opzionali in questa fase; il primo può contenere una descrizione
del tipo di conto di trasferimento coinvolto mentre il secondo è destinato a una descrizione aggiuntiva
della transazione.

13.Sposta il cursore nel campo dell'importo mancante sulla terza riga e lo completa. Premendo il tasto

Invio, selezionando il pulsante Inserisci o andando in Transazione → Inserisci transazione il cursore
verrà posizionato sulla riga successiva

14.La colonna del Conto contiene una lista dei conti di trasferimento. Questa colonna è utilizzata per
aggiungere delle suddivisioni. Il metodo descritto al passo cinque, può essere utilizzato per selezionare
un ulteriore conto su una riga vuota. Si possono aggiungere quante suddivisioni si desiderano.

15.Quando la transazione è bilanciata, le celle grigie spariranno come anche l’importo visualizzato
nell’ultima riga vuota.
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16.Premendo Invio, come descritto più sopra, si salterà alla transazione successiva. Selezionando la tran-
sazione successiva verrà chiusa automaticamente la suddivisione oppure si potrà chiuderla manualmen-

te premendo il pulsante Suddivisione oppure selezionando la voce del menu Operazioni → Suddividi
transazione.

Transazioni in valuta multipla
Attualmente i trasferimenti fra conti aventi valuta diversa sono possibili solamente attraverso la finestra
del trasferimento fondi descritta più sopra (la sezione chiamata «Finestra di trasferimento fondi»). Questa
finestra è necessaria per inserire il tasso di cambio.

Per assegnare a un conto una valuta diversa, modificarne le proprietà cambiando il campo della Commodity
nella valuta desiderata. Selezionando ora questo conto nella finestra del trasferimento fondi, verrà abilitata
la sezione del trasferimento in valuta.

Modificare una transazione
Per modificare una transazione è sufficiente selezionare la parte della transazione che si desidera modifica-
re. Una volta effettuati i cambiamenti, premere il tasto Invio, oppure selezionare il pulsante Inserisci o an-

dare in Transazione → Inserisci Transazione per spostare il cursore nella riga successiva della transazione.

Per visualizzare maggiori dettagli relativi a una transazione nella modalità a libro mastro basilare, premere

il pulsante Suddivisione nella barra degli strumenti o selezionare Operazioni → Suddividi transazione.

Cancellare una transazione
Se è necessario rimuovere una transazione dal registro, selezionarla e premere il pulsante Elimina nella

barra degli strumenti oppure andare in Transazioni → Elimina transazione. Verrà visualizzata una finestra
di conferma dell’eliminazione, a meno che non siano state cambiate le preferenze. La finestra propone
due opzioni

È possibile rimuovere anche solo alcune parti della transazione premendo il pulsante Suddivisione sulla

barra degli strumenti o selezionando Operazioni → Suddividi transazione. La parte della transazione da
cancellare può essere poi selezionata per l’eliminazione.

Rimuovere le suddivisioni da una transazione
La rimozione delle suddivisioni da una transazione prevede che vengano eliminate tutte le suddivisioni a
esclusione di quella relativa al conto aperto. Questa operazione rappresenta un metodo efficace per riuti-
lizzare una transazione con suddivisioni multiple modificandola a piacimento (si noti che questo può esse-
re fatto senza espandere la transazione, ma così facendo si rendono più visibili gli effetti dell’operazione).

1. Se lo stile del registro è impostato a libro mastro basilare, premere il pulsante Suddivisione sulla barra

degli strumenti o selezionare Operazioni → Suddividi transazione per espandere la transazione selezio-
nata. Se la modalità di visualizzazione del registro è un’altra, è sufficiente selezionare la transazione.

2. Selezionare Transazione → Rimuovi suddivisioni transazione.

Verrà aperta una finestra per confermare la cancellazione, a meno che non siano state cambiate le
preferenze. Questa finestra presenta due opzioni: Ricordalo e non chiedermelo di nuovo e Ricordalo e



Operazioni comuni per le transazioni

56

non chiedermelo di nuovo in questa sessione. La risposta verrà impostata in base all’opzione attivata.

La scelta effettuata può essere annullata andando in Operazioni → Ripristina avvisi. la sezione chiamata
«Ripristina avvisi...».

3. Tutti i conti e i relativi dettagli verranno rimossi a eccezione del conto attualmente aperto.

4. L’importo non risulterà bilanciato e GnuCash lo indicherà inserendo delle celle grigie nelle colonne
dell’importo e riportando l’ammontare non bilanciato nell’ultima riga vuota del registro.

5. Modificare la transazione inserendo le nuove informazioni.

Copiare una transazione
La copia delle transazioni è disponile dal menu Transazione. Il menu Transazione presenta i comandi
Taglia transazione, Copia transazione e Incolla transazione che pemettono di copiare, tagliare e incollare
l’intera transazione in una nuova riga. Con questa procedura di copia verrà utilizzata la data mostrata nella
nuova linea vuota.

La voce Transazione → Duplica transazione... o il pulsante della barra degli strumenti Duplica, a diffe-
renza del comando Copia, permettono di scegliere una nuova data.

• Selezionare la transazione da duplicare.

• Andare in Transazione → Duplica transazione...

• Una finestra dal nome Duplica la transazione richiederà la data e il numero della transazione stessa.

• Premere OK per aggiungere la transazione al registro.

Saltare al registro di un altro conto
Quando si utilizza la finestra del registro del conto, può rivelarsi utile essere in grado di vedere un altro
conto e il conto di trasferimento allo stesso tempo. GnuCash permette di eseguire velocemente questa
operazione utilizzando la funzione di «salto»; è infatti disponibile, nella barra degli strumenti, il pulsante

Salta raggiungibile anche tramite il menu Operazioni → Salta nella finestra del registro del conto.

Selezionare la transazione nella finestra del registro del conto e premere il pulsante Salta oppure selezionare

Operazioni → Salta per aprire la finestra del registro del conto di destinazione. Se la transazione è suddivisa
in più di un conto allora sarà necessario visualizzare tutti i conti di suddivisione e selezionare quello in
cui si desidera "saltare".

Pianificare le transazioni
Le transazioni pianificate consentono di essere avvisati o di inserire automaticamente le transazioni in una
data specificata. Questa proprietà combinata con l’assistente Dall’ultimo avvio... > (la sezione chiamata
«Assistente dall’ultimo avvio») permette di rivedere e inserire le transazioni. L’assistente per il Rimborso
di mutui e ipoteche (la sezione chiamata «Assistente per mutui e ipoteche») permette di configurare una
transazione pianificata per ripagare un prestito con un tasso di interesse composto. L’editor transazioni
pianificate (la sezione chiamata «Finestra di modifica della transazione pianificata») permette di creare e
modificare le transazioni che stanno per essere inserite automaticamente nel registro.

Il metodo più semplice per configurare una transazione pianificata consiste nell’utilizzare come modello
una transazione esistente nella finestra del registro di un conto. Selezionare la transazione da utilizzare
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come modello e poi selezionare o il pulsante Pianifica sulla barra degli strumenti o andare in Operazioni

→ Pianifica.... Verrà aperta la finestra dal titolo Crea Transazione pianificata.

• Nome: inserire un nome per la transazione pianificata. Questo verrà utilizzato nel campo della Descri-
zione per la transazione.

• Frequenza: selezionare l’intervallo di tempo intercorrente tra due pianificazioni. Le date in cui la tran-
sazione verrà inserita saranno visualizzate nel mini calendario in basso.

• Data d’inizio:selezionare una data iniziale per la transazione pianificata.

• Senza fine: se la transazione non ha un termine.

• Data di termine: selezionare una data finale per la transazione pianificata.

• Numero di occorrenze: inserire il numero di volte con cui si desidera che la transazione venga inserita
nel registro.

Il pulsante Avanzate... apre la finestra dell’Editor transazioni pianificate per modificare la transazione.
Questa è descritta nell’apposita sezione: la sezione chiamata «Finestra di modifica della transazione pia-
nificata».

Finestra della transazione pianificata
La finestra per le transazioni pianificate permette di accedere alla lista delle transazioni pianificate e di
crearle, modificarle o eliminarle; fornisce anche un calendario. Fermando il cursore per qualche secondo
su una data visualizzata dal calendario, verrà mostrata una piccola finestra contenente l’elenco delle tran-
sazioni pianificate per quella stessa data; per chiudere la piccola finestra è sufficiente premere su di essa
un’altra volta. Le date evidenziate in giallo sul calendario rappresentano i giorni in cui sono pianificate
delle transazioni.

Il riquadro superiore della finestra delle transazioni pianificate contiene una lista delle transazioni piani-
ficate attualmente impostate. Questa lista elenca il nome della transazione, se questa è attiva ai fini della
pianificazione, la frequenza (mese o giorno) con cui la transazione deve essere inserita, l’ultima data in
cui è stata inserita e la prossima data in cui verrà inserita.

Sul lato destro del riquadro è presenta una freccia rivolta verso il basso che, quando premuta,che permette
di selezionare le caratteristiche visualizzate. Togliendo la spunta a una voce, questa verrà rimossa dal
riquadro.

La barra degli strumenti di questa finestra contiene tre pulsanti per creare, cancellare o modificare una
transazione pianificata. Premendo i pulsanti Nuovo o Modifica, verrà aperto l’Editor transazioni pianifica-
te. Premendo invece Elimina verrà cancellata la transazione pianificata selezionata. Le stesse opzioni sono

raggiungibili anche attraverso il menu Pianifica → Nuovo/Modifica/Cancella, nella scheda della Transa-
zioni pianificate.

Al di sotto della lista delle transazioni pianificate, è posizionato il calendario delle "prossime scadenze";
qui è visualizzato il calendario fino all’anno seguente e sono evidenziate le date in cui sono previste delle
transazioni pianificate. Cliccando su di una data nel calendario, verrà aperta una finestra con la lista delle
transazioni pianificate per quella stessa data. Spostando il puntatore al di sopra di un’altra data, cambierà
di conseguenza anche la lista delle transazioni. Cliccando di nuovo sul calendario verrà chiusa la finestra
contenente la lista delle transazioni.

La finestra per le transazioni pianificate è accessibile sia dalla scheda del conto che da quella del registro

attraverso la voce del menu Operazioni → Transazioni pianificate → Editor transazioni pianificate.
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Finestra di modifica della transazione pianifica-
ta

La finestra dell’Editor transazioni pianificate è divisa in sei aree: Nome,Opzioni, Frequenza, Calendario
e Modello di transazione.

Il Nome da utilizzare per la transazione pianificata. Verrà visualizzato nel campo Descrizione della tran-
sazione.

L’area delle Opzioni fornisce la possibilità di scegliere se la transazione deve essere creata automatica-
mente e quanti giorni prima crearla o notificarne la ricorrenza.

L’area delle Scadenze fornisce delle opzioni per impostare i limiti di tempo e il numero di transazioni
da inserire.

L’area della Frequenza permette di impostare le ricorrenze e le date in cui la transazione deve essere
inserita.

Il calendario fornisce una rapida visualizzazione delle transazioni già pianificate.

La scheda del Modello di transazione permette di impostare la transazione così come deve essere inserita
nel registro alla data spcificata.

Queste opzioni sono descritte con maggior dettaglio in la sezione chiamata «Pianificare le transazioni»

• Dalla scheda delle Transazioni pianificate selezionando una transazione dall’elenco e premendo il pul-
sante Modifica o Nuovo verrà aperto l’Editor Transazioni pianificate.

Stampare gli assegni
In GnuCash gli assegni sono stampati dal registro del conto. GnuCash fornisce la possibilità di stampare
assegni con lo standard Quicken (anche nel formato US Letter) o di creare un formato personalizzato.
Anche la posizione dell’assegno e il formato della data sono personalizzabili.

Per stampare un unico assegno in GnuCash, selezionare la transazione di cui stampare l’assegno e andare

in File → Stampa assegni. Verrà aperta la finestra delle proprietà per la stampa dell’assegno.

Per stampare più assegni in GnuCash eseguire una ricerca per trovare le transazioni che si intende stampare.

Dalla finestra dei risultati della ricerca andare in File → Stampa assegni. Verrà aperta la finestra delle
proprietà di stampa degli assegni per stampare tutti gli assegni presenti nella finestra di ricerca.

La finestra per la stampa dell’assegno presenta due schede. La prima è denominata Opzioni e permette di
impostare le opzioni più comuni per la stampa dell’assegno; la seconda, denominata Formato personaliz-
zato permette di configurare la posizione dei vari campi sull’assegno. È utile a questo scopo stampare un
assegno di prova su un foglio di carta e utilizzarlo per effettuare le correzioni necessarie.

La selezione preimpostata nella finestra delle Opzioni è l’assegno Quicken/Quickbooks (tm) US-Letter.

• Formato dell’assegno: provare prima con il formato Quicken e utilizzare il formato personalizzato se
la posizione non è corretta.

• Posizione dell’assegno: permette di selezionare l’assegno da stampare: Top (in alto), Middle (in mezzo)
o Bottom (in basso). L’opzione Personalizzato è da selezionare se la posizione degli assegni nella pagina
non è corretta.
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• Formato data: il valore predefinito visualizzato in questo campo è impostato nelle preferenze di Gnu-
Cash. Dalla lista a comparsa è possibile selezionare il formato della data desiderato. Il formato può
essere cambiato utilizzando le righe denominate Mesi: e Anni:. Scegliendo Personalizzato sarà possi-
bile impostare il formato della data nel campo Formato: (%m significa mese, %d significa giorno, %Y
significa anno). Un esempio del formato selezionato è mostrato appena più sotto nella finestra.

• Indirizzo: l’indirizzo del beneficiario, se il formato dell’assegno contiene uno spazio dedicato e se si
intende stampare un unico assegno.

La scheda del Formato personalizzato è divisa in due sezioni. La metà superiore (al di sopra della linea
di divisione) contiene due colonne per l’inserimento delle coordinate X e Y della posizione del campo
sull’assegno. Le posizioni nel formato di assegno personalizzato sono a partire da x = 0 sul lato sinistro
dell’assegno, crescenti verso destra, e y = 0 dal lato superiore dell’assegno, crescenti verso il basso. (Se si
utilizza una versione di GTK precedente alla 2.10, allora y = 0 è al bordo inferiore e positiva verso l’alto).

• Beneficiario:

• Data:

• Importo (in parole):

• Importo (in numeri):

• Indirizzo:

• Note:

• Promemoria:

• Importo suddivisioni

• Promemoria suddivisioni

• Conto suddivisioni

La parte della scheda del Formato personalizzato al di sotto della linea di divisione contiene i campi per il
posizionamento dell’assegno all’interno della pagina. La Traslazione è la distanza dall’angolo superiore
sinistro mentre la Rotazione rappresenta la rotazione in senso orario dell’assegno.

Il campo Unità nella metà inferiore della finestra indica le unità da utilizzare per i campi in entrambe le
metà della finestra.

Una volta che è stato premuto il tasto OK nella finestra di stampa dell’assegno, verrà visualizzata la finestra
per la stampa di un documento di GnuCash. Premere di nuovo OK per stampare l’assegno.

Operazioni online...
Nota

Questa sezione è "in costruzione - ogni contributo è benvenuto!!".

Ricevi saldo

Ricevi transazioni ...
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Inoltra transazione

Addebito diretto

Libro mastro generale
Il libro mastro generale è un registro avanzato che permette di inserire le transazioni senza il bisogno di
aprire i singoli conti; permette anche di visualizzare tutte le transazioni per tutti i conti in un unico registro.

L’inserimento di una transazione nel libro mastro generale è più complicato rispetto alla stessa operazione
compiuta dal registro del conto. Il vantaggio del libro mastro generale risiede nella visualizzazione più
esaustiva delle transazioni inserite in tutti i propri conti.

Il libro mastro generale è impostato di default per visualizzare solamente le transazioni dell’ultimo mese.
Questa impostazione può essere cambiata utilizzando la voce «Intervallo temporale» nel menu «Visualiz-
za».



61

Capitolo 7. Strumenti e assistenti
GnuCash fornisce diversi strumenti specializzati che permettono l’accesso a funzionalità avanzate. Questi
strumenti sono selezionabili dal menu Strumenti. Alcuni di essi potrebbero non essere visualizzati se non
sono stati configurati alcuni dei supporti quali l’Online Banking, o gli strumenti appropriati per la finestra
corrente.

Trovare le transazioni
La ricerca delle transazioni è utile per cercare delle particolari transazioni in GnuCash e mostrare i risultati
in una finestra del registro. La barra del titolo della finestra Trova transazione contiene la stringa trova
transazione e la prima linea riporta suddivisione: opzioni di ricerca. Nelle altre finestre di ricerca disponi-
bili in GnuCash, la prima linea contiene una descrizione diversa ma la stessa disposizione di base degli
elementi.

Nota

Lo strumento Trova... può anche cercare un cliente, una fattura, un lavoro, un venditore, una o
più ricevute, uno o più dipendenti o una o più note spese. L’oggetto ricercato è determinato dalla

posizione di avvio dello strumento; esso è accessibile anche dal menu Impresa → (Cliente/Ven-
ditore/Dipendente).

Per aprire la finestra di ricerca delle transazioni dalla finestra della struttura dei conti o da quella del regi-
stro, selezionare il menu «Strumenti» e poi la voce «Trova...» oppure si può utilizzare, come scorciatoia,
la combinazione di tasti Ctrl-F.

La finestra di ricerca è suddivisa in due riquadri: quello superiore contiene i pulsanti per il o i criteri di
ricerca mentre quello inferiore serve per selezionare la tipologia di ricerca da effettuare.

Sono presenti due pulsanti nella parte alta del riquadro del criterio di ricerca: quello di sinistra permette di
aggiungere una ulteriore riga per impostare un criterio aggiuntivo (la riga del primo criterio deve essere
completata per poterne aggiungere un altro); quello di destra è utilizzato per impostare la combinazione
tra i criteri di ricerca; quando è selezionato il valore Tutti i criteri sono rispettati tutte le righe dei criteri di
ricerca devono restituire almeno un risultato; il valore almeno uno dei criteri è rispettato richiede, invece,
che solo una delle righe dei criteri restituisca un risultato.

La riga del criterio di ricerca permette di combinare diversi pulsanti per i criteri. La tabella seguente
descrive le possibili combinazioni di pulsanti;

Tabella 7.1. Pulsanti del criterio di ricerca.

Pulsante 1 Pulsante 2 Pulsante 3 Pulsante 4 Pulsante 5 Pulsante 6 Pulsante 7 Pulsante 8

Descrizione contiene Espressione
inserita nel
campo di ri-
cerca

L’espressione
inserita è
insensibile
alle lette-
re maiusco-
le/minusco-
le?

Elimina ri-
ga

Descrizione non contie-
ne

Espressione
inserita nel
campo di ri-
cerca

L’espressione
inserita è
insensibile
alle lette-

Elimina ri-
ga
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Pulsante 1 Pulsante 2 Pulsante 3 Pulsante 4 Pulsante 5 Pulsante 6 Pulsante 7 Pulsante 8

re maiusco-
le/minusco-
le?

Descrizione corrisponde
all’espressione
regolare

Espressione
inserita nel
campo di ri-
cerca

L’espressione
inserita è
insensibile
alle lette-
re maiusco-
le/minusco-
le?

Elimina ri-
ga

Descrizione non corri-
sponde
all’espressione
regolare

Espressione
inserita nel
campo di ri-
cerca

L’espressione
inserita è
insensibile
alle lette-
re maiusco-
le/minusco-
le?

Elimina ri-
ga

Promemo-
ria

contiene Espressione
inserita nel
campo di ri-
cerca

L’espressione
inserita è
insensibile
alle lette-
re maiusco-
le/minusco-
le?

Elimina ri-
ga

Promemo-
ria

non contie-
ne

Espressione
inserita nel
campo di ri-
cerca

L’espressione
inserita è
insensibile
alle lette-
re maiusco-
le/minusco-
le?

Elimina ri-
ga

Promemo-
ria

corrisponde
all’espressione
regolare

Espressione
inserita nel
campo di ri-
cerca

L’espressione
inserita è
insensibile
alle lette-
re maiusco-
le/minusco-
le?

Elimina ri-
ga

Promemo-
ria

non corri-
sponde
all’espressione
regolare

Espressione
inserita nel
campo di ri-
cerca

L’espressione
inserita è
insensibile
alle lette-
re maiusco-
le/minusco-
le?

Elimina ri-
ga

Numero contiene Espressione
inserita nel
campo di ri-
cerca

L’espressione
inserita è
insensibile
alle lette-

Elimina ri-
ga
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Pulsante 1 Pulsante 2 Pulsante 3 Pulsante 4 Pulsante 5 Pulsante 6 Pulsante 7 Pulsante 8

re maiusco-
le/minusco-
le?

Numero non contie-
ne

Espressione
inserita nel
campo di ri-
cerca

L’espressione
inserita è
insensibile
alle lette-
re maiusco-
le/minusco-
le?

Elimina ri-
ga

Numero corrisponde
all’espressione
regolare

Espressione
inserita nel
campo di ri-
cerca

L’espressione
inserita è
insensibile
alle lette-
re maiusco-
le/minusco-
le?

Elimina ri-
ga

Numero non corri-
sponde
all’espressione
regolare

Espressione
inserita nel
campo di ri-
cerca

L’espressione
inserita è
insensibile
alle lette-
re maiusco-
le/minusco-
le?

Elimina ri-
ga

Operazioni contiene Espressione
inserita nel
campo di ri-
cerca

L’espressione
inserita è
insensibile
alle lette-
re maiusco-
le/minusco-
le?

Elimina ri-
ga

Operazioni non contie-
ne

Espressione
inserita nel
campo di ri-
cerca

L’espressione
inserita è
insensibile
alle lette-
re maiusco-
le/minusco-
le?

Elimina ri-
ga

Operazioni corrisponde
all’espressione
regolare

Espressione
inserita nel
campo di ri-
cerca

L’espressione
inserita è
insensibile
alle lette-
re maiusco-
le/minusco-
le?

Elimina ri-
ga

Operazioni non corri-
sponde
all’espressione
regolare

Espressione
inserita nel
campo di ri-
cerca

L’espressione
inserita è
insensibile
alle lette-

Elimina ri-
ga
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Pulsante 1 Pulsante 2 Pulsante 3 Pulsante 4 Pulsante 5 Pulsante 6 Pulsante 7 Pulsante 8

re maiusco-
le/minusco-
le?

Nota contiene Espressione
inserita nel
campo di ri-
cerca

L’espressione
inserita è
insensibile
alle lette-
re maiusco-
le/minusco-
le?

Elimina ri-
ga

Nota non contie-
ne

Espressione
inserita nel
campo di ri-
cerca

L’espressione
inserita è
insensibile
alle lette-
re maiusco-
le/minusco-
le?

Elimina ri-
ga

Nota corrisponde
all’espressione
regolare

Espressione
inserita nel
campo di ri-
cerca

L’espressione
inserita è
insensibile
alle lette-
re maiusco-
le/minusco-
le?

Elimina ri-
ga

Nota non corri-
sponde
all’espressione
regolare

Espressione
inserita nel
campo di ri-
cerca

L’espressione
inserita è
insensibile
alle lette-
re maiusco-
le/minusco-
le?

Elimina ri-
ga

Data di
emissione

è prima del Campo per
la selezione
della data

Elimina ri-
ga

Data di
emissione

è prima del
o il

Campo per
la selezione
della data

Elimina ri-
ga

Data di
emissione

è il Campo per
la selezione
della data

Elimina ri-
ga

Data di
emissione

non è il Campo per
la selezione
della data

Elimina ri-
ga

Data di
emissione

è dopo il Campo per
la selezione
della data

Elimina ri-
ga
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Pulsante 1 Pulsante 2 Pulsante 3 Pulsante 4 Pulsante 5 Pulsante 6 Pulsante 7 Pulsante 8

Data di
emissione

è il o dopo il Campo per
la selezione
della data

Elimina ri-
ga

Valore ha il credito
o il debito

minore di Campo per
l’immissione
dell’importo

Elimina ri-
ga

Valore ha il credito
o il debito

minore o
uguale a

Campo per
l’immissione
dell’importo

Elimina ri-
ga

Valore ha il credito
o il debito

uguale a Campo per
l’immissione
dell’importo

Elimina ri-
ga

Valore ha il credito
o il debito

diverso da Campo per
l’immissione
dell’importo

Elimina ri-
ga

Valore ha il credito
o il debito

maggiore di Campo per
l’immissione
dell’importo

Elimina ri-
ga

Valore ha il credito
o il debito

maggiore o
uguale a

Campo per
l’immissione
dell’importo

Elimina ri-
ga

Valore ha il credito minore di Campo per
l’immissione
dell’importo

Elimina ri-
ga

Valore ha il credito minore o
uguale a

Campo per
l’immissione
dell’importo

Elimina ri-
ga

Valore ha il credito uguale a Campo per
l’immissione
dell’importo

Elimina ri-
ga

Valore ha il credito diverso da Campo per
l’immissione
dell’importo

Elimina ri-
ga

Valore ha il credito maggiore di Campo per
l’immissione
dell’importo

Elimina ri-
ga

Valore ha il credito maggiore o
uguale a

Campo per
l’immissione
dell’importo

Elimina ri-
ga

Valore ha il debito minore di Campo per
l’immissione
dell’importo

Elimina ri-
ga

Valore ha il debito minore o
uguale a

Campo per
l’immissione
dell’importo

Elimina ri-
ga
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Pulsante 1 Pulsante 2 Pulsante 3 Pulsante 4 Pulsante 5 Pulsante 6 Pulsante 7 Pulsante 8

Valore ha il debito uguale a Campo per
l’immissione
dell’importo

Elimina ri-
ga

Valore ha il debito diverso da Campo per
l’immissione
dell’importo

Elimina ri-
ga

Valore ha il debito maggiore di Campo per
l’immissione
dell’importo

Elimina ri-
ga

Valore ha il debito maggiore o
uguale a

Campo per
l’immissione
dell’importo

Elimina ri-
ga

Quote minore di Campo per
l’immissione
dell’importo

Elimina ri-
ga

Quote minore o
uguale a

Campo per
l’immissione
dell’importo

Elimina ri-
ga

Quote uguale a Campo per
l’immissione
dell’importo

Elimina ri-
ga

Quote diverso da Campo per
l’immissione
dell’importo

Elimina ri-
ga

Quote maggiore di Campo per
l’immissione
dell’importo

Elimina ri-
ga

Quote maggiore o
uguale a

Campo per
l’immissione
dell’importo

Elimina ri-
ga

Quotazione minore di Campo per
l’immissione
dell’importo

Elimina ri-
ga

Quotazione minore o
uguale a

Campo per
l’immissione
dell’importo

Elimina ri-
ga

Quotazione uguale a Campo per
l’immissione
dell’importo

Elimina ri-
ga

Quotazione diverso da Campo per
l’immissione
dell’importo

Elimina ri-
ga

Quotazione maggiore di Campo per
l’immissione
dell’importo

Elimina ri-
ga
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Pulsante 1 Pulsante 2 Pulsante 3 Pulsante 4 Pulsante 5 Pulsante 6 Pulsante 7 Pulsante 8

Quotazione maggiore o
uguale a

Campo per
l’immissione
dell’importo

Elimina ri-
ga

Riconcilia è Non liqui-
data

Liquidata Riconcilia-
ta

Bloccata Invalidata Elimina ri-
ga

Riconcilia non è Non liqui-
data

Liquidata Riconcilia-
ta

Bloccata Invalidata Elimina ri-
ga

Bilancio è impostato a
vero

Elimina ri-
ga

Bilancio non è impostato a
vero

Elimina ri-
ga

Conto soddisfa
ogni conto

scegliere
conti

Elimina ri-
ga

Conto non soddi-
sfa alcun
conto

scegliere
conti

Elimina ri-
ga

Tutti i conti soddisfa
tutti i conti

scegliere
conti

Elimina ri-
ga

Il pulsante «conto» esegue una ricerca dove i conti selezionati nella finestra «scegli conti» verranno en-
trambi analizzati individualmente per la ricerca di risultati. Ciò significa che una corrispondenza in qual-
siasi dei conti selezionati verrà visualizzata (matches any account) o scartata (matches no account).

Il pulsante «tutti i conti» esegue una ricerca in cui i conti selezionati nella schermata di scelta dei conti
forniranno dei risultati solamente se corrispondono in entrambi i conti.

Sono possibili 4 scelte nel riquadro del tipo di ricerca. Quando viene eseguita una nuova ricerca, solo
l’opzione nuova ricerca è attivata. Le altre scelte sono selezionabili solamente quando è visibile la finestra
di registro dei risultati di ricerca.

• Nuova ricerca: esegue una nuova ricerca tra le transazioni

• Perfeziona la ricerca attiva: cerca tra i risultati della ricerca precedente.

• Aggiungi i risultati alla ricerca attiva: ricerca sulla base del primo gruppo di criteri e di quello nuovo.

• Elimina i risultati dalla ricerca attiva: scarta qualsiasi risultato che corrisponde a quelli precedenti.

Assistente dall’ultimo avvio
L’assistente Dall’ultimo avvio viene avviato automaticamente quando si esegue GnuCash; permette di
inserire nel registro qualsiasi transazione il cui inserimento automatico sta per avvenire. L’esecuzione
all’avvio di GnuCash può essere modificata nella finestra delle preferenze di GnuCash all’interno della

scheda Transazioni pianificate. Per eseguire l’assistente manualmente, andare in Operazioni → Transa-

zioni pianificate → Dall’ultimo avvio...

Nella finestra Dall’ultimo avvio... sono presenti tre colonne:

Transazione Il nome assegnato nell’Editor transazioni pianificate che identifica la transazione pia-
nificata.
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Stato Il valore del campo State può essere uno tra i seguenti:

Suggerimento

Fare clic nel campo della colonna dello Stato relativa a una transazione per
modificarne lo stato (questa opzione è disponibile solamente se il campo dello
stato non è vuoto)

Ignora Se viene visualizzata una transazione pianificata, da creare o come
promemoria, l’utente può impostare lo stato a Ignorato per scarta-
re l’inserimento. La transazione pianificata non verrà inserita nel
registro e la transazione verrò ricordata solamente nell’occorrenza
successiva. Per esempio, se è stato impostato un promemoria per
una transazione relativa a un trasferimento di 500€ alla fine del
mese verso il proprio conto risparmi, e questo mese si è acquista-
to un nuovo computer a causa del quale non si avrà la disponibi-
lità di quella cifra, si potrà impostare lo stato della transazione a
Ignorato.

Posticipato Se una transazione pianificata e identificata come Da creare ma la
si vuole trattenere evitando che venga inserita nel registro, si può
cambiarne lo stato in Posticipato.

Promemoria Si è a n giorni dalla data di scadenza della transazione pianificata.
Il numero di giorni n con cui segnalare in anticipo la scadenza di
una transazione pianificata, può essere impostato o nella scheda
Transazioni pianificate delle Preferenze di GnuCash o nella sche-
da Generali dell’Editor transazioni pianificate.

Da creare La transazione pianificata verrà creata automaticamente alla pres-
sione del pulsante Ok.

Vuoto Un campo vuoto significa che non è prevista alcuna operazione
per la transazione pianificata.

Nella parte inferiore della finestra sono presenti due pulsanti:

• Il pulsante Annulla permette di uscire dalla finestra Dall’ultimo avvio... senza creare le transazioni
pianificate.

• Il pulsanteOk chiude la finestra Dall’ultimo avvio e applica le operazioni in sospeso.

Nella parte inferiore destra della finestra Dall’ultimo avvio... è possibile abilitare l’opzione Controlla le
transazioni create. Abilitandola, quando sono presenti una o più transazioni Da creare, premendo il tasto
Ok verrà aperta una finestra del registro in cui sono visualizzati dettagli della transazione inserita automa-
ticamente da GnuCash

Assistente per mutui e ipoteche
Questa procedura guidata crea una transazione pianificata per il rimborso di un prestito. Quando è utiliz-
zato per creare una transazione pianificata, l’assistente crea una formula variabile in modo che l’interesse

composto venga correttamente calcolato. Per avviare l’assistente occorre selezionare Operazioni → Tran-

sazioni pianificate → Rimborso di mutui e ipoteche... dal menu principale.’
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L’assistente per il rimborso di mutui e ipoteche presenta all’avvio una schermata che descrive brevemente
la sua funzione. I tre pulsanti in basso nella finestra rimarranno invariati in tutte le finestre dell’assistente.

• Il pulsante Annulla permette di uscire dall’assistente e cancellare la creazione della transazione pianifi-
cata. Qualunque scelta fatta all’interno dell’assistente fino a questo punto, verrà persa.

• Il pulsante Indietro farà apparire la schermata precedente in modo da poter modificare una selezione
fatta in quella finestra.

• Il pulsante Avanti permette di avanzare nella procedura.

La schermata seguente permette di inserire le informazioni essenziali per il prestito. Queste sono fornite
normalmente dalla banca al momento della firma dei documenti da parte del debitore. Qui è inoltre possi-
bile impostare il conto che la transazione pianificata utilizzerà per inoltrare il pagamento.

• Conto del mutuo: scegliere un conto per le transazioni di pagamento del mutuo o utilizzare il tasto
«Nuovo...» per creare un nuovo conto per le transazioni.

• Importo: l’ammontare del prestito.

• Tasso d’interesse: inserire il tasso di interesse applicato al prestito.

• Tipo: scegliere il tipo di prestito. Se viene impostato il tasso fisso, il riquadro della frequenza è disa-
bilitato.

• Frequenza di variazione del tasso di interesse: scegliere la frequenza con cui il tasso cambia e la data
di inizio del cambiamento.

• Data d’inizio: selezionare la data in cui il prestito è stato acceso.

• Durata: inserire la durata del prestito.

• Mesi rimanenti: questo valore dovrebbe essere calcolato automaticamente. Scegliere il numero di mesi
che mancano all’estinzione del prestito.

La schermata successiva è destinata all’impostazione del conto di garanzia, dell’assicurazione e delle op-
zioni delle tasse per il prestito; È utile soprattutto per i pagamenti dei mutui. Quando ognuna di queste
opzioni è impostata, vengono abilitate delle pagine aggiuntive nell’assistente per impostare queste voci
del pagamento. Tutte le pagine verranno descritte in questa sezione anche se alcune potrebbero non venire
visualizzate se l’opzione corrispondente non è stata scelta.

• ... usare un conto destinato a garanzia per i pagamenti?: questa opzione abilita l’utilizzo di un conto
impostato per tracciare i pagamenti a garanzia. Se il mutuo o il prestito utilizzano un conto destinato a
garanzia per il pagamento delle tasse, dell’assicurazione ecc... allora si imposti il conto qui.

• ... pagare imposte?: aggiunge una schermata per impostare una transazione pianificata dedicata al pa-
gamento delle tasse.

• ... pagare assicurazione?: aggiunge una schermata per impostare una transazione pianificata dedicata al
pagamento dell’assicurazione.

• ... pagare "PMI"?: aggiunge una schermata per impostare una transazione pianificata per il pagamento
della PMI (Private Mortgage Insurance = assicurazione privata sul mutuo).

• ... pagare altre uscite?: aggiunge una schermata addizionale per impostare una transazione pianificata
dedicata al pagamento delle altre spese relative al prestito.
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La schermata successiva permette di impostare i dettagli della transazione pianificata per il rimborso del
mutuo.

• Nome: il nome che, immesso in questo campo, verrà utilizzato per identificare la transazione pianificata,
la sua descrizione e il promemoria.

• Importo: visualizza le variabili utilizzate per il calcolo della rata da pagare.

• Pagamento da: scegliere un conto da cui pagare il prestito.

• Capitale a: scegliere un conto in cui trasferire il pagamento della parte del prestito per il rimborso del
capitale.

• Interessi a: scegliere un conto in cui trasferire il pagamento della parte del prestito per il rimborso degli
interessi.

• Remainder to: Choose an account to transfer the rest of the payment amount to.

• Frequenza: selezionare la frequenza delle rate e la data di inizio del rimborso.

La schermata successiva permette di impostare i dettagli della transazione pianificata per il pagamento
delle tasse.

• Nome: il nome che, immesso in questo campo, verrà utilizzato per identificare la transazione pianificata,
la sua descrizione e il promemoria.

• Importo: inserire l’importo da pagare.

• Pagamento da: scegliere un conto da cui trasferire l’importo per il pagamento delle tasse.

• Pagamento a: scegliere un conto verso cui trasferire l’importo per il pagamento delle tasse.

• Frequenza di pagamento: selezionare la frequenza e la data di inizio per il pagamento delle imposte.

La schermata successiva permette di impostare i dettagli della transazione pianificata per il pagamento
dell’assicurazione.

• Nome: il nome che, immesso in questo campo, verrà utilizzato per identificare la transazione pianificata,
la sua descrizione e il promemoria.

• Importo: inserire l’importo da pagare.

• Pagamento da: scegliere un conto da cui trasferire l’importo per il pagamento della PMI.

• Pagamento a: scegliere un conto verso cui trasferire l’importo per il pagamento della PMI.

• Frequenza di pagamento: selezionare la frequenza e la data di inizio per il pagamento della PMI.

La schermata successiva permette di impostare i dettagli della transazione pianificata per il pagamento
dell’assicurazione privata sui mutui ipotecari.

• Nome: il nome che, immesso in questo campo, verrà utilizzato per identificare la transazione pianificata,
la sua descrizione e il promemoria.

• Importo: inserire l’importo da pagare.

• Pagamento da: scegliere un conto da cui trasferire l’importo per il pagamento dell’importo
dell’assicurazione.

• Pagamento a: scegliere un conto verso cui trasferire l’importo per il pagamento dell’assicurazione.
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• Frequenza di pagamento: selezionare la frequenza e la data di inizio per il pagamento dell’assicurazione.

La schermata successiva permette di impostare i dettagli della transazione pianificata per il pagamento
delle altre spese.

• Nome: il nome che, immesso in questo campo, verrà utilizzato per identificare la transazione pianificata,
la sua descrizione e il promemoria.

• Importo: inserire l’importo da pagare.

• Pagamento da: scegliere un conto da cui trasferire l’importo per il pagamento delle altre spese.

• Pagamento a: scegliere un conto verso cui trasferire l’importo per il pagamento delle altre spese.

• Frequenza di pagamento: selezionare la frequenza e la data di inizio per il pagamento delle altre spese.

L’ultima schermata fornisce una lista di tre scelte possibili per terminare l’assistente.

• Il pulsante Annulla permette di uscire dall’assistente e cancellare la creazione della transazione pianifi-
cata per il prestito. Qualunque scelta fatta all’interno dell’assistente fino a questo punto, verrà persa.

• Il pulsante Indietro riporterà alla schermata precedente permettendo la modifica delle opzioni immesse
in precedenza.

• Il pulsante Termina terminerà l’assistente e creerà la transazione pianificata.

Ora si dovrebbe avere la transazione pianificata per il rimborso del mutuo o del prestito, impostata cor-
rettamente.

Registrare un frazionamento azionario
I frazionamenti azionari avvengono quando una Società decide che il prezzo dell’azione è troppo elevato
per un singolo investitore che vuole acquistarla. Il frazionamento ha l’effetto di far diminuire il prezzo della
singola quota mantenendo invariato il valore delle quote possedute dall’investitore che ha già acquistato
le azioni.

Assistente per il frazionamento azionario
GnuCash utilizza questo assistente per registrare i frazionamenti azionari; esso fornisce un modo per in-
serire i dettagli del frazionamento, qualsiasi cambiamento nel prezzo dell’azione o anche il cash disburse-
ment derivante dal frazionamento azionario.

L’assistente per il frazionamento azionario è accessibile dal menu Operazioni → Frazionamento aziona-
rio....

L’assistente visualizza subito una schermata che contiene una breve descrizione del suo funzionamento e
del suo utilizzo. I tre pulsanti in basso nella schermata, non cambieranno durante l’utilizzo della procedura
guidata.

• Il pulsante Annulla permette di uscire dall’assistente e cancellare l’inserimento delle informazioni del
frazionamento azionario. Qualsiasi scelta effettuata nella procedura guidata fino a questo punto, verrà
persa.

• Il pulsante Indietro farà apparire la schermata precedente in modo da poter modificare una selezione
fatta in quella finestra.
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• Il pulsante Avanti permette di avanzare nella procedura.

La schermata successiva permette di selezionare un conto per le azioni. Selezionare un conto dalla lista
per registrare un frazionamento o una fusione azionaria.

• Conto: viene elencato il nome del conto di GnuCash per l’azione.

• Simbolo: il simbolo dell’azione associata con questo conto.

• Quote: il numero di quote che sono state acquistate nel conto.

La schermata successiva permette di impostare i dettagli del frazionamento azionario. La parte superiore
della finestra contiene dei dettagli utilizzati nella creazione della transazione per il frazionamento aziona-
rio.

• Data: selezionare la data del frazionamento azionario.

• Share Distribution: inserire il numero di quote guadagnate dal frazionamento azionario. Per una fusione
azionaria si inserisca un numero negativo.

• Descrizione: inserire una descrizione o lasciare quella di default.

La parte inferiore della finestra contiene dei dettagli utili per registrare un prezzo per il frazionamento
(opzionale).

• Nuovo prezzo: inserire il prezzo delle azioni nel giorno del frazionamento azionario.

• Valuta: selezionare la valuta delle quote.

La schermata successiva permette di inserire una transazione per l’esborso di liquidi (Cash In Lieu) come
conseguenza del frazionamento azionario (opzionale).

• Importo in contanti: inserire l’importo dell’esborso di liquidi.

• Promemoria: inserire un promemoria o lasciare quello di default.

• Conto entrate: scegliere un conto delle entrate per l’esborso.

• Conto attività: scegliere un conto delle attività per l’esborso.

L’ultima schermata fornisce una lista di tre scelte possibili per terminare l’assistente.

• Il pulsante Annulla permette di uscire dall’assistente e cancellare il frazionamento azionario. Qualsiasi
scelta effettuata nella procedura guidata fino a questo punto, verrà persa.

• Il pulsante Indietro farà apparire la schermata precedente in modo da poter modificare una selezione
fatta in quella finestra.

• Il pulsante Terminacrea le transazioni necessarie per registrare il frazionamento azionario.

Ora dovrebbe essere stata immessa correttamente il frazionamento o la fusione azionaria.

Procedura guidata per l’HBCI (Online Banking)
Nota

Questa sezione è "in costruzione - ogni contributo è benvenuto!!".
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La procedura guidata per l’HBCI permette di creare e modificare i dati necessari per accedere alle transa-
zioni registarte dall’online banking. Attualmente, le istruzioni più complete per questo procedimento sono
nella wiki di GnuCash all’indirizzo Setting up OFXDirectConnect in GnuCash 2 [http://wiki.gnucash.org/
wiki/Setting_up_OFXDirectConnect_in_GnuCash_2]. Se la voce Impostazione dell’Online Banking non
appare nel proprio menu Strumenti, verificare di essere nella finestra della struttura dei conti o nella scheda
del registro.

Editor prezzi
L’editor prezzi è utile per modificare o registrare il valore di una valuta, di un fondo comune o di una
azione. Esso fornisce un’unica interfaccia per aggiornare i valori di queste commodity ed è in grado di
aggiornarle sia attraverso la ricezione di quotazioni via internet oppure manualmente.

Ogni elemento nell’editor rappresenta una registrazione del prezzo di una commodity o titolo:

• Titolo:  la commodity o il titolo di cui recuperare il prezzo. La visualizzazione è ordinata per mercato
in cui i singoli titoli sono scambiati. L’elenco può essere espanso facendo clic sul simbolo a sinistra
del nome.

• Valuta: la valuta con cui il prezzo è registrato.

• Data: la data in cui il prezzo è stato registrato.

• Fonte: la fonte del prezzo per la commodity. Generalmente, questa sarà o user:price-editor, a indicare
che è stata immessa direttamente dall’utente, o Finance::Quote, a indicare che è stata ricevuta da una
fonte online con il modulo Finance::Quote.

• Tipo: esistono diversi tipi di prezzi per le azioni.

• Offerta: indica il prezzo con cui un operatore specializzato è pronto ad acquistare un’azione.

• Domanda:  indica il prezzo con cui gli operatori sono pronti a vendere l’azione.

• Ultimo:  indica il prezzo con cui è avvenuto l’ultimo scambio per l’azione o titolo. Rappresenta il
prezzo più comunemente utilizzato dai media.

• Valore netto delle attività: è tipicamente utilizzato per i fondi comuni. Sono generalmente calcolate
sul valore netto dell’attività del fondo.

• Sconosciuto: utilizzare questa voce se il tipo di prezzo non è noto.

• Prezzo: il prezzo attuale della commodity.

Aggiungere manualmente il prezzo di un’azione
Per inserire un nuovo prezzo, premere Aggiungi e inserire i dettagli del titolo e del prezzo nel riquadro. Per
modificare un prezzo esistente, selezionarlo dalla lista dei prezzi, premere il pulsante Modifica e modificare
i dati presenti.

Per cancellare un singolo prezzo, selezionarlo e premere il pulsante Rimuovi. Per rimuovere tutti i prez-
zi più vecchi di una certa data, premere il pulsante Rimuovi vecchi e inserire i dettagli nella schermata
visualizzata.

Verrà visualizzata una finestra con il messaggio "Cancella tutti i prezzi delle azioni in base al seguente
criterio:". Inserire quindi la data dell’ultimo prezzo da cancellare.

http://wiki.gnucash.org/wiki/Setting_up_OFXDirectConnect_in_GnuCash_2
http://wiki.gnucash.org/wiki/Setting_up_OFXDirectConnect_in_GnuCash_2
http://wiki.gnucash.org/wiki/Setting_up_OFXDirectConnect_in_GnuCash_2
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Al di sotto del campo della data sono presenti due opzioni:

• Cancella i prezzi inseriti manualmente - se selezionata, verranno cancellati i prezzi immessi manual-
mente e datati precedentemente alla data specificata. Diversamente solo i prezzi aggiunti dal modulo
Finance::Quote verranno cancellati.

• Cancella l’ultimo prezzo per un’azione - se selezionata, verranno cancellati i prezzi precedenti alla data
specificata. Diversamente, l’ultimo prezzo precedente alla data specificata verrà conservato e tutte le
quote più vecchie saranno cancellate.

Configurazione per l’utilizzo del pulsante Ricevi quota-
zioni

Per avere il supporto alla ricezione delle quotazioni tramite internet per una particolare azione o fondo
comune, occorre prima di tutto abilitare l’opzione per la ricezione delle quotazioni e selezionare una fonte
nell’Editor titolo. Questo processo è descritto in dettaglio in la sezione chiamata «Configurare titoli e valute
per la ricezione online dei prezzi». Una volta abilitato il servizio e installato il modulo Finance::Quote, sarà
possibile aggiornare le quotazioni delle proprie azioni e dei propri fondi comuni premendo semplicemente
il pulsante Ricevi quotazioni.

Editor titoli
L’editor titoli è utilizzato per creare o modificare le commodity che vengono utilizzate dai conti per i
fondi comuni e per le azioni; permette anche di visualizzare i dettagli delle valute nazionali utilizzate da
GnuCash.

Per mostrare i dettagli delle valute Nazionali, si attivi l’opzione Mostra valute Nazionali in basso nella
schermata.

Per ogni elemento della lista, sono visualizzati i dettagli relativi al titolo o valuta:

• Tipo: per le azioni indica la borsa o il mercato dove l’azione è scambiata. Per i fondi comuni utilizzare il
tipo FUND. Se la commodity non rientra in queste tipologie, è possibile crearne un nuovo tipo inserendo
il nome nel campo. Per le valute nazionali il tipo è ISO4217. L’ISO-4217 stabilisce uno standard inter-
nazionale che definisce un simbolo unico a tre lettere per ogni valuta. Le valute nazionali non possono
essere modificate dall’utente.

• Simbolo: il simbolo o l’abbreviazione della commodity. Generalmente si tratta del simbolo ticker (per
le azioni) o un’abbreviazione univoca per la commodity. Se la commodity è scambiata in un mercato
pubblico, è importante utilizzare lo stesso identificatore utilizzato nel mercato. Per le valute Nazionali
il simbolo è il codice della valuta secondo la norma ISO-4217.

• Nome: il nome completo della commodity. Assegnarne uno riconoscibile come, per esempio, Dollari
USA o azioni IBM.

• Codice: rappresenta un codice numerico o alfanumerico utilizzato per identificare la commodity. Il
codice CUSIP è una stringa numerica che identifica univocamente ogni azione, bond o fondo comune
e la maggior parte dei tipi di traded options, futures and commodiy. Questo codice non è obbligatorio.

• Frazione: rappresenta l’unità minima scambiata della commodity, espressa come frazione di una sin-
gola unità nominale. Questa unità è utilizzata dai conti in GnuCash come la frazione predefinita per gli
scambi della commodity.
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Aggiungere o modificare una commodity
Per inserire una nuova commodity (azione o fondo comune), premere Aggiungi e inserire i dettagli della
commodity nella finestra per il Nuovo titolo. Per modificare una commodity esistente, selezionarla dalla
lista, premere il pulsante Modifica e modificare la finestra di Modifica titolo. Per eliminare una commo-
dity, selezionarla e premere il pulsante Rimuovi.

I campi nelle schermate di nuovo titolo e modifica titolo sono le stesse presentate nell’editor titoli la sezione
chiamata «Editor titoli». Al di sotto di questi campi sono presenti le opzioni per le quotazioni online.

Configurare titoli e valute per la ricezione online dei
prezzi

Per avere il supporto alla ricezione delle quotazioni online per una particolare azione o fondo comune, è
necessario prima di tutto abilitare la ricezione delle quotazioni online e selezionare la fonte dall’editor del
titolo. Per icevere invece i tassi di cambio delle valute, è necessario che sia solamente abilitata l’opzione per
le quotazioni online, che venga selezionato il fuso orario e che sai attivata l’opzione «Ricevi quotazioni»
nell’"editor titoli".

Istruzioni dettagliate sono reperibili nella sezione sulla creazione di nuovi conti. la sezione chiamata «Pro-
cedura per abilitare l’aggiornamento dei prezzi online»

Calcolatore di prestiti
Il Calcolatore di prestiti è utile per calcolare gli interessi composti. Fornisce la possibilità di inserire quattro
parametri dei cinque necessari per calcolare l’interesse composto e di calcolare il parametro incognito.

La calcolatrice è suddivisa in due riquadri: quello di sinistra presenta cinque campi con un pulsante Calcola
e un pulsante Pulisci. Il tasto Calcola permette di ottenere il risultato dell’incognita mentre il pulsante
Pulisci cancella qualsiasi valore inserito nel campo corrispondente.

• Numero di rate: questo campo è destinato al numero di rate da utilizzare per i calcoli.

• Tasso di interesse: questo campo è destinato al valore percentuale del tasso di interesse.

• Valore attuale: questo campo contiene, di solito, l’importo che è stato chiesto in prestito. È l’importo
di base su cui si vogliono calcolare gli interessi.

• Importo della rata: questo campo contiene l’importo del pagamento per il periodo selezionato (ad
esempio: mensile, settimanale ecc...). Se serve a ripagare un prestito allora dovrebbe avere un segno
negativo.

• Valore futuro: questo campo è per il valore finale al termine del periodo di pagamento. Nel caso si
stesse ripagando un prestito per intero allora sarebbe nullo (=0).

Il riquadro di destra contiene i pulsanti per selezionare il tipo di pagamento e l’interesse composto utilizzati
per i calcoli nel riquadro di sinistra.

• Interesse composto: questa opzione permette di impostare l’intervallo temporale utilizzato per il calcolo
se è stato selezionato l’interesse composto discreto.

• Rata: questo pulsante permette di impostare l’intervallo da utilizzare per il campo del Numero di rate.

• Pagamenti alla fine del periodo: attivare l’opzione se il pagamento della rata alla fine del periodo.
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• Pagamenti all’inizio del periodo: attivare l’opzione se il pagamento della rata all’inizio del periodo.

• Interesse composto discreto: questa opzione è utilizzata quando l’interesse è applicato in modo discreto,
cioè a intervalli temporali definiti dal pulsante Interesse composto descritto più sopra.

• Interesse composto continuo: questa opzione è utilizzata quando il tasso di interesse è applicato in modo
continuo.

• Pagamento totale: questo campo visualizza l’importo totale da pagare per restituire il prestito.

Esempi di utilizzo del Calcolatore di prestiti di GnuCash sono forniti nella «guida ai concetti e
manuale». Capitolo sui prestiti nella «guida ai concetti e manuale» [http://svn.gnucash.org/docs/gui-
de/loans_calcs1.html]

http://svn.gnucash.org/docs/guide/loans_calcs1.html
http://svn.gnucash.org/docs/guide/loans_calcs1.html
http://svn.gnucash.org/docs/guide/loans_calcs1.html
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Capitolo 8. Resoconti e diagrammi
Nota

This section is a «work in process» all of the material has not been reviewed for V2.0. While it
may not be strictly accurate, it is at least a "guide".

Resoconti e diagrammi permettono a GnuCash di presentare una vista generale dei dati finanziari in vari
modi. Questi strumenti vanno da un semplice sommario dei totali del conto ad una visualizzazione avanzata
di un portafoglio. Questa sezione presenterà una spiegazione dei principali resoconti di GnuCash e su
come personalizzarli

GnuCash classifica i resoconti principali in quattro classi; questi sono tutti disponibili nel menu resoconti.

Resoconti generali
The General Reports include the Account Summary Report, Custom Reports, the Tax Schedule Report
and TXF Export, and the Transaction Report and also the reports in the Sample & Custom menu.

• Sommario del conto:

• Tax Schedule Report and TXF Export: The tax schedule report lists all taxable income and deductible
expense amounts used in the preparation of US Income Tax returns. The purpose of the report is to
provide a complete audit trail for these amounts. The report is intended to be used by a tax payer to
manually prepare his or her own tax return, or alternatively, to be provided to a tax preparer for that
purpose. The report can also be used to generate an export of all tax related income and expenses to a
TXF (Tax eXchange Format) file (this is in addition to exporting to the HTML format that all reports
allow). The TXF file can be imported into tax filing programs such as TaxCut or TurboTax. The report
should be run, inspected carefully for errors or omissions, and then corrections made to transactions,
report settings, currency conversion rates or the account structure as needed. This process should be
repeated as often as needed until all the amounts on the report are correct before a final version is used
and saved along with the tax returns.

For accounts specified in the report options (none = all) that are also flagged as Tax-related, all transac-
tions for the time period selected (also in the report options) are included. The report sorts transactions
by date within account providing subtotals by account within tax code within Form or Schedule line
number. Support is also provided for multiple copies of and for sub-line items for selected Forms/Sche-
dules. Optionally uses special date processing to include federal estimated tax payments after year end.

All totals are in USD since this is the currency required for filing US Income Tax returns. Non-USD
transaction amounts are converted to USD using the transaction conversion rate to USD, if available.
If not, a conversion rate from the price database is used (either the date nearest the transaction date or
nearest the report date as specified in the report options; if none is available, transaction amounts are
converted to zero and the report provides a comment accordingly). A complete audit trail of conversions
is provided.

Nota

For this to work, the user has to segregate taxable and non taxable income to different accounts,
as well as deductible and non deductible expenses. The Income Tax Information dialog is used

for this. To access the Income Tax Information dialog go to Edit → Tax Report Options. The
user also must set the TXF category of each tax related account. The Income Tax Information
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dialog is described in the la sezione chiamata «Impostare le opzioni per i resoconti delle tasse»
section.

• Resoconto delle transazioni:

• Semplice resoconto di benvenuto:

• Resoconto multicolonna personalizzato: questo resoconto permette di inserire più resoconti in un’unica
finestra per esaminare un gruppo di informazioni finanziarie contemporaneamente.

• Grafici semplici

• Resoconto semplice con esempi:

Attività e passività
I resoconti di attività e passività includono il rapporto sul saldo, i resoconti sugli investimenti e il resoconto
sul patrimonio netto.

• Portafoglio avanzato:

• Istogramma delle attività:

• Grafico a torta delle attività:

• Saldo medio:

• Rapporto sul saldo: questo resoconto riassume le attività, le passività e il capitale. Quando vengono
mantenute correttamente, le attività dovrebbero essere pari alla somma tra passività e capitali; se così
non è, allora è presente uno sbilancio all’interno dei conti.

• Giornale generale:

• Libro mastro generale:

• Portafoglio degli investimenti: questo resoconto riassume il valore delle azioni nel paniere corrente.

• Istogramma:

• Grafico a torta delle passività:

• Istogramma del patrimonio netto: il patrimonio netto è rappresentato dalla differenza tra il valore delle
attività e quello delle passività.

• Grafico del patrimonio netto: andamento nel tempo del patrimonio netto (differenza tra il valore delle
attività e quello delle passività).

• Grafico a dispersione del prezzo:

Entrate e Uscite
I resoconti per entrate e uscite includono il flusso di liquidi e i rapporti sulle entrate.

• Resoconto di bilancio

• Flusso di liquidi:
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• Stato patrimoniale:

• Istogramma delle uscite:

• Grafico a torta delle uscite:

• Uscite per giorno della settimana:

• Istogramma delle entrate:

• Grafico delle entrate e delle uscite:

• Income Statement: This report summarizes sources of income and expenditure. (This report was called
Profit & Loss in gnucash-1.8.)

• Prospetto delle entrate:

• Entrate per giorno della settimana:

• Bilancio di previsione: questo resoconto riassume le fonti di reddito e di spesa.

Resoconti per gli affari
I resoconti per gli affari includono i rapporti su clienti e venditori, le fatture stampabili e i resoconti Aging
reports.

• Resoconto cliente:

• Fattura semplice:

• Resoconto dipendente:

• Fattura elaborata:

• Payable Aging:

• Fattura stampabile:

• Receivable Aging:

• Resoconto venditore:

Personalizzare resoconti e grafici
I resoconti di GnuCash possono essere personalizzati tramite varie opzioni. Prima di tutto selezionare ed
avviare un resoconto dal menu. Accedere poi alle opzioni del resoconto selezionando il pulsante Opzioni
nella barra degli strumenti.

Nota

Controllare le opzioni del nuovo motore grafico e descrivere la procedura per salvare le opzioni
dei resoconti personalizzati

La maggior parte dei resoconti hanno molte opzioni in comune. Alcune sono le seguenti:

• Nome resoconto: imposta il titolo del resoconto; è anche utilizzato per stampare il resoconto allo scopo
di visualizzarlo in seguito.
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• Opzioni della data: normalmente i resoconti si riferiscono a una specifica data o intervallo di date. Queste
possono essere impostate in due modi: direttamente (utilizzando il selettore di data) o selezionando una
data relativa dal menu. Le date relative permettono di specificare dei valori quali Inizio di quest’anno
o Oggi.

• Intervallo temporale: questa opzione è utilizzata negli istogrammi per impostare l’intervallo con cui
ogni barra viene rappresentata. Valori tipici sono: quotidianamente, settimanalmente, mensilmente e
annualmente.

• Conti: selezionare il conto appropriato per il resoconto. Si noti che per alcuni resoconti è possibile
selezionare solo certi tipi di conti. Per esempio, un grafico a torta delle uscite è visualizzabile solo se
viene selezionato un conto delle uscite.

• Mostra il nome completo del conto: questa opzione permette di scegliere se visualizzare il nome del
conto nella forma breve (per esempio Elettricità) oppure completa (per esempio Servizi:Elettricità).

• Includi sottoconti: i resoconti di sommario generalmente hanno un’opzione per includere anche i sotto-
conti che, se selezionata, fa in modo che sai compresi nel resoconto anche i sottoconti del conto padre
selezionato..

• Profondità: questa opzione permette di selezionare il numero di livelli con cui il resoconto deve visua-
lizzare i sottoconti. Se questi superano il livello selezionato, verrà calcolato un valore complessivo per
tutti i sottoconti e incluso nel totale. Per fare in modo che ogni conto o sottoconto venga visualizzato
singolarmente, selezionare tutti.

• Foglio di stile: seleziona il foglio di stile. I fogli di stile controllano il modo in cui i resoconti vengono
visualizzati. Al momento sono presenti quattro fogli di stile: Predefinito, Easy, Piè di pagina e Tech-

nicolor. È possibile personalizzare ognuno di essi dalla voce di menu Modifica → Fogli di stile.... Il
procedimento dettagliato è descritto in la sezione chiamata «Modificare i fogli di stile».

• Dimensioni di stampa: sono presenti opzioni per altezza e larghezza per la maggioranza dei grafici, che
specificano le dimensioni di visualizzazione in (pixel).

• Valuta del resoconto: seleziona la valuta da utilizzare per il resoconto. Generalmente le valute verranno
convertite in questa valuta per la visualizzazione.

• Fonte del prezzo: selezionare come i prezzi delle azioni e delle valute vengono calcolati in questo re-
soconto. È possibile scegliere tra la media pesata dei prezzi su tutte le transazioni, i prezzi al valore
corrente o i prezzi al momento della compilazione del resoconto.

• Totali: per i diagrammi verrà visualizzata una legenda con i totali.

• Maximum Slices: Controls the maximum number of slices displayed in a Grafico a torta - other accounts
will be placed in a slice marked Other.

• Maximum Bars: Controls the maximum number of bars displayed in a Istogramma.

• Display Columns: Choose columns to show from the register.

Stampare ed esportare resoconti e grafici
Nota

Da verificare!!! Come personalizzare la stampa con Gnome?
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GnuCash è in grado di stampare i resoconti e di esportarli nel formato HTML. La finestra di stampa di
un documento di GnuCash è accessibile dal pulsante Stampa sulla barra degli strumenti o tramite il menu

selezionando la voce File → Stampa. Per esportare un resoconto come pagina internet (HTML), selezionare
il pulsante Esporta sulla barra degli strumenti e inserire il nome da assegnare al file.

La finestra di stampa di un documento di GnuCash permette di selezionare la stampante alla quale inviare il
lavoro di stampa o il file su cui stampare il documento. La finestra fornisce anche un pulsante di Anteprima
per controllare il documento prima di inviarlo in stampa. Premendo Stampa il lavoro verrà inviato alla
stampante selezionata mentre premendo Annulla la finestra verrà chiusa senza effettuare alcuna stampa.

Stampando dalla finestra del registro, verrà stampato il resoconto dei conti, che è anche chiamato resoconto
del registro. In esso sono elencate le transazioni nel conto con un totale. Gli altri resoconti vengono invece
stampati come sono visualizzati nella schermata del resoconto.

Creare resoconti e grafici
Nota

Questa sezione potrebbe dover essere aggiornata!!!

Se i resoconti forniti da GnuCash non soddisfano le proprie esigenze, è possibile crearne di nuovi. Per farlo
è necessario conoscere Scheme (un linguaggio di programmazione simile a LISP) ed è anche consigliato
avere accesso al codice sorgente di GnuCash.

L’interfaccia dei resoconti è documentata nel seguente file del codice sorgente src/report/re-
port-system/doc/report-html.txt. Il file src/report/utility-reports/hel-
lo-world.scm nella distribuzione sorgente di GnuCash fornisce un buon esempio di come sviluppare
un resoconto.

È inoltre necessario accedere ai dati dal cuore del programma al fine di ricevere i dati che si desidera
inserire nel resoconto. Questa operazione è svolta da una serie di funzioni di Scheme documentate nel file
src/g-wrap/gnc.html. Esaminando alcuni degli altri resoconti in src/scm/report, è possibile
avere delle indicazioni sul loro utilizzo.

Attualmente, i resoconti sono prodotti richiamando una API di generazione HTML, che fornisce una dia-
lettica di HTML e la disegna con un widget HTML. Questa procedura presenta delle limitazioni, in parti-
colare qiuando si tenta di allineare gli oggetti con precisione, come può rendersi necessario per stampare
su fatture pre-stampate.
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Capitolo 9. Personalizzare GnuCash

Opzioni di visualizzazione del conto
Il comando Filtra per è utilizzato per impostare o modificare la vista della finestra della struttura ad albero
dei conti. La scheda dei Conti permette di selezionare la tipologia dei conti che devono essere mostrati.
Queste impostazioni influenzano distintamente ogni finestra aperta della struttura dei conti.

La scheda Altro permette invece di abilitare o disabilitare due opzioni: se visualizzare i conti nascosti e
se mostrare i conti che hanno un totale nullo.

La finestra della struttura dei conti, mostra di default solamente la quantità di ogni commodity che si
possiede, nella colonna del Totale. Spesso, però, può essere utile visualizzare altri valori; per fare questo
si può premere il pulsante Opzioni nella barra del titolo (la piccola freccia verso il basso sul lato destro
della barra del titolo nella finestra principale dei conti) e selezionare le voci da visualizzare. Queste scelte
influenzano tutte le finestre aperte della struttura dei conti.

Impostare le preferenze
La finestra delle Preferenze di GnuCash permette di personalizzare la propria sessione di GnuCash impo-

stando diverse opzioni. Dal menu di GnuCash selezionare Modifica → Preferenze (

Suggerimento

Fermando il cursore per qualche secondo sopra le opzioni presenti in questa finestra, verranno
mostrate delle descrizioni più approfondite sulla voce selezionata.

Nota

Le modifiche effettuate verranno applicate immediatamente.

Per chiudere la finestra delle Preferenze di GnuCash, premere il pulsante Chiudi.

Ogni scheda della finestra delle Preferenze di GnuCash ha una sezione dedicata nel seguito. Per un elenco
delle schede, consultare Capitolo 9, Personalizzare GnuCash.
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Periodo contabile

Figura 9.1. La scheda Preferenze — Periodo contabile

• Data d’inizio - specifica l’inizio del periodo contabile.

• Relativa — utilizza la data iniziale relativa specificata per calcolare i guadagni, le perdite e le attività
nette. L’inizio relativo è definito da: oggi o l’inizio dell’attuale o precedente anno, trimestre o mese.

• Assoluta — utilizza la data iniziale assoluta specificata per calcolare i guadagni, le perdite e le attività
nette.

• Data di termine — specifica la fine del periodo contabile.

• Relativa — utilizza la data finale relativa specificata per calcolare i guadagni, le perdite e le attività
nette.

• Assoluta — utilizza la data finale assoluta specificata per calcolare i guadagni, le perdite e le attività
nette.

• Contenuto della barra di riepilogo

• Includi somma complessiva — se attivata, verrà mostrata nella barra di riepilogo una somma com-
plessiva di tutti i conti utilizzando la valuta predefinita.

• Includi i totali diversi dalle valute — se questa opzione è selezionata, GnuCash includerà nella barra
di riepilogo un totale per gli elementi diversi dalla valuta (in pratica il numero di quote).
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Conti

Figura 9.2. La scheda Preferenze — Conti

• Carattere separatore — il separatore del conto è il carattere che separa un conto padre dai suoi sottoconti,
per esempio Bollette:Elettricità. Il valore predefinito è : (Colon), ma è anche possibile selezionare /
(Slash), \ (Backslash), - (Dash), . (Period) o qualsiasi altro carattere Unicode che non sia una lettra o
un numero.

• Conti con saldo invertito — se i saldi dei conti devono avere un valore positivo o negativo:

• Entrate e uscite assegna un saldo a credito positivo ai conti delle entrate a un saldo a debito negativo
ai conti delle uscite. Consultare la sezione chiamata «Tipi di conti in GnuCash» per maggiori infor-
mazioni su questo tipo di conti.

• Conti crediti (predefinita) visualizza un saldo positivo per i conti che normalmente hanno un saldo in
credito (entrate, crediti, passività, capitali). Consultare la sezione chiamata «Tipi di conti in GnuCash»
per maggiori informazioni su questo tipo di conti.

• Nessuno mostra tutti i saldi a credito come negativi e tutti i saldi a debito come positivi.

• Etichette — selezionare questa opzione per fare in modo che le colonne del registro riportino i termini
Debiti e Crediti invece delle diciture informali come Prelievo e Deposito.

• Valuta predefinita — questa opzione permette di selezionare la valuta impostata dal sistema come pre-
definita per la creazione di nuovi conti.

• Locale — utilizza la valuta predefinita di sistema per tutti i nuovi conti creati.

• Altra: — la valuta da utilizzare, indipendentemente dalle impostazioni di sistema.
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Impresa

Figura 9.3. La scheda Preferenze — Impresa

• Generali

• Apri in una nuova finestra — se selzionata, ogni registro verrà aperto in una nuova finestra in primo
piano. Diversamente, il registro verrà aperto nella finestra corrente.

• Accumula suddivisioni all’emissione — se accumulare automaticamente tutte le voci di una fattura
che trasferiscono verso lo stesso conto, in un’unica suddivisione.

• Fatture

• Tasse incluse — indica se le tasse sono già incluse nelle voci delle fatture. Questa impostazione sarà
applicata ai nuovi clienti e venditori.

• Ricevute

• Notifica scadenze — specifica se si vuole essere notificati all’avvio di GnuCash delle ricevute in
scadenza.

• Giorni in anticipo — quanti giorni in anticipo avvisare delle ricevute in scadenza.

• Tasse incluse — indica se le tasse sono già incluse nelle voci delle ricevute. Questa impostazione
sarà applicata ai nuovi clienti e venditori.
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Data e ora

Figura 9.4. La scheda Preferenze — Data e ora

• Formato della data

• Usa orologio a 24 ore — permette di specificare se utilizzare il formato dell’ora a 12 o 24 ore. Cioé
se le 11 di notte debbano essere rappresentate come 11PM o 23:00.l’

• Formato della data — questa opzione controlla l’aspetto della data (un’anteprima della data è visualiz-
zata a fianco di ciascuna scelta disponibile). Le scelte disponibili soo:

• Locale — usa il formato di data predefinito del sistema.

• US — utilizza il formato di data proprio degli Stati Uniti.

• UK — utilizza il formato di data proprio del Regno Unito.

• Europa — utilizza il formato di data proprio dell’Europa continentale.

• ISO — utilizza il formato di data specificato dallo standard ISO-8601.
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Generali

Figura 9.5. La scheda Preferenze — Generali

• Generali

• Visualizza la finestra del «suggerimento del giorno» — questa opzione permette di abilitare o disa-
bilitare la visualizzazione all’avvio di GnuCash della finestra del Suggerimento del giorno.

• Visualizza i suggerimenti all’avvio è utile per abilitare o disattivare il suggerimento del giorno
all’avvio di GnuCash.

• Esegui la procedura guidata per la struttura conti — questa opzione disabilita la visualizzazione
dell’assistente per l’Impostazione di una nuova struttura dei conti quando viene selezionata la voce

File → Nuovo file dal menu di GnuCash.

• Numeri

• Visualizza importi negativi in rosso — Se viene abilitata questa opzione, GnuCash visualizzerà gli
importi negativi in rosso.

• Posizioni decimali automatiche — inserisce automaticamente un punto decimale nei valori che sono
digitati senza.

• Posizioni decimali — il numero di posizioni decimali da utilizzare.

• File

Nota

Le opzioni seguenti sono rilevanti solamente per i file salvati in formato XML.
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• Comprimi: — Questa opzione ndica se i file dei dati di GnuCash debbano essere compressi o meno.

• Visualizza la richiesta di conferma per il salvataggio automatico — se abilitata, GnuCash visualizzerà
una schermata di conferma ogni volta che viene avviata la procedura di salvataggio automatico.

• Intervallo di salvataggio automatico — i minuti intercorrenti tra un salvataggio automatico del file e
uno successivo. Impostare a 0 per disabilitare la funzione di salvataggio automatrico.

• Conserva i file di log per: — in questa sezione è possibile impostare le preferenze relative ai file di log.

• Mai — disabilita la creazione dei file di log.

• Per: — inserire un numero di giorni per cui conservare i file.

• Per sempre — disabilita la cancellazione automatica dei file di log; conserva i file di log per sempre.

• Finestra di ricerca

• Soglia per una nuova ricerca — apre una nuova ricerca se il numero di risultati trovati è inferiore
al numero impostato qui.

Online Banking

Figura 9.6. La scheda Preferenze — Online Banking

• Importazione file QIF

• Visualizza la documentazione — la prima volta che si utilizza la procedura di importazione di file
QIF vengono visualizzate delle istruzioni dettagliate su come importare un file. Una volta che si è
acquistata familiarità con il procedimento, si potrebbe voler disattivare questa opzione rendendo il
processo più veloce.
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• Importatore generico

• Utilizza la corrispondenza Bayesiana — opzione per attivare o disattivare l’utilizzo degli algoritmi
Bayesiani per trovare le corrispondenze tra le nuove transazioni e i conti esistenti.

• Soglia di visualizzazione — il punteggio minimo che una possibile corrispondenza deve avere per
essere visualizzata nella lista delle corrispondenze.

• Soglia di auto-inserimento — una transazione il cui punteggio migliore ricade nella zona rossa (al
di sopra della soglia di visualizzazione, ma inferiore o uguale alla soglia di auto-inserimento), verrà
inserita automaticamente.

• Soglia di auto-liquidazione — una transazione il cui punteggio migliore ricade nella zona verde (su-
periore o al limite uguale al valore della soglia di auto-inserimento) verrà liquidata automaticamente.

• Soglia per i costi degli ATM commerciali — in alcune zone, gli sportelli commerciali ATM (che non
fanno capo a una particolare istituzione finanziaria) sono installati in luoghi come i centri commer-
ciali. Questi sportelli addebitano direttamente l’importo sul totale invece di farlo figurare con una
transazione separata o nell’estratto conto mensile della banca. Per esempio, se si prelevano €100 si
può essere addebitati di €101,50. Se si fosse inserito manualmente l’addebito dei soli €100, gli importi
non corrisponderebbero. Questa opzione dovrebbe essere impostata al valore massimo di questa tassa
applicato nella propria area (in un’unità della propria valuta), in modo che le transazioni vengano
riconosciute nel processo di identificazione delle corrispondenze.

• Online Banking

Nota

Questa scheda è mostrata solamente se GnuCash è compilato con il supporto ad Aqbanking
e HBCI.

• Ricorda PIN — abilitare questa opzione per fare in modo che GnuCash ricordi il PIN inserito per
l’autenticazione all’online banking.

• Messaggi di debug prolissi — abilitare questa opzione per fare in modo che GnuCash mostri infor-
mazioni iù dettagliate relativamente alle operazioni di online bancking.
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Stampa

Figura 9.7. La scheda Preferenze — Stampa

La scheda Stampa permette di configurare alcune opzioni che governano la stampasu carta degli assegni.

• Stampa il formato della data — abilitare questa opzione per stampare sugli assegni il formato della data
(nel tipo a 8 punti) sotto alla data.

• Stampa i caratteri di blocco — abilitare questa opzione per stampare una serie di tre asterischi prima
e dopo ogni campo di testo sull’assegno.

• Carattere predefinito — premere il pulsante di sinistra per aprire una finestra di Selezione del tipo di
carattere in cui è possibile personalizzare il carattere da utilizzare per la stampa su carta degli assegni.



Personalizzare GnuCash

91

Registro

Figura 9.8. La scheda Preferenze — Registro

• Operazioni

• «Invio» inserisce una riga con una transazione vuota — se attivata, premendo il tasto Invio il cursore
verrà spostato all’ultima transazione vuota alla fine del registro. Diversamente il cursore si sposterà
alla riga successiva.

• Espandi liste automaticamente — se selzionata, tutte le liste verranno automaticamente espanse quan-
do l’input è focalizzato nel campo lista.

• La sequenza di «Tab» include il campo «Trasferimento» per le transazioni memorizzate — se sele-
zionata, quando la transazione è completata automaticamente, premendo il tasto Tab nel registro, il
salto del cursore includerà il campo Trasferimento.

• Riconciliazione

• Spunta le transazioni liquidate — se selezionata, verranno spuntate automaticamente le transazioni
liquidate al momento della riconciliazione.

• Trasferimento automatico degli interessi — se attivata, prima della riconciliazione di un conto che
matura o addebita interessi, verrà richiesto se inserire una transazione per gli interessi. Attualmente
questa impostazione ha effetto solamente sui seguenti tipi di conti: banca, credito, fondo comune,
attività, debiti e crediti correnti e passività.

• Pagamento carta di credito automatico — se selezionata, dopo la riconciliazione del conto della carta
di credito, verrà richiesto un pagamento con la carta di credito.

• Riconcilia sempre a oggi — se selezionata, la finestra di riconciliazione viene aperta con la data
odierna, indiffirentemente dalla data della riconciliazione precedente.
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• Grafica

• Utilizza i colori del tema di sistema — se attivata, verranno utilizzati i colori del tema di sistema per la
decorazione delle finestre del registro. Se disattivata, verranno utilizzati i colori originali di GnuCash.

• I colori della modalità a doppia linea si alternano tra le transazioni — se attivata, configura la finestra
del registro in modo da alternare i colori primario e secondario per ogni transazione, invece che per
ogni riga.

• Disegna delle linee orizzontali fra le righe — se selezionata, GnuCash disegnerà delle linee orizzontali
tra ogni riga.

• Disegna delle linee verticali fra le colonne — se selezionata, GnuCash disegnerà delle linee verticali
tra ogni colonna.

Predefinite del registro

Figura 9.9. La scheda Preferenze — Predefinite del registro

La scheda delle preferenze Predefinite del registro influenza il comportamento delle finestre del registro
delle transazioni.

• Stile predefinito

Qui è possibile scegliere tra 3 diversi stili per la finestra del registro:

• Libro mastro basilare — visualizza tutte le transazioni su una riga singola (due nella modalità a doppia
linea).

• Mastro a espansione automatica Giornale della transazione

• Altre predefinite
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• Il registro verrà aperto in una nuova finestra — se selezionata, il registro del conto verrà aperto in
una nuova finestra invece che in una scheda.

• Modalità a doppia linea — visualizza due righe di informazioni per ogni transazione in luogo di una
unica.

• Visualizza solamente i nomi dei sottoconti — se selezionata, verranno visualizzati solamente i nomi
dei sottoconti nel campo di selezione del Conto. Il comportamento predefinito prevede la visualizza-
zione del nome completo del conto con incluso il suo percorso nella struttura dei conti.

Avvertimento

Abilitare questa opzione presuppone che vengano utilizzati dei nomi unici per i conti figli.

• Numero di transazioni — quante transazioni visualizzare nel registro. Un valore nullo significa che
verranno visualizzate tutte le transazioni.

Resoconti

Figura 9.10. La scheda Preferenze — Resoconti

La scheda delle preferenze Resoconti influisce sul comportamento dei resoconti di GnuCash.

• Valuta predefinita — questa opzione permette di selezionare la valuta da utilizzare come predefinita
per creare i resoconti. È possibile scegliere tra:

• Locale — utilizza la valuta predefinita di sistema per tutti i nuovi resoconti.

• Altra — utilizza la valuta specificata in questo campo per tuti nuovi resoconti.

• Posizione
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• Il resoconto viene aperto in una nuova finestra — se selezionata, i resoconti verranno aperti in una
nuova finestra invece che in una scheda.

Transazioni pianificate

Figura 9.11. La scheda Preferenze — Transazioni pianificate

La scheda delle preferenze Transazioni pianificate governa il comportamento delle transazioni pianificate
in GnuCash. Maggiori informazioni relative alle transazioni pianificate sono reperibili in la sezione chia-
mata «Pianificare le transazioni».

• Assistente dall’ultimo avvio

• Avvia all’apertura del file — se selezionata verrà visualizzato L’assistente dall’utlimo avvio all’avvio
di GnuCash (o meglio quando GnuCash aprirà un file).

• Predefinite dell’editor transazioni

• Crea automaticamente le nuove transazioni — se selezionata, le nuove transazioni pianificate verran-
no inserite automaticamente nel registro. Se questa opzione viene abilitata, è anche possibile abilitare
l’opzione Notifica prima che le transazioni vengano create in modo che sia possibile confermare la
creazione delle transazioni.

• Crea in anticipo — i giorni d’anticipo con cui creare una transazione pianificata.

• Ricorda in anticipo — i giorni d’anticipo con cui ricorare la scadenza per l’immissione di una tran-
sazione pianificata.
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Finestre

Figura 9.12. La scheda Preferenze — Finestre

• Geometria finestra

• Salva la dimensione e la posizioen della finestra — se selezionata, al prossimo avvio GnuCash uti-
lizzerà la dimensione e la posizione della finestra configurate nell’ultimo avvio.

• Stile della barra strumenti

È possibile scegliere tra cinque diversi stili per la barra degli strumenti:

• Utilizza predefinito di sistema (predefinito) — utilizza le impostazioni di sistema per visualizzare gli
elementi della barra degli strumenti.

• Testo sotto alle icone — Visualizza la barra degli strumenti con l’etichetta di testo sotto all’icona.
Le etichette verranno visualizzate per tutti gli elementi della barra.

• Testo accanto alle icone principali — visualizza gli elementi della barra degli strumenti con l’etichetta
di testo accanto all’icona. Le etichette di testo verranno visualizzate solamente per gli elementi più
importanti.

• Solo icone — visualizza solo le icone degli elementi della barra degli strumenti.

• Solo testo — visualizza solo il testo degli elementi della barra degli strumenti.

• Schede

• Visualizza il tasto di chiusura sulle schede — aggiunge una piccola icona per la chiusura su ogni
scheda per renderne più semplice la chiusura.
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• Porta la scheda più recente in primo piano — se selezionata, le nuove schede create verranno visua-
lizzate al di sopra delle altre.

• Larghezza — la larghezza dell’etichetta delle schede epressa in caratteri.

• Posizione delle schede

Posiziona le schede in Alto (predefinita), in Basso, a Sinistra o a Destra.

• Posizione della barra di riepilogo

Posiziona la barra di riepilogo In alto o In basso (predefinita) nella finestra principale di GnuCash.

Modificare i fogli di stile
GnuCash fornisce quattro tipi predefiniti di fogli di stile per le pagine web dei resoconti. Questi fogli di

stile possono essere modificati utilizzando l’editor HTML. Per accedervi, selezionare Modifica → Fogli
di stile....

Utilizzando l’editor dei fogli di stile è possibile visualizzare e modificare le impostazioni di un foglio di
stile.

Nota

Cambiando il foglio di stile, verrà modificato l’aspetto di tutti i resoconti a cui il foglio di stile
è associato. È necessario eseguire il comando Aggiorna per visualizzare i cambiamenti, se il o i
resoconti sono visualizzati al momento della modifica.

Per aggiungere un nuovo foglio di stile, selezionare il pulsante Nuovo... nel riquadro del foglio di stile;
verrà visualizzata la finestra per il Nuovo foglio di stile. Immettere il Nome e selezionare un modello. Per
rimuovere un foglio di stile, selezionarlo dalla lista e premere Elimina.

Foglio di stile predefinito
Il foglio di stile Predefinito presenta quattro schede per modificarne l’aspetto nei resoconti che lo utiliz-
zano: Colori, Caratteri, Generali e Tabelle.

Scheda Colori

• Colore alternativo delle celle: il colore da alternare sulle righe della tabella.

Scheda Stili

• Titolo: selezionare il carattere e la dimensione per i titoli.

• Collegamento al conto: il carattere e la dimensione per il collegamento al conto.

• Cella numerica: selezionare il carattere e la dimensione dei numeri per le celle numeriche.

• Valori negativi in rosso: se attivata, i valori negativi saranno visualizzati in rosso.

• Cella di testo: selezionare il carattere e la dimensione del testo per le celle di testo.

• Cella del totale: selezionare il carattere e la dimensione per le celle del totale.
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• Cella dell’etichetta del totale: selezionare il carattere e la dimensione del testo per la cella di intestazione
dei totali.

• Cella con etichetta centrata: selezionare il carattere e la dimensione del testo delle celle con l’etichetta
centrale.

Scheda Generali

• Colore dello sfondo: apre il selezionatore di colore per sceglierne uno nuovo.

• Immagine di sfondo: usare il pulsante Sfoglia per selezionare un’immagine da utilizzare come sfondo
nei resoconti.

• Abilita collegamenti: se attivata, verranno visualizzati in blu i collegamenti ipertestuali nei resoconti.

Scheda Tabelle

• Spaziatura tra le celle: permette di specificare lo spazio tra le celle

• Imbottitura della cella: specifica lo spazio tra i bordi della cella e il suo contenuto.

• Larghezza del bordo della tabella: permette di impostare la larghezza dei bordi delle tabelle.

Foglio di stile Semplice
Il foglio di stile Semplice presenta quattro schede per modificare l’aspetto dei resoconti: colori, generali,
immagini e tabelle.

Colori

• Colore dello sfondo: apre il selezionatore di colore per sceglierne uno nuovo.

• Colore del testo: apre il selezionatore del colore per sceglierne uno nuovo.

• Colore del testo della cella: apre il selezionatore del colore per sceglierne uno nuovo.

• Colore del collegamento: apre il selezionatore del colore per sceglierne uno nuovo.

• Colore alternativo delle celle: apre il selezionatore del colore per sceglierne uno nuovo.

• Colore della cella del sottotitolo e del subtotale: apre il selezionatore del colore per sceglierne uno nuovo.

• Colore della cella del sotto-sottotitolo e del totale: apre il selezionatore del colore per sceglierne uno
nuovo.

• Colore della cella della somma complessiva: apre il selezionatore del colore per scegliere il colore da
assegnare alle righe della somma complessiva.

Stili

• Titolo: selezionare il carattere e la dimensione per i titoli.

• Collegamento al conto: il carattere e la dimensione per il collegamento al conto.

• Cella numerica: selezionare il carattere e la dimensione dei numeri per le celle numeriche.

• Valori negativi in rosso: se attivata, i valori negativi saranno visualizzati in rosso.

• Intestazione: selezionare il carattere e la dimensione per l’intestazione.
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• Cella di testo: selezionare il carattere e la dimensione del testo per le celle di testo.

• Cella del totale: selezionare il carattere e la dimensione per le celle del totale.

• Cella dell’etichetta del totale: selezionare il carattere e la dimensione del testo per la cella di intestazione
dei totali.

• Cella con etichetta centrata: selezionare il carattere e la dimensione del testo delle celle con l’etichetta
centrale.

Generali

• Redattore: Nome della persona che ha preparato il resoconto.

• Preparato per: Nome della società od organizzazione per cui il resoconto è stato preparato.

• Visualizza informazioni sul redattore: mostra le informazioni sul redattore nel resoconto.

• Abilita collegamenti: se attivata, verranno visualizzati in blu i collegamenti ipertestuali nei resoconti.

Immagini

• Immagine di sfondo: permette di ricercare una immagine da utilizzare come sfondo nei resoconti utiliz-
zando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.

• Striscione di intestazione: permette di ricercare una immagine da utilizzare come intestazione nei reso-
conti utilizzando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.

• Allineamento dell’intestazione: selezionare dalla lista a discesa un valore tra sinistra, centro e destra per
specificare la posizione dello striscione superiore del o dei resoconti.

• Logo: permette di ricercare una immagine da utilizzare come logo nei resoconti utilizzando il pulsante
Sfoglia. Il pulsante Pulisci annulla la selezione.

Tabelle

• Spaziatura tra le celle: permette di specificare lo spazio tra le celle

• Imbottitura della cella: specifica lo spazio tra i bordi della cella e il suo contenuto.

• Larghezza del bordo della tabella: permette di impostare la larghezza dei bordi delle tabelle.

Fogli di stile Piè di pagina
Il foglio di stile Piè di pagina presenta le stesse cinque schede dello stile Easy per modificare l’aspetto dei
resoconti: Colori, Stili, Generali, Immagini e Tabelle.

Colori

• Colore dello sfondo: apre il selezionatore di colore per sceglierne uno nuovo.

• Colore del testo: apre il selezionatore del colore per sceglierne uno nuovo.

• Colore del testo della cella: apre il selezionatore del colore per sceglierne uno nuovo.

• Colore del collegamento: apre il selezionatore del colore per sceglierne uno nuovo.

• Colore alternativo delle celle: apre il selezionatore del colore per sceglierne uno nuovo.
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• Colore della cella del sottotitolo e del subtotale: apre il selezionatore del colore per sceglierne uno nuovo.

• Colore della cella del sotto-sottotitolo e del totale: apre il selezionatore del colore per sceglierne uno
nuovo.

• Colore della cella della somma complessiva: apre il selezionatore del colore per scegliere il colore da
assegnare alle righe della somma complessiva.

Stili

• Titolo: selezionare il carattere e la dimensione per i titoli.

• Collegamento al conto: il carattere e la dimensione per il collegamento al conto.

• Cella numerica: selezionare il carattere e la dimensione dei numeri per le celle numeriche.

• Valori negativi in rosso: se attivata, i valori negativi saranno visualizzati in rosso.

• Intestazione: selezionare il carattere e la dimensione per l’intestazione.

• Cella di testo: selezionare il carattere e la dimensione del testo per le celle di testo.

• Cella del totale: selezionare il carattere e la dimensione per le celle del totale.

• Cella dell’etichetta del totale: selezionare il carattere e la dimensione del testo per la cella di intestazione
dei totali.

• Cella con etichetta centrata: selezionare il carattere e la dimensione del testo delle celle con l’etichetta
centrale.

Generali

• Redattore: Nome della persona che ha preparato il resoconto.

• Preparato per: Nome della società od organizzazione per cui il resoconto è stato preparato.

• Visualizza informazioni sul redattore: mostra le informazioni sul redattore nel resoconto.

• Abilita collegamenti: se attivata, verranno visualizzati in blu i collegamenti ipertestuali nei resoconti.

• Piè di pagina: il testo da inserire a piè pagina del resocoto.

Immagini

• Immagine di sfondo: permette di ricercare una immagine da utilizzare come sfondo nei resoconti utiliz-
zando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.

• Striscione di intestazione: permette di ricercare una immagine da utilizzare come intestazione nei reso-
conti utilizzando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.

• Allineamento dell’intestazione: selezionare dalla lista a discesa un valore tra sinistra, centro e destra per
specificare la posizione dello striscione superiore del o dei resoconti.

• Logo: permette di ricercare una immagine da utilizzare come logo nei resoconti utilizzando il pulsante
Sfoglia. Il pulsante Pulisci annulla la selezione.

Tabelle

• Spaziatura tra le celle: permette di specificare lo spazio tra le celle
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• Imbottitura della cella: specifica lo spazio tra i bordi della cella e il suo contenuto.

• Larghezza del bordo della tabella: permette di impostare la larghezza dei bordi delle tabelle.

Foglio di stile Technicolor
Il foglio di stile Technicolor fornisce cinque schede per modificare l’aspetto dei resoconti: Colori, Stili,
Generali, Immagini e Tabelle.

Colori

• Colore dello sfondo: apre il selezionatore di colore per sceglierne uno nuovo.

• Colore del testo: apre il selezionatore del colore per sceglierne uno nuovo.

• Colore del testo della cella: apre il selezionatore del colore per sceglierne uno nuovo.

• Colore del collegamento: apre il selezionatore del colore per sceglierne uno nuovo.

• Colore alternativo delle celle: apre il selezionatore del colore per sceglierne uno nuovo.

• Colore della cella del sottotitolo e del subtotale: apre il selezionatore del colore per sceglierne uno nuovo.

• Colore della cella del sotto-sottotitolo e del totale: apre il selezionatore del colore per sceglierne uno
nuovo.

• Colore della cella della somma complessiva: apre il selezionatore del colore per scegliere il colore da
assegnare alle righe della somma complessiva.

Stili

• Titolo: selezionare il carattere e la dimensione per i titoli.

• Collegamento al conto: il carattere e la dimensione per il collegamento al conto.

• Cella numerica: selezionare il carattere e la dimensione dei numeri per le celle numeriche.

• Valori negativi in rosso: se attivata, i valori negativi saranno visualizzati in rosso.

• Intestazione: selezionare il carattere e la dimensione per l’intestazione.

• Cella di testo: selezionare il carattere e la dimensione del testo per le celle di testo.

• Cella del totale: selezionare il carattere e la dimensione per le celle del totale.

• Cella dell’etichetta del totale: selezionare il carattere e la dimensione del testo per la cella di intestazione
dei totali.

• Cella con etichetta centrata: selezionare il carattere e la dimensione del testo delle celle con l’etichetta
centrale.

Generali

• Redattore: Nome della persona che ha preparato il resoconto.

• Preparato per: Nome della società od organizzazione per cui il resoconto è stato preparato.

• Visualizza informazioni sul redattore: mostra le informazioni sul redattore nel resoconto.

• Abilita collegamenti: se attivata, verranno visualizzati in blu i collegamenti ipertestuali nei resoconti.
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Immagini
• Immagine di sfondo: permette di ricercare una immagine da utilizzare come sfondo nei resoconti utiliz-

zando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.

• Striscione di intestazione: permette di ricercare una immagine da utilizzare come intestazione nei reso-
conti utilizzando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.

• Allineamento dell’intestazione: selezionare dalla lista a discesa un valore tra sinistra, centro e destra per
specificare la posizione dello striscione superiore del o dei resoconti.

• Logo: permette di ricercare una immagine da utilizzare come logo nei resoconti utilizzando il pulsante
Sfoglia. Il pulsante Pulisci annulla la selezione.

Tabelle
• Spaziatura tra le celle: permette di specificare lo spazio tra le celle

• Imbottitura della cella: specifica lo spazio tra i bordi della cella e il suo contenuto.

• Larghezza del bordo della tabella: permette di impostare la larghezza dei bordi delle tabelle.

Impostare le opzioni per i resoconti delle tasse
The Income Tax Information dialog is used to set Tax Report Options. The settings on accounts in this
dialog are used by the TXF Export function in reports to select the accounts for export. To access this

dialog go to Edit → Tax Report Options.

If the Income Tax features are used, it is strongly recommended that the Tax Info column be made visible
on the accounts tab (click large downward-pointing arrow and select Tax Info check box). The Tax Info
column will display the Form/Schedule and tax category (e.g., Schedule D Dividend, cap gain distrib.)
assigned to an account, if any. Alternatively, it will display the following error messages which can be

corrected through Edit → Tax Report Options

• Relativo alle tasse ma non ha un codice

• Entità e tipo dell’imposta non specificati

• Tax type "tax_type": invalid code "code" for account type"

• Not tax-related; tax type "tax_type": invalid code "code" for account type

• Codice imposta "codice" non valido per il tipo di imposta "tipo_imposta"

• Not tax-related; invalid code "code" for tax type "tax_type"

• No form: code "code", tax type "tax_type"

• Not tax-related; no form: code "code", tax type "tax_type"

• No description: form "form", code "code", tax type "tax_type"

• Not tax-related; no description: form "form", code "code", tax type "tax_type"

• Not tax-related; "form"("copy") "desc" (code "code", tax type "tax_type")

The Income Tax Identity must be set in order to assign codes to individual accounts. Click Edit to set the
identity. The Tax Name is optional. If entered, it will be printed at the top of the report. A Type must be
selected in order to activate the tax category selections. The choices are:
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• Individual, Joint, etc. - Files US Form 1040 Tax Return

• Partnership - Files US Form 1065 Tax Return

• Corporation - Files US Form 1120 Tax Return

• S Corporation - Files US Form 1120S Tax Return

• None - No Income Tax Options Provided

While the Income Tax Entity Type can be changed after tax categories have been assigned to accounts,
you should be cautioned that you will need to manually change each one if you do so, which could be quite
tedious. The tax categories are unique for each Income Tax Entity Type, so changing the type will make
all previously assigned categories invalid. It is assumed (and highly recommended) that each GnuCash
file is for only one tax entity and this is where you specify its type of tax entity. You should not keep,
for example, personal and partnership accounts mixed in one GnuCash file if you plan to use the Income
Tax Reporting features.

A given TXF code can be assigned to multiple accounts. The Tax Schedule Report will combine accounts
by code and generate a detailed TXF record for each account and a summary TXF record for the total as
calculated by the report.

For codes for which the "Payer Name Source" is not grayed, the payer on the TXF record will be based on
what is specified here, either the account name of the account or the account name of the account’s parent
account. This feature is typically used for interest accounts or stocks or mutual funds that pay dividends
where the individual payees are shown on the tax schedule. For example, if the parent account’s name is
the name of your broker and the sub-account’s names are the names of individual stocks that pay dividends
and the name on the 1099-DIV received is that of the broker, in order to match that name, you would
select ’Parent Account’; the total dividends from the broker would be exported and, if you had several
brokers, there would be an amount exported and a subtotal for each broker, along with each brokers name.
Alternatively, if you had a parent account named Directly Held, for example, and below it sub-accounts
for one or more stocks, you would receive a 1099-DIV from the issuer of each stock separately and, in
order to match that name, you would select Current Account; the total dividends from each stock would
be exported and, if you had several stocks, there would be an amount exported and a subtotal for each
stock, along with each stock’s name as the payer.

Some tax Forms/Schedules need to have multiple copies filed under some circumstances (for example,
Schedule C if a taxpayer and spouse have separate businesses). For tax categories on these Forms/Sche-
dules, the Copy Number is not grayed out and can be used to segregate accounts by copy number.

• Accounts: This pane contains the list of accounts. Select an account to set a TXF category. If no account
is selected nothing is changed. If multiple accounts are selected, all of the accounts will be set to the
selected item.

• Tax Related: Select this check-box to add tax information to an account then select the TXF Category
below. This setting is displayed on the account edit dialogue but cannot be changed from there.

• TXF Categories: Select the desired one. A detailed description appears just below (if available, otherwise
it says No help available), along with the TXF code for the category and information about what line
number on the form or schedule the amounts are included in by tax year (used for detailed sort on report).

• Payer Name Source: Select an option to determine where the text description that is exported along with
the value of the account is derived from, as described above. This is usually the name of a bank, stock,
or mutual fund that pays dividends or interest. Occasionally, it is a description of a deduction.

• Copy Number: A copy number that is exported along with the value of the account. This is used to
segregate amounts between different copies of the same Form/Schedule that may need to be filed (e.g.,
Schedule C(1), Schedule C(2), etc.). This is also used to sort the report.
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TXF Export - Known Anomalies and Limitations
TaxCut 1999

• Code: N488 "^ Sched B \ Div. income, cap gain distrib."

• Code: N286 "^ Sched B \ Dividend income"

These two codes, from the same payer, are not correlated. The user will have to adjust for this after import.

TaxCut 1999, 2000

• Code: N521 " F1040 \ Federal estimated tax, quarterly"

Does not accept the date field and does not import the individual payment amounts, only the total. The
date and individual payment amounts, only matter if you have to compute the penalty. (this may be a
TurboTax enhancement)

• Code: N460 " W-2 \ Salary or wages, self"

• Code: N506 " W-2 \ Salary or wages, spouse"

• and other related codes.

Use Copy Number to separate information from more than one job.

TurboTax 1999, 2000

• Code: N521 " F1040 \ Federal estimated tax, quarterly"

Does not accept the dates outside of the tax year. This is a problem for the last payment that is due Jan 15.
GnuCash changes the the date of the last payment to Dec 31 for the export unless the "Do not use special
date processing" option is selected in the report options display tab. The user will have to adjust for this
after import. The date only matters if you have to compute the penalty.

TXF Tax eXport Format

• Duplicate Codes

Codes can be assigned to multiple accounts and the amounts will be summed for all the accounts generating
one detail TXF record per account and one summary TXF record for the sum. Codes that let you select
"Payer Name Source" will generate a separate summary TXF account with each change in payer. Selecting
the "Print TXF export parameters" option will cause the report to show to which codes this applies (Payer
Name Source option Y) and, for the accounts assigned to those codes, the Name Source each account is set
to and the TXF item number that will be assigned to each. A summary TXF record will be generated for
each change in assigned item line number. These may not be handled the same by TaxCut and TurboTax.

• Code: N673 "Short/Long gain or loss"

Short term or long term gain or loss from the sale of a security; generates TXF output for only the date
sold and sales amount, with the date acquired and cost basis information left blank (to be separately added
in the tax software). The code can be assigned to either a short-, long-, or mixed-term gain/loss income
account and the security sales transaction should be entered as illustrated in Section 8.7, Selling Shares, of
the GnuCash Tutorial and Concepts Guide. The report uses the transaction split of the gain/loss account to
find one or more other splits in the same transaction with negative share quantities. For each of these found,
it generates a detailed TXF output record with the quantity sold, the name of the security, the date sold,
and the sales amount. Note that if, for a given transaction, more than one transaction split is to a gain/loss
income account assigned to code 673, TXF output data will be erroneously repeated. That is because the
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report will fetch the same data, and re-output it, for each transaction split set to a gain/loss income account
within the same transaction. For this reason, there should be no more than one gain/loss account entered
per transaction to use this tax reporting code properly. (Note that no amounts are used from GnuCash’s
lot-tracking; a future enhancement is expected to use this data to provide capital gain reporting).

Detailed TXF Category Descriptions
Table 32. Detailed TXF Category Descriptions

Tabella 9.1. Detailed TXF Category Descriptions

Tax Form \ TXF Code

Descrizione

Messaggi TXF di aiuto estesi

< help \ H001

Name of Current account is exported.

Categories marked with a «<» or a «^», require a
Payer identification to be exported. «<» indicates
that the name of this account is exported as this
Payer ID. Typically, this is a bank, stock, or mutual
fund name.

^ help \ H002

Name of Parent account is exported.

Categories marked with a «<» or a «^», require a
Payer identification to be exported. «^» indicates
that the name of the PARENT of this account is ex-
ported as this Payer ID. Typically, this is a bank,
stock, or mutual fund name.

# help \ H003

Non ancora implementato, NON usare!

Categories marked with a «#» not fully implemen-
ted yet! Do not use these codes!

none \ N000

Tax Report Only - No TXF Export

This is a dummy category and only shows up on the
tax report, but is not exported.

Help F1040 \ H256

Form 1040 - the main tax form

Form 1040 is the main form of your tax return.

F1040 \ N261

Alimony received

Amounts received as alimony or separate mainte-
nance. Note: child support is not considered alimo-
ny.

F1040 \ N257

Other income, misc.

Miscellaneous income such as: a hobby or a farm
you operate mostly for recreation and pleasure, jury
duty pay. Exclude self employment income, gam-
bling winnings, prizes and awards.

F1040 \ N520

RR retirement inc., spouse

Spouse’s part of tier I railroad retirement benefits,
which are treated as a social security benefits. These
will be reported on Form RRB-1099.

F1040 \ N519

RR retirement income, self

The part of tier I railroad retirement benefits, which
are treated as a social security benefits. These will
be reported on Form RRB-1099.

F1040 \ N258

Sick pay or disability pay

Amounts you receive from your employer while you
are sick or injured are part of your salary or wages.
Exclude workers’ compensation, accident or health
insurance policy benefits, if you paid the premiums.
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Tax Form \ TXF Code

Descrizione

Messaggi TXF di aiuto estesi

F1040 \ N483

Social Security inc., spouse

Spouse’s part of any monthly benefit under title II
of the Social Security Act. These will be reported on
Form SSA-1099.

F1040 \ N266

Social Security income, self

The part of any monthly benefit under title II of the
Social Security Act. These will be reported on Form
SSA-1099.

F1040 \ N260

State and local tax refunds

Refund of state or local income tax refund (or credit
or offset) which you deducted or took a credit for
in an earlier year. You should receive a statement,
Form 1099-G. Not reportable if you didn’t itemize
last year.

F1040 \ N269

Taxable fringe benefits

Fringe benefits you receive in connection with the
performance of your services are included in your
gross income as compensation. Examples: Acci-
dent or Health Plan, Educational Assistance, Group-
Term Life Insurance, Transportation (company car).

Help F1099-G \ H634

Form 1099-G - certain Government payments

Form 1099-G is used to report certain government
payments from federal, state, or local governments.

F1099-G \ N672

Qualified state tuition earnings

Qualified state tuition program earnings you recei-
ved this year.

F1099-G \ N260

State and local tax refunds

Refund of state or local income tax refund (or credit
or offset) which you deducted or took a credit for
in an earlier year. You should receive a statement,
Form 1099-G. Not reportable if you didn’t itemize
last year.

F1099-G \ N479

Unemployment compensation

Total unemployment compensation paid to you this
year. Reported on Form 1099-G.

Help F1099-MISC \ H553

Form 1099-MISC - MISCellaneous income

Form 1099-MISC is used to report miscellaneous
income received and direct sales of consumer goods
for resale.

^ F1099-MISC \ N562

Crop insurance proceeds

The amount of crop insurance proceeds as the result
of crop damage.

^ F1099-MISC \ N559

Fishing boat proceeds

Your share of all proceeds from the sale of a catch
or the fair market value of a distribution in kind that
you received as a crew member of a fishing boat.

^ F1099-MISC \ N560

Medical/health payments

The amount of payments received as a physician or
other supplier or provider of medical or health care
services. This includes payments made by medical
and health care insurers under health, accident, and
sickness insurance programs.

^ F1099-MISC \ N561 The amount of non-employee compensation recei-
ved. This includes fees, commissions, prizes and
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Tax Form \ TXF Code

Descrizione

Messaggi TXF di aiuto estesi

Non employee compensation awards for services performed, other forms of com-
pensation for services you performed for a trade or
business by which you are not employed. Also in-
clude oil and gas payments for a working interest.

^ F1099-MISC \ N557

Other income

The amount of prizes and awards that are not for
services performed. Included is the fair market va-
lue of merchandise won on game shows. Included is
all punitive damages, any damages for nonphysical
injuries or sickness, and any other taxable damages,
Deceased employee’s wages paid to estate or bene-
ficiary.

^ F1099-MISC \ N259

Prizes and awards

The amount of prizes and awards that are not for
services performed. Included is the fair market value
of merchandise won on game shows.

^ F1099-MISC \ N555

Rents

Amounts received for all types of rents, such as real
estate rentals for office space, machine rentals, and
pasture rentals.

^ F1099-MISC \ N556

Royalties

The gross royalty payments received from a publi-
sher or literary agent.

Help F1099=MSA \ H629

Form 1099-MSA Medical Savings Account

Form 1099-MSA is used to report medical savings
account distributions.

F1099-MSA \ N632

MSA earnings on excess contrib

The earnings on any excess contributions you with-
drew from an MSA by the due date of your income
tax return. If you withdrew the excess, plus any ear-
nings, by the due date of your income tax return, you
must include the earnings in your income in the year
you received the distribution even if you used it to
pay qualified medical expenses.

F1099-MSA \ N631

MSA gross distribution

The amount you received this year from a Medical
Savings Account. The amount may have been a di-
rect payment to the medical service provider or di-
stributed to you.

Help F1099-R \ H473

Form 1099-R - Retirement distributions

Form 1099-R is used to report taxable and non-ta-
xable retirement distributions from retirement, pen-
sion, profit-sharing, or annuity plans. Use a separate
Form 1099-R for each payer.

^ F1099-R \ N623

SIMPLE total gross distribution

The gross amount of a distribution received from a
qualified SIMPLE pension plan.

^ F1099-R \ N624

SIMPLE total taxable distribution

The taxable amount of a distribution received from a
qualified SIMPLE plan. This amount may be subject
to a federal penalty of up to 25%.

^ F1099-R \ N477

Total IRA gross distribution

The gross amount of a distribution from a qualified
Individual Retirement Arrangement (IRA) plan.
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Tax Form \ TXF Code

Descrizione

Messaggi TXF di aiuto estesi

^ F1099-R \ N478

Total IRA taxable distribution

The taxable amount of a distribution from a qua-
lified Individual Retirement Arrangement (IRA)
plan.

^ F1099-R \ N475

Total pension gross distribution

The gross amount of a distribution from a qualified
pension or annuity plan. Note: IRA distributions are
not included here.

^ F1099-R \ N476

Total pension taxable distribution

The taxable amount of a distribution from a qua-
lified pension or annuity plan. Note: IRA distribu-
tions are not included here.

Help F2106 \ H380

employee business expenses

Form 2106 is used to deduct employee business ex-
penses. You must file this form if you were reim-
bursed by your employer or claim job-related tra-
vel, transportation, meal, or entertainment expenses.
Use a separate Form 2106 for your spouse’s expen-
ses.

F2106 \ N387

Reimb. business expenses (non-meal/ent.)

Reimbursement for business expenses from your
employer that is NOT included on your Form W-2.
Note: meals and entertainment are NOT included
here.

F2106 \ N388

Reimb. meal/entertainment expenses

Reimbursement for meal and entertainment expen-
ses from your employer that is NOT included on
your Form W-2.

Help F4137 \ H503

Form 4137 - tips not reported

Form 4137 is used to compute social security and
Medicare tax owed on tips you did not report to your
employer.

F4137 \ N505

Total cash/tips not reported to employer

The amount of tips you did not report to your em-
ployer.

Help F4684 \ H412

Form 4684 - casualties and thefts

Form 4684 is used to report gains and losses from
casualties and thefts.

F4684 \ N416

FMV after casualty

The fair market value (FMV) is the price at which
the property would change hands between a willing
buyer and seller, each having knowledge of the re-
levant facts. The FMV after a theft is zero if the pro-
perty is not recovered. The FMV is generally deter-
mined by competent appraisal.

F4684 \ N415

FMV before casualty

The fair market value (FMV) is the price at which
the property would change hands between a willing
buyer and seller, each having knowledge of the re-
levant facts. FMV is generally determined by com-
petent appraisal.

F4684 \ N414

Insurance/reimbursement

The amount of insurance or other reimbursement
you received expect to receive.
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Tax Form \ TXF Code

Descrizione

Messaggi TXF di aiuto estesi

Help F4835 \ H569

Form 4835 - farm rental income

Form 4835 is used to report farm rental income re-
ceived as a share of crops or livestock produced by
your tenant if you did not materially participate in
the operation or management of the farm. Use a dif-
ferent copy of Form 4835 for each farm rented.

F4835 \ N573

Agricultural program payments

Government payments received for: price support
payments, market gain from the repayment of a se-
cured Commodity Credit Corporation (CCC) loan
for less than the original loan amount, diversion pay-
ments, cost-share payments (sight drafts), payments
in the form of materials (such as fertilizer or lime)
or services (such as grading or building dams). Re-
ported on Form 1099-G.

F4835 \ N575

CCC loans forfeited/repaid

The full amount forfeited or repaid with certificates,
even if you reported the loan proceeds as income.
See IRS Pub 225.

F4835 \ N574

CCC loans reported/election

Generally, you do not report CCC loan proceeds as
income. However, if you pledge part or all of your
production to secure a CCC loan, you may elect to
report the loan proceeds as income in the year you
receive them, instead of the year you sell the crop.

F4835 \ N577

Crop insurance proceeds deferred

If you use the cash method of accounting and re-
ceive crop insurance proceeds in the same tax year
in which the crops are damaged, you can choose to
postpone reporting the proceeds as income until the
following tax year. A statement must also be atta-
ched to your return. See IRS Pub 225.

F4835 \ N576

Crop insurance proceeds received

You generally include crop insurance proceeds in
the year you receive them. Treat as crop insuran-
ce proceeds the crop disaster payments you receive
from the federal government.

F4835 \ N578

Other income

Illegal Federal irrigation subsidies, bartering inco-
me, income from discharge of indebtedness, state
gasoline or fuel tax refund, the gain or loss on the
sale of commodity futures contracts, etc.

F4835 \ N571

Sale of livestock/produce

Income you received from livestock, produce,
grains, and other crops based on production. Under
both the cash and the accrual methods of reporting,
you must report livestock or crop share rentals re-
ceived in the year you convert them into money or
its equivalent.

F4835 \ N572

Total cooperative distributions

Distributions received from a cooperative. This in-
cludes patronage dividends, non patronage distribu-
tions, per-unit retain allocations, and redemption of
non qualified notices and per unit retain allocations.
Reported on Form 1099-PATR.
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Tax Form \ TXF Code

Descrizione

Messaggi TXF di aiuto estesi

Help F6252 \ H427

Form 6252 - income from casual sales

Form 6252 is used to report income from casual sa-
les of real or personal property when you will recei-
ve any payments in a tax year after the year of sale
(i.e., installment sale).

F6252 \ N429

Debt assumed by buyer

Enter only mortgages or other debts the buyer assu-
med from the seller or took the property subject to.
Do not include new mortgages the buyer gets from
a bank, the seller, or other sources.

F6252 \ N431

Depreciation allowed

Enter all depreciation or amortization you deducted
or should have deducted from the date of purchase
until the date of sale. Add any section 179 expen-
se deduction. Several other adjustments are allowed,
See Form 6252 instructions.

F6252 \ N435

Payments received prior years

Enter all money and the fair market value (FMV)
of property you received before this tax year from
the sale. Include allocable installment income and
any other deemed payments from prior years. Do not
include interest whether stated or unstated.

F6252 \ N434

Payments received this year

Enter all money and the fair market value (FMV) of
any property you received in this tax year. Include
as payments any amount withheld to pay off a mort-
gage or other debt, such as broker and legal fees. Do
not include interest whether stated or unstated.

F6252 \ N428

Selling price

Enter the total of any money, face amount of the in-
stallment obligation, and the FMV of other property
that you received or will receive in exchange for the
property sold.

Help F8815 \ H441

Form 8815 - EE U.S. savings bonds sold for educa-
tion

Form 8815 is used to compute the amount of inte-
rest you may exclude if you cashed series EE U.S.
savings bonds this year that were issued after 1989
to pay for qualified higher education costs.

F8815 \ N444

EE US savings bonds proceeds

Enter the total proceeds (principal and interest) from
all series EE and I U.S. savings bonds issued after
1989 that you cashed during this tax year.

F8815 \ N443

Nontaxable education benefits

Nontaxable educational benefits. These benefits in-
clude: Scholarship or fellowship grants excludable
from income under section 117; Veterans’ educatio-
nal assistance benefits; Employer-provided educa-
tional assistance benefits that are not included in box
1 of your W-2 form(s); Any other payments (but not
gifts, bequests, or inheritances) for educational ex-
penses that are exempt from income tax by any U.S.
law. Do not include nontaxable educational benefits
paid directly to, or by, the educational institution.

F8815 \ N445

Post-89 EE bond face value

The face value of all post-1989 series EE bonds ca-
shed this tax year.
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Tax Form \ TXF Code

Descrizione

Messaggi TXF di aiuto estesi

Help F8863 \ H639

Form 8863 - Hope and Lifetime Learning education
credits

Form 8863 is used to compute the Hope and Lifeti-
me Learning education credits. IRS rules are strin-
gent for these credits. Refer to IRS Publication 970
for more information.

F8863 \ N637

Hope credit

Expenses qualified for the Hope credit are amounts
paid this tax year for tuition and fees required for
the student’s enrollment or attendance at an eligible
educational institution.

F8863 \ N638

Lifetime learning credit

Expenses qualified for the Lifetime Learning credit
are amounts paid this tax year for tuition and fees
required for the student’s enrollment or attendance
at an eligible educational institution.

Home Sale \ N392

Home Sale worksheets (was F2119)

Home Sale worksheets (replaces Form 2119) are
used to report the sale of your personal residence.
See IRS Pub 523.

Home Sale \ N393

Selling price of old home

The selling price is the total amount you receive for
your home. It includes money, all notes, mortgages,
or other debts assumed by the buyer as part of the
sale, and the fair market value of any other proper-
ty or any services you receive. Reported on Form
1099-S.

Help Sched B \ H285

Schedule B - interest and dividend income

Schedule B is used to report your interest and divi-
dend income.

< Sched B \ N487

Dividend income, non-taxable

Some mutual funds pay shareholders non-taxable
dividends. The amount of non-taxable dividends
are indicated on your monthly statements or Form
1099-DIV.

^ Sched B \ N286

Dividend income, Ordinary

Ordinary dividends from mutual funds, stocks, etc.,
are reported to you on a 1099-DIV. Note: these are
sometimes called short term capital gain distribu-
tions. Do not include (long term) capital gain distri-
butions or non-taxable dividends here, these go on
Sched D

< Sched B \ N287

Interest income

Taxable interest includes interest you receive from
bank accounts, credit unions, loans you made to
others. There are several categories of interest, be
sure you select the correct one!

< Sched B \ N489

Interest income, non-taxable

Non-taxable interest income other than from bonds
or notes of states, counties, cities, the District of Co-
lumbia, or a possession of the United States, or from
a qualified private activity bond. There are several
categories of interest, be sure you select the correct
one!

< Sched B \ N492

Interest income, OID bonds

Interest income from Original Issue Discount (OID)
bonds will be reported to you on Form 1099-OID.
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There are several categories of interest, be sure you
select the correct one!

< Sched B \ N524

Interest income, Seller-financed mortgage

Interest the buyer paid you on a mortgage or other
form of seller financing, for your home or other pro-
perty and the buyer used the property as a personal
residence. There are several categories of interest,
be sure you select the correct one!

< Sched B \ N289

Interest income, State and municipal bond

Interest on bonds or notes of states, counties, cities,
the District of Columbia, or possessions of the Uni-
ted States is generally free of federal income tax (but
you may pay state income tax). There are several
categories of interest, be sure you select the correct
one!

< Sched B \ N490

Interest income, taxed only by fed

Interest income that is taxed on your federal return,
but not on your state income tax return - other than
interest paid on U.S. obligations. There are several
categories of interest, be sure you select the correct
one!

< Sched B \ N491

Interest income, taxed only by state

Interest income that is not taxed on your federal re-
turn, but is taxed on your state income tax return -
other than interest income from state bonds or notes,
the District of Columbia, or a possession of the Uni-
ted States. There are several categories of interest,
be sure you select the correct one!

< Sched B \ N290

Interest income, tax-exempt private activity bond

Interest income from a qualified tax-exempt priva-
te activity bond is not taxable if it meets all requi-
rements. This income is included on your Schedule
B as non-taxable interest income. There are several
categories of interest, be sure you select the correct
one!

< Sched B \ N288

Interest income, US government

Interest on U.S. obligations, such as U.S. Treasury
bills, notes, and bonds issued by any agency of the
United States. This income is exempt from all state
and local income taxes. There are several categories
of interest, be sure you select the correct one!

Help Sched C \ H291

Schedule C - self-employment income

Schedule C is used to report income from self-em-
ployment. Use a separate Schedule C to report inco-
me and expenses from different businesses.

Sched C \ N293

Gross receipts or sales

The amount of gross receipts from your trade or bu-
siness. Include amounts you received in your tra-
de or business that were properly shown on Forms
1099-MISC.

Sched C \ N303

Other business income

The amounts from finance reserve income, scrap sa-
les, bad debts you recovered, interest (such as on no-
tes and accounts receivable), state gasoline or fuel
tax refunds you got this year, prizes and awards re-
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lated to your trade or business, and other kinds of
miscellaneous business income.

Help Sched D \ H320

Schedule D - capital gains and losses

Schedule D is used to report gains and losses from
the sale of capital assets.

^ Sched D \ N488

Dividend income, capital gain distributions

Sometimes called long term capital gain distribu-
tions. These are from mutual funds, other regula-
ted investment companies, or real estate investment
trusts. These are reported on your monthly state-
ments or Form 1099-DIV. Note: short term capital
gain distributions are reported on Sched B as ordi-
nary dividends

# Sched D \ N323

Long Term gain/loss - security

Long term gain or loss from the sale of a security.
Not yet implemented in GnuCash.

# Sched D \ N321

Short Term gain/loss - security

Short term gain or loss from the sale of a security.
Not yet implemented in GnuCash.

# Sched D \ N673

Short/Long Term gain or loss

Short term or long term gain or loss from the sale
of a security; for use when only the date sold and
net sales amount are available and the date acquired
and cost basis information is not available and will
be separately added in the tax software.

Help Sched E \ H325

Schedule E - rental and royalty income

Schedule E is used to report income or loss from
rental real estate, royalties, and residual interest in
REMIC’s. Use a different copy for each rental or
royalty. Use the Schedule K-1 categories for part-
nership rental income and loss amounts.

Sched E \ N326

Rents received

The amounts received as rental income from real
estate (including personal property leased with real
estate) but you were not in the real estate business.
(If you are in the business of renting personal pro-
perty, use Schedule C.)

Sched E \ N327

Royalties received

Royalties received from oil, gas, or mineral proper-
ties (not including operating interests); copyrights;
and patents.

Help Sched F \ H343

Schedule F - Farm income and expense

Schedule F is used to report farm income and ex-
pense. Use a different copy of Schedule F for each
farm you own.

Sched F \ N372

Agricultural program payments

Government payments received for: price support
payments, market gain from the repayment of a se-
cured Commodity Credit Corporation (CCC) loan
for less than the original loan amount, diversion pay-
ments, cost-share payments (sight drafts), payments
in the form of materials (such as fertilizer or lime)
or services (such as grading or building dams). Re-
ported on Form 1099-G.
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Sched F \ N374

CCC loans forfeited or repaid

The amount forfeited or repaid with certificates,
even if you reported the loan proceeds as income.
See IRS Pub 225.

Sched F \ N373

CCC loans reported/election

Generally, you do not report CCC loan proceeds as
income. However, if you pledge part or all of your
production to secure a CCC loan, you may elect to
report the loan proceeds as income in the year you
receive them, instead of the year you sell the crop.

Sched F \ N376

Crop insurance proceeds deferred

If you use the cash method of accounting and re-
ceive crop insurance proceeds in the same tax year
in which the crops are damaged, you can choose to
postpone reporting the proceeds as income until the
following tax year. A statement must also be atta-
ched to your return. See IRS Pub 225.

Sched F \ N375

Crop insurance proceeds received

You generally include crop insurance proceeds in
the year you receive them. Treat as crop insuran-
ce proceeds the crop disaster payments you receive
from the federal government.

Sched F \ N370

Custom hire income

The income you received for custom hire (machine
work).

Sched F \ N377

Other farm income

Illegal Federal irrigation subsidies, bartering inco-
me, income from discharge of indebtedness, state
gasoline or fuel tax refund, the gain or loss on the
sale of commodity futures contracts, etc.

Sched F \ N369

Resales of livestock/items

Amounts you received from the sales of livestock
and other items you bought specifically for resale.
Do not include sales of livestock held for breeding,
dairy purposes, draft, or sport. These are reported on
Form 4797, Sales of Business Property.

Sched F \ N368

Sales livestock/product raised

Amounts you received from the sale of livestock,
produce, grains, and other products you raised.

Sched F \ N371

Total cooperative distributions

Distributions received from a cooperative. This in-
cludes patronage dividends, non patronage distribu-
tions, per-unit retain allocations, and redemption of
non qualified notices and per unit retain allocations.
Reported on Form 1099-PATR.

Help Sched K-1 \ H446

Schedule K-1 - partnership income, credits, deduc-
tions

Schedule K-1 is used to report your share of a
partnership’s income, credits, deductions, etc. Use a
separate copy of Schedule K-1 for each partnership.

Sched K-1 \ N452

Dividends, ordinary

The amount of dividend income the partnership re-
ported to you on Schedule K-1. (You report this on
Schedule B)
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Sched K-1 \ N455

Guaranteed partner payments

A guaranteed payments the partnership reported to
you on Schedule K-1. (You report this on Schedule
E)

Sched K-1 \ N451

Interest income

The amount of interest income the partnership re-
ported to you on Schedule K-1. (You report this on
Schedule B)

# Sched K-1 \ N454

Net LT capital gain or loss

The long-term gain or (loss) from the sale of asse-
ts the partnership reported to you on Schedule K-1.
(You report this on Schedule D)

# Sched K-1 \ N453

Net ST capital gain or loss

The short-term gain or (loss) from sale of assets the
partnership reported to you on K-1. (You report this
on Schedule D)

# Sched K-1 \ N456

Net Section 1231 gain or loss

The gain or (loss) from sale of Section 1231 asse-
ts the partnership reported to you on Schedule K-1.
(You report this on Form 4797)

# Sched K-1 \ N448

Ordinary income or loss

Your share of the ordinary income (loss) from the
trade or business activities of the partnership. This
is reported to you on Schedule K-1. (You usually
report this on Schedule E, See instructions for Sche-
dule K-1)

# Sched K-1 \ N450

Other rental income or loss

The income or (loss) from rental activities, other
than the rental of real estate. This is reported to you
on Schedule K-1. (You usually report this on Sche-
dule E, See instructions for Schedule K-1)

# Sched K-1 \ N449

Rental real estate income or loss

The income or (loss) from rental real estate activities
engaged in by the partnership. This is reported to
you on Schedule K-1. (You usually report this on
Schedule E, See instructions for Schedule K-1)

Sched K-1 \ N527

Royalties

The amount of the royalty income the partnership
reported to you on Schedule K-1. (You report this
on Schedule E)

Sched K-1 \ N528

Tax-exempt interest income

The amount of tax-exempt interest income the part-
nership reported to you on Schedule K-1. (You re-
port this on Form 1040)

Help W-2 \ H458

Form W-2 - Wages earned and taxes withheld

Form W-2 is used by your employer to report the
amount of wages and other compensation you ear-
ned as an employee, and the amount of federal and
state taxes withheld and fringe benefits received.
Use a separate copy of Form W-2 for each employer.

^ W-2 \ N465

Dependent care benefits, self

The amount dependent care benefits, including the
fair market value of employer-provided or em-
ployer-sponsored day-care facilities you received.

^ W-2 \ N512

Dependent care benefits, spouse

The amount dependent care benefits, including the
fair market value of employer-provided or em-
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ployer-sponsored day-care facilities your spouse re-
ceived.

^ W-2 \ N267

Reimbursed moving expenses, self

Qualified moving expense reimbursements paid di-
rectly to you by an employer.

^ W-2 \ N546

Reimbursed moving expenses, spouse

Qualified moving expense reimbursements paid di-
rectly to your spouse by your spouse’s employer.

^ W-2 \ N460

Salary or wages, self

The total wages, tips, and other compensation, be-
fore any payroll deductions, you receive from your
employer.

^ W-2 \ N506

Salary or wages, spouse

The total wages, tips, and other compensation, be-
fore any payroll deductions, your spouse receives
from your spouse’s employer.

Help W-2G \ H547

Form W-2G - gambling winnings

Form W-2G is used to report certain gambling win-
nings.

^ W-2G \ N549

Gross winnings

The amount of gross winnings from gambling. This
may include winnings from horse racing, dog ra-
cing, jai alai, lotteries, keno, bingo, slot machines,
sweepstakes, and wagering pools. If the amount is
large enough, it will be reported on Form W-2G.

none \ N000

Tax Report Only - No TXF Export

This is a dummy category and only shows up on the
tax report, but is not exported.

Help F1040 \ H256

Form 1040 - the main tax form

Form 1040 is the main form of your tax return.

F1040 \ N264

Alimony paid

Amounts payed as alimony or separate maintenan-
ce. Note: child support is not considered alimony.

< F1040 \ N265

Early withdrawal penalty

Penalty on Early Withdrawal of Savings from CD’s
or similar instruments. This is reported on Form
1099-INT or Form 1099-OID.

F1040 \ N521

Federal estimated tax, quarterly

The quarterly payments you made on your estimated
Federal income tax (Form 1040-ES). Include any
overpay from your previous year return that you ap-
plied to your estimated tax. NOTE: If a full year (Jan
1, YEAR to Dec 31, YEAR) is specified, GnuCash
adjusts the date to Mar 1, YEAR to Feb 28, YEAR
+1. Thus, the payment due Jan 15 is exported for the
correct year.

F1040 \ N613

Fed tax withheld, RR retire, self

The amount of federal income taxes withheld from
your part of tier I railroad retirement benefits, which
are treated as a social security benefits.
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F1040 \ N614

Fed tax withheld, RR retire, spouse

The amount of federal income taxes withheld from
your spouse’s part of tier I railroad retirement bene-
fits, which are treated as a social security benefits.

F1040 \ N611

Fed tax withheld, Social Security, self

The amount of federal income taxes withheld from
your part of any monthly benefit under title II of the
Social Security Act.

F1040 \ N612

Fed tax withheld, Social Security, spouse

The amount of federal income taxes withheld from
your spouse’s part of any monthly benefit under title
II of the Social Security Act.

F1040 \ N482

IRA contrib., non-work spouse

IRA contribution for a non-working spouse.

F1040 \ N262

IRA contribution, self

Contribution to a qualified IRA. If you or your spou-
se are covered by a company retirement plan, this
amount could be limited or eliminated.

F1040 \ N481

IRA contribution, spouse

Contribution of a working spouse to a qualified IRA.
If you or your spouse are covered by a company re-
tirement plan, the deductible contribution could be
limited or eliminated.

F1040 \ N263

Keogh deduction, self

Contributions to a Keogh or HR 10 plan of a sole
proprietor or a partnership.

F1040 \ N516

Keogh deduction, spouse

Spouse Contributions to a Keogh or HR 10 plan of
a sole proprietor or a partnership.

F1040 \ N608

Medical savings contribution, spouse

Contributions made to your spouse’s medical sa-
vings account that were not reported on their Form
W-2.

F1040 \ N607

Medical savings contribution, self

Contributions made to your medical savings ac-
count that were not reported on your Form W-2.

F1040 \ N517

SEP-IRA deduction, self

Contributions made to a simplified employee pen-
sion plan (SEP-IRA).

F1040 \ N518

SEP-IRA deduction, spouse

Spouse contributions made to a simplified employee
pension plan (SEP-IRA).

F1040 \ N609

SIMPLE contribution, self

Contributions made to your SIMPLE retirement
plan that were not reported on your Form W-2.

F1040 \ N610

SIMPLE contribution, spouse

Contributions made to your spouse’s SIMPLE reti-
rement plan that were not reported on your spouse’s
Form W-2.

F1040 \ N636

Student loan interest

The amount of interest you paid this year on quali-
fied student loans.



Personalizzare GnuCash

117

Tax Form \ TXF Code

Descrizione

Messaggi TXF di aiuto estesi

Help F1099-G \ H634

Form 1099-G - certain Government payments

Form 1099-G is used to report certain government
payments from federal, state, or local governments.

F1099-G \ N606

Fed tax withheld, unemployment comp

The amount of federal income taxes withheld from
your unemployment compensation.

F1099-G \ N605

Unemployment comp repaid

If you received an overpayment of unemployment
compensation this year or last and you repaid any of
it this year, subtract the amount you repaid from the
total amount you received.

Help F1099-MISC \ H553

Form 1099-MISC - MISCellaneous income

Form 1099-MISC is used to report miscellaneous
income received and direct sales of consumer goods
for resale.

^ F1099-MISC \ N558

Federal tax withheld

The amount of federal income tax withheld (backup
withholding) from 1099-MISC income.

^ F1099-MISC \ N563

State tax withheld

The amount of state income tax withheld (state bac-
kup withholding) from 1099-MISC income.

Help F1099-R \ H473

Form 1099-R - Retirement distributions

Form 1099-R is used to report taxable and non-ta-
xable retirement distributions from retirement, pen-
sion, profit-sharing, or annuity plans. Use a separate
Form 1099-R for each payer.

^ F1099-R \ N532

IRA federal tax withheld

The amount of federal income taxes withheld from
your IRA distribution.

^ F1099-R \ N534

IRA local tax withheld

The amount of local income taxes withheld from
your IRA distribution.

^ F1099-R \ N533

IRA state tax withheld

The amount of state income taxes withheld from
your IRA distribution.

^ F1099-R \ N529

Pension federal tax withheld

The amount of federal income taxes withheld from
your pension distribution.

^ F1099-R \ N531

Pension local tax withheld

The amount of local income taxes withheld from
your pension distribution.

^ F1099-R \ N530

Pension state tax withheld

The amount of state income taxes withheld from
your pension distribution.

^ F1099-R \ N625

SIMPLE federal tax withheld

The amount of federal income taxes withheld from
a SIMPLE distribution received.

^ F1099-R \ N627

SIMPLE local tax withheld

The amount of local income taxes withheld from a
SIMPLE distribution received.
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^ F1099-R \ N626

SIMPLE state tax withheld

The amount of state income taxes withheld from a
SIMPLE distribution received.

Help F2106 \ H380

employee business expenses

Form 2106 is used to deduct employee business ex-
penses. You must file this form if you were reim-
bursed by your employer or claim job-related tra-
vel, transportation, meal, or entertainment expenses.
Use a separate Form 2106 for your spouse’s expen-
ses.

F2106 \ N382

Automobile expenses

Total annual expenses for gasoline, oil, repairs, in-
surance, tires, license plates, or similar items.

F2106 \ N381

Education expenses

Cost of tuition, books, supplies, laboratory fees, and
similar items, and certain transportation costs if the
education maintains or improves skills required in
your present work or is required by your employer
or the law to keep your salary, status, or job, and the
requirement serves a business purpose of your em-
ployer. Expenses are not deductible if they are nee-
ded to meet the minimum educational requirements
to qualify you in your work or business or will lead
to qualifying you in a new trade or business.

F2106 \ N391

Employee home office expenses

Your use of the business part of your home must be:
exclusive, regular, for your trade or business, AND
The business part of your home must be one of the
following: your principal place of business, a pla-
ce where you meet or deal with patients, clients, or
customers in the normal course of your trade or bu-
siness, or a separate structure (not attached to your
home) you use in connection with your trade or bu-
siness. Additionally, Your business use must be for
the convenience of your employer, and You do not
rent all or part of your home to your employer and
use the rented portion to perform services as an em-
ployee. See IRS Pub 587.

F2106 \ N389

Job seeking expenses

Fees to employment agencies and other costs to look
for a new job in your present occupation, even if you
do not get a new job.

F2106 \ N384

Local transportation expenses

Local transportation expenses are the expenses of
getting from one workplace to another when you are
not traveling away from home. They include the co-
st of transportation by air, rail, bus, taxi, and the co-
st of using your car. Generally, the cost of commu-
ting to and from your regular place of work is not
deductible.

F2106 \ N386

Meal/entertainment expenses

Allowable meals and entertainment expense, inclu-
ding meals while away from your tax home over-
night and other business meals and entertainment.
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F2106 \ N385

Other business expenses

Other job-related expenses, including expenses for
business gifts, trade publications, etc.

F2106 \ N390

Special clothing expenses

cost and upkeep of work clothes, if you must wear
them as a condition of your employment, and the
clothes are not suitable for everyday wear. Include
the cost of protective clothing required in your work,
such as safety shoes or boots, safety glasses, hard
hats, and work gloves.

F2106 \ N383

Travel (away from home)

Travel expenses are those incurred while traveling
away from home for your employer. The cost of get-
ting to and from your business destination (air, rail,
bus, car, etc.), taxi fares, baggage charges, and clea-
ning and laundry expenses. Note: meal and enter-
tainment expenses are not included here.

Help F2441 \ H400

Form 2441 - child and dependent credit

Form 2441 is used to claim a credit for child and
dependent care expenses.

< F2441 \ N401

Qualifying child/dependent care expenses

The total amount you actually paid to the care pro-
vider. Also, include amounts your employer paid to
a third party on your behalf.

< F2441 \ N402

Qualifying household expenses

The cost of services needed to care for the qualify-
ing person as well as to run the home. They include
the services of a babysitter, cleaning person, cook,
maid, or housekeeper if the services were partly for
the care of the qualifying person.

Help F3903 \ H403

Form 3903 - moving expenses

Form 3903 is used to claim moving expenses.

F3903 \ N406

Transport/storage of goods

The amount you paid to pack, crate and move your
household goods and personal effects. You may in-
clude the cost to store and insure household goods
and personal effects within any period of 30 days
in a row after the items were moved from your old
home.

F3903 \ N407

Travel/lodging, except meals

The amount you paid to travel from your old home
to your new home. This includes transportation and
lodging on the way. Although not all members of
your household must travel together, you may only
include expenses for one trip per person. Do not in-
clude meals.

Help F4684 \ H412

Form 4684 - casualties and thefts

Form 4684 is used to report gains and losses from
casualties and thefts.

F4684 \ N413

Basis of casualty property

Cost or other basis usually means original cost plus
improvements. Subtract any postponed gain from
the sale of a previous main home. Special rules ap-
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ply to property received as a gift or inheritance. See
Pub 551, Basis of Assets, for details.

Help F4835 \ H569

Form 4835 - farm rental income

Form 4835 is used to report farm rental income re-
ceived as a share of crops or livestock produced by
your tenant if you did not materially participate in
the operation or management of the farm. Use a dif-
ferent copy of Form 4835 for each farm rented.

F4835 \ N579

Car and truck expenses

The business portion of car or truck expenses, such
as, for gasoline, oil, repairs, insurance, tires, license
plates, etc.

F4835 \ N580

Chemicals

Chemicals used in operating your farm, such as in-
sect sprays and dusts.

F4835 \ N581

Conservation expenses

Your expenses for soil or water conservation or for
the prevention of erosion of land used in farming. To
take this deduction, your expenses must be consi-
stent with a plan approved by the Natural Resources
Conservation Service (NRCS) of the Department of
Agriculture.

F4835 \ N582

Custom hire expenses

Amounts you paid for custom hire (machine work)
(the machine operator furnished the equipment). Do
not include amounts paid for rental or lease of equi-
pment you operated yourself.

F4835 \ N583

Employee benefit programs

Contributions to employee benefit programs, such
as accident and health plans, group-term life insu-
rance, and dependent care assistance programs. Do
not include contributions that are a incidental part of
a pension or profit-sharing plan.

F4835 \ N584

Feed purchased

The cost of feed for your livestock. Generally, you
cannot currently deduct expenses for feed to be con-
sumed by your livestock in a later tax year. See in-
structions for Schedule F.

F4835 \ N585

Fertilizers and lime

The cost of fertilizer, lime, and other materials ap-
plied to farm land to enrich, neutralize, or condition
it. You can also deduct the cost of applying these
materials. However, see Prepaid Farm Supplies, in
Pub 225, for a rule that may limit your deduction for
these materials.

F4835 \ N586

Freight and trucking

The costs of freight or trucking of produce or live-
stock.

F4835 \ N587

Gasoline, fuel, and oil

The costs of gas, fuel, oil, etc. for farm equipment.

F4835 \ N588

Insurance (other than health)

Premiums paid for farm business insurance, such
as: fire, storm, crop, theft and liability protection of
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farm assets. Do not include premiums for employee
accident and health insurance.

F4835 \ N589

Interest expense, mortgage

The interest you paid to banks or other financial in-
stitutions for which you received a Form 1098, for a
mortgage on real property used in your farming bu-
siness (other than your main home). If you paid in-
terest on a debt secured by your main home, and any
proceeds from that debt were used in your farming
operation, refer to IRS Pub 225.

F4835 \ N590

Interest expense, other

The interest you paid for which you did not receive
a Form 1098 (perhaps someone else did, and you are
liable too), for a mortgage or other loans for your
farm business.

F4835 \ N591

Labor hired

The amounts you paid for farm labor. Do not inclu-
de amounts paid to yourself. Count the cost of boar-
ding farm labor but not the value of any products
they used from the farm. Count only what you paid
house-hold help to care for farm laborers.

F4835 \ N602

Other farm expenses

Include all ordinary and necessary farm rental ex-
penses not deducted elsewhere on Form 4835, such
as advertising, office supplies, etc. Do not include
fines or penalties paid to a government for violating
any law.

F4835 \ N592

Pension/profit-sharing plans

Enter your deduction for contributions to employee
pension, profit-sharing, or annuity plans. If the plan
included you as a self-employed person, see the in-
structions for Schedule C (Form 1040).

F4835 \ N594

Rent/lease land, animals

Amounts paid to rent or lease property such as pa-
sture or farm land.

F4835 \ N593

Rent/lease vehicles, equip.

The business portion of your rental cost, for rented
or leased vehicles, machinery, or equipment. But if
you leased a vehicle for a term of 30 days or mo-
re, you may have to reduce your deduction by an in-
clusion amount. For details, see the instructions for
Schedule C (Form 1040).

F4835 \ N595

Repairs and maintenance

Amounts you paid for repairs and maintenance of
farm buildings, machinery, and equipment. You can
also include what you paid for tools of short life or
minimal cost, such as shovels and rakes.

F4835 \ N596

Seeds and plants purchased

The amounts paid for seeds and plants purchased for
farming.

F4835 \ N597

Storage and warehousing

Amounts paid for storage and warehousing of crops,
grains, etc.
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F4835 \ N598

Supplies purchased

Livestock supplies and other supplies, including
bedding, office supplies, etc.

F4835 \ N599

Imposte

Real estate and personal property taxes on farm bu-
siness assets; Social security and Medicare taxes
you paid to match what you are required to with-
hold from farm employees’ wages and any Federal
unemployment tax paid; Federal highway use tax.

F4835 \ N600

Utilities

Amounts you paid for gas, electricity, water, etc., for
business use on the farm. Do not include personal
utilities. You cannot deduct the base rate (including
taxes) of the first telephone line into your residence,
even if you use it for business.

F4835 \ N601

Vet, breeding, medicine

The costs of veterinary services, medicine and bree-
ding fees.

Help F4952 \ H425

Form 4952 - investment interest

Form 4952 is used to compute the amount of invest-
ment interest expense deductible for the current year
and the amount, if any, to carry forward to future
years.

F4952 \ N426

Investment interest expense

The investment interest paid or accrued during the
tax year, regardless of when you incurred the indeb-
tedness. Investment interest is interest paid or ac-
crued on a loan (or part of a loan) that is allocable
to property held for investment.

Help F6252 \ H427

Form 6252 - income from casual sales

Form 6252 is used to report income from casual sa-
les of real or personal property when you will recei-
ve any payments in a tax year after the year of sale
(i.e., installment sale).

F6252 \ N432

Expenses of sale

Enter sales commissions, advertising expenses, at-
torney and legal fees, etc., in selling the property.

Help F8815 \ H441

Form 8815 - EE U.S. savings bonds sold for educa-
tion

Form 8815 is used to compute the amount of inte-
rest you may exclude if you cashed series EE U.S.
savings bonds this year that were issued after 1989
to pay for qualified higher education costs.

F8815 \ N442

Qualified higher education expenses

Qualified higher education expenses include tuition
and fees required for the enrollment or attendance of
the person(s). Do not include expenses for room and
board, or courses involving sports, games, or hob-
bies that are not part of a degree or certificate gran-
ting program.

Help F8829 \ H536

Form 8829 - business use of your home

Form 8829 is used only if you file a Schedule C,
Profit or Loss from Business, and you meet speci-
fic requirements to deduct expenses for the business
use of your home. IRS rules are stringent for this
deduction. Refer to IRS Publication 587.
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F8829 \ N537

Deductible mortgage interest

The total amount of mortgage interest that would be
deductible whether or not you used your home for
business (i.e., amounts allowable as itemized deduc-
tions on Schedule A, Form 1040). Form 8829 com-
putes the deductible business portion.

F8829 \ N539

Assicurazione

The total amount of insurance paid for your home,
in which an area or room is used regularly and ex-
clusively for business. Form 8829 computes the de-
ductible business portion.

F8829 \ N542

Other expenses

If you rent rather than own your home, include rent
paid for your home, in which an area or room is used
regularly and exclusively for business. Form 8829
computes the deductible business portion.

F8829 \ N538

Real estate taxes

The total amount of real estate taxes that would be
deductible whether or not you used your home for
business (i.e., amounts allowable as itemized deduc-
tions on Schedule A, Form 1040). Form 8829 com-
putes the deductible business portion.

F8829 \ N540

Repairs and maintenance

The total amount of repairs and maintenance paid
for your home, in which an area or room is used
regularly and exclusively for business. Form 8829
computes the deductible business portion.

F8829 \ N541

Utilities

The total amount of utilities paid for your home, in
which an area or room is used regularly and exclu-
sively for business. Form 8829 computes the deduc-
tible business portion.

Help F8839 \ H617

Form 8839 - adoption expenses

Form 8839 is used to report qualified adoption ex-
penses.

F8839 \ N618

Adoption fees

Adoption fees that are reasonable and necessary, di-
rectly related to, and for the principal purpose of, the
legal adoption of an eligible child.

F8839 \ N620

Attorney fees

Attorney fees that are reasonable and necessary, di-
rectly related to, and for the principal purpose of, the
legal adoption of an eligible child.

F8839 \ N619

Court costs

Court costs that are reasonable and necessary, direc-
tly related to, and for the principal purpose of, the
legal adoption of an eligible child.

F8839 \ N622

Other expenses

Other expenses that are reasonable and necessary,
directly related to, and for the principal purpose of,
the legal adoption of an eligible child.

F8839 \ N621

Traveling expenses

Traveling expenses (including meals and lodging)
while away from home, directly related to, and for
the principal purpose of, the legal adoption of an eli-
gible child.
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Home Sale \ N392

Home Sale worksheets (was F2119)

Home Sale worksheets (replaces Form 2119) are
used to report the sale of your personal residence.
See IRS Pub 523.

Home Sale \ N397

Cost of new home

The cost of your new home includes costs incurred
within the replacement period (beginning 2 years
before and ending 2 years after the date of sale) for
the following items: Buying or building the home;
Rebuilding the home; and Capital improvements or
additions.

Home Sale \ N394

Expense of sale

Selling expenses include commissions, advertising
fees, legal fees, title insurance, and loan charges
paid by the seller, such as loan placement fees or
"points."

Home Sale \ N396

Fixing-up expenses

Fixing-up expenses are decorating and repair costs
that you paid to sell your old home. For example, the
costs of painting the home, planting flowers, and re-
placing broken windows are fixing-up expenses. Fi-
xing-up expenses must meet all the following con-
ditions. The expenses: Must be for work done du-
ring the 90-day period ending on the day you sign
the contract of sale with the buyer; Must be paid no
later than 30 days after the date of sale; Cannot be
deductible in arriving at your taxable in-come; Mu-
st not be used in figuring the amount realized; and
Must not be capital expenditures or improvements.

Help Sched A \ H270

Schedule A - itemized deductions

Schedule A is used to report your itemized deduc-
tions.

Sched A \ N280

Cash charity contributions

Contributions or gifts by cash or check you gave to
organizations that are religious, charitable, educa-
tional, scientific, or literary in purpose. You may al-
so deduct what you gave to organizations that work
to prevent cruelty to children or animals. For do-
nations of $250 or more, you must have a state-
ment from the charitable organization showing the
amount donated and the value of goods or services
you received.

Sched A \ N484

Doctors, dentists, hospitals

Insurance premiums for medical and dental care,
medical doctors, dentists, eye doctors, surgeons, X-
ray, laboratory services, hospital care, etc. See IRS
Pub 502.

Sched A \ N272

Gambling losses

Gambling losses, but only to the extent of gambling
winnings reported on Form 1040. Note: not subject
to the 2% AGI of limitation.

Sched A \ N545

Home mortgage interest (no 1098)

Home mortgage interest paid, for which you did not
receive a Form 1098 from the recipient. The interest
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could be on a first or second mortgage, home equity
loan, or refinanced mortgage.

Sched A \ N283

Home mortgage interest (1098)

Home mortgage interest and points reported to you
on Form 1098. The interest could be on a first or
second mortgage, home equity loan, or refinanced
mortgage.

Sched A \ N282

Investment management fees

Investment interest is interest paid on money you
borrowed that is allocable to property held for in-
vestment. It does not include any interest allocable
to passive activities or to securities that generate tax-
exempt income.

Sched A \ N544

Local income taxes

Local income taxes that were not withheld from
your salary, such as local income taxes you paid this
year for a prior year.

Sched A \ N274

Medical travel and lodging

Lodging expenses while away from home to receive
medical care in a hospital or a medical care facility
related to a hospital. Do not include more than $50
a night for each eligible person. Ambulance service
and other travel costs to get medical care.

Sched A \ N273

Medicine and drugs

Prescription medicines, eyeglasses, contact lenses,
hearing aids. Over-the-counter medicines are not
deductible.

Sched A \ N523

Misc., no 2% AGI limit

Other miscellaneous itemized deductions that are
not reduced by 2% of adjusted gross income, such
as casualty and theft losses from income-producing,
amortizable bond premium on bonds acquired befo-
re October 23, 1986, federal estate tax on income
in respect to a decedent, certain unrecovered invest-
ment in a pension, impairment-related work expen-
ses of a disabled person.

Sched A \ N486

Misc., subject to 2% AGI limit

Safety equipment, small tools, and supplies you nee-
ded for your job; Uniforms required by your em-
ployer and which you may not usually wear away
from work; subscriptions to professional journals;
job search expenses; certain educational expenses.
You may need to file Form 2106.

Sched A \ N485

Non-cash charity contributions

The fair market value of donated property, such as
used clothing or furniture.

Sched A \ N277

Other taxes

Other taxes paid not included under state and local
income taxes, real estate taxes, or personal property
taxes. You may want to take a credit for the foreign
tax instead of a deduction.

Sched A \ N535

Personal property taxes

Enter personal property tax you paid, but only if it
is based on value alone. Example: You paid a fee
for the registration of your car. Part of the fee was
based on the car s value and part was based on its
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weight. You may deduct only the part of the fee that
is based on the car s value.

Sched A \ N284

Points paid (no 1098)

Generally, you must deduct points you paid to refi-
nance a mortgage over the life of the loan. If you
used part of the proceeds to improve your main ho-
me, you may be able to deduct the part of the points
related to the improvement in the year paid. See Pub.
936 Use this line for points not reported on Form
1098.

Sched A \ N276

Real estate taxes

Include taxes (state, local, or foreign) you paid on
real estate you own that was not used for business,
but only if the taxes are based on the assessed va-
lue of the property. Do not include taxes charged for
improvements that tend to increase the value of your
property (for example, an assessment to build a new
sidewalk).

Sched A \ N522

State estimated tax, quarterly

State estimated tax payments made this year.

Sched A \ N275

State income taxes

State income taxes paid this year for a prior year.
Include any part of a prior year refund that you chose
to have credited to this years state income taxes.

Sched A \ N271

Subscriptions

Amounts paid for subscriptions to magazines or ser-
vices that are directly related to the production or
collection of taxable income. (example: subscrip-
tions to investment publications, stock newsletters,
etc.).

Sched A \ N281

Tax preparation fees

Fees you paid for preparation of your tax return, in-
cluding fees paid for filing your return electronical-
ly.

Help Sched B \ H285

Schedule B - interest and dividend income

Schedule B is used to report your interest and divi-
dend income.

< Sched B \ N615

Fed tax withheld, dividend income

The amount of federal income taxes withheld from
dividend income. This is usually reported on Form
1099-DIV.

< Sched B \ N616

Fed tax withheld, interest income

The amount of federal income taxes withheld from
interest income. This is usually reported on Form
1099-INT.

Help Sched C \ H291

Schedule C - self-employment income

Schedule C is used to report income from self-em-
ployment. Use a separate Schedule C to report inco-
me and expenses from different businesses.

Sched C \ N304

Pubblicità

The amounts paid for advertising your trade or bu-
siness in newspapers, publications, radio or televi-
sion. Also include the cost of brochures, business
cards, or other promotional material.
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Sched C \ N305

Bad debts from sales/services

Include debts and partial debts from sales or servi-
ces that were included in income and are definitely
known to be worthless.

Sched C \ N306

Car and truck expenses

You can deduct the actual expenses of running your
car or truck, or take the standard mileage rate.

Sched C \ N307

Commissions and fees

The amounts of commissions or fees paid to inde-
pendent contractors (non employees) for their servi-
ces.

Sched C \ N494

Cost of Goods Sold - Labor

Labor costs are usually an element of cost of goods
sold only in a manufacturing or mining business. In
a manufacturing business, labor costs that are pro-
perly allocable to the cost of goods sold include both
the direct and indirect labor used in fabricating the
raw material into a finished, salable product.

Sched C \ N495

Cost of Goods Sold - Materials/supplies

Materials and supplies, such as hardware and che-
micals, used in manufacturing goods are charged to
cost of goods sold. Those that are not used in the
manufacturing process are treated as deferred char-
ges. You deduct them as a business expense when
you use them.

Sched C \ N496

Cost of Goods Sold - Other costs

Other costs incurred in a manufacturing or mining
process that you charge to your cost of goods sold
are containers, freight-in, overhead expenses.

Sched C \ N493

Cost of Goods Sold - Purchases

If you are a merchant, use the cost of all merchandise
you bought for sale. If you are a manufacturer or
producer, this includes the cost of all raw materials
or parts purchased for manufacture into a finished
product. You must exclude the cost of merchandise
you withdraw for your personal or family use.

Sched C \ N309

Depletion

The amounts for depletion. If you have timber de-
pletion, attach Form T. See Pub. 535.

Sched C \ N308

Employee benefit programs

Contributions to employee benefit programs that are
not an incidental part of a pension or profit-sha-
ring plan. Examples are accident and health plans,
group-term life insurance, and dependent care assi-
stance programs.

Sched C \ N310

Insurance, other than health

Premiums paid for business insurance. Do not inclu-
de amounts paid for employee accident and health
insurance. nor amounts credited to a reserve for self-
insurance or premiums paid for a policy that pays
for your lost earnings due to sickness or disability.
See Pub. 535.

Sched C \ N311

Interest expense, mortgage

The interest you paid to banks or other financial in-
stitutions for which you received a Form 1098, for
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a mortgage on real property used in your business
(other than your main home).

Sched C \ N312

Interest expense, other

The interest you paid for which you did not receive
a Form 1098 (perhaps someone else did, and you are
liable too), for a mortgage or other loans for your
business.

Sched C \ N298

Legal and professional fees

Accountant’s or legal fees for tax advice related to
your business and for preparation of the tax forms
related to your business.

Sched C \ N294

Meals and entertainment

Total business meal and entertainment expenses.
Business meal expenses are deductible only if they
are (a) directly related to or associated with the ac-
tive conduct of your trade or business, (b) not lavish
or extravagant, and (c) incurred while you or your
employee is present at the meal.

Sched C \ N313

Office expenses

The cost of consumable office supplies such as busi-
ness cards, computer supplies, pencils, pens, posta-
ge stamps, rental of postal box or postage machines,
stationery, Federal Express and UPS charges, etc.

Sched C \ N302

Other business expenses

Other costs not specified on other lines of Schedu-
le C, such as: Clean-fuel vehicles and refueling pro-
perty; Donations to business organizations; Educa-
tional expenses; Environmental cleanup costs; Im-
pairment-related expenses; Interview expense allo-
wances; Licenses and regulatory fees; Moving ma-
chinery; Outplacement services; Penalties and fines
you pay for late performance or nonperformance of
a contract; Subscriptions to trade or professional pu-
blications.

Sched C \ N314

Pension/profit sharing plans

You can set up and maintain the following small
business retirement plans for yourself and your em-
ployees, such as: SEP (Simplified Employee Pen-
sion) plans; SIMPLE (Savings Incentive Match Plan
for Employees) plans; Qualified plans (including
Keogh or H.R. 10 plans). You deduct contributions
you make to the plan for yourself on Form 1040.

Sched C \ N300

Rent/lease other business property

The amounts paid to rent or lease real estate or pro-
perty, such as office space in a building.

Sched C \ N299

Rent/lease vehicles, equip.

The amount paid to rent or lease vehicles, machine-
ry, or equipment, for your business. If you leased a
vehicle for a term of 30 days or more, you may have
to reduce your deduction by an amount called the
inclusion amount. See Pub. 463.

Sched C \ N315

Repairs and maintenance

The cost of repairs and maintenance. Include labor,
supplies, and other items that do not add to the value
or increase the life of the property. Do not include
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the value of your own labor. Do not include amounts
spent to restore or replace property; they must be
capitalized.

Sched C \ N296

Returns and allowances

Credits you allow customers for returned merchan-
dise and any other allowances you make on sales.

Sched C \ N301

Supplies (not from Cost of Goods Sold)

The cost of supplies not reported under Cost Of
Goods Sold.

Sched C \ N316

Taxes and licenses

Include the following taxes: State and local sales ta-
xes imposed on you as the seller of goods or ser-
vices; Real estate and personal property taxes on
business assets; Social security and Medicare taxes
paid to match required withholding from your em-
ployees’ wages; Also, Federal unemployment tax
paid; Federal highway use tax.

Sched C \ N317

Travel

Expenses for lodging and transportation connected
with overnight travel for business while away from
your tax home.

Sched C \ N318

Utilities

The costs of electricity, gas, telephone, etc. for your
business property.

Sched C \ N297

Wages paid

The total amount of salaries and wages for the tax
year. Do not include amounts paid to yourself.

Help Sched E \ H325

Schedule E - rental and royalty income

Schedule E is used to report income or loss from
rental real estate, royalties, and residual interest in
REMIC’s. Use a different copy for each rental or
royalty. Use the Schedule K-1 categories for part-
nership rental income and loss amounts.

Sched E \ N328

Pubblicità

Amounts paid to advertise rental unit(s) in newspa-
pers or other media or paid to realtor’s to obtain te-
nants.

Sched E \ N329

Auto and travel

The ordinary and necessary amounts of auto and tra-
vel expenses related to your rental activities, inclu-
ding 50% of meal expenses incurred while traveling
away from home.

Sched E \ N330

Cleaning and maintenance

The amounts paid for cleaning services (carpet, dra-
pes), cleaning supplies, locks and keys, pest control,
pool service, and general cost of upkeep of the ren-
tal property.

Sched E \ N331

Commissioni

The amounts paid as Commissions to realtor’s or
management companies to collect rent.

Sched E \ N332

Assicurazione

Insurance premiums paid for fire, theft, liability.
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Sched E \ N333

Legal and professional fees

The amounts of fees for tax advice and the prepara-
tion of tax forms related to your rental real estate or
royalty properties.

Sched E \ N502

Management fees

The amount of fees to a manager or property mana-
gement company to oversee your rental or royalty
property.

Sched E \ N334

Mortgage interest expense

Interest paid to banks or other financial institutions
for a mortgage on your rental property, and you re-
ceived a Form 1098.

Sched E \ N341

Other expenses

Other expenses that are not listed on other tax lines
of Schedule E. These might include the cost of gar-
dening and/or snow removal services, association
dues, bank charges, etc.

Sched E \ N335

Other interest expense

Interest paid for a mortgage on your rental property,
not paid to banks or other financial institutions or
you did not receive a Form 1098.

Sched E \ N336

Repairs

You may deduct the cost of repairs made to keep
your property in good working condition. Repairs
generally do not add significant value to the proper-
ty or extend its life.

Sched E \ N337

Supplies

Miscellaneous items needed to maintain the proper-
ty, such as: brooms, cleaning supplies, nails, paint
brushes, etc.

Sched E \ N338

Imposte

The amounts paid for real estate and personal pro-
perty taxes. Also include the portion of any payroll
taxes you paid for your employees.

Sched E \ N339

Utilities

The costs of electricity, gas, telephone, etc. for your
rental property.

Help Sched F \ H343

Schedule F - Farm income and expense

Schedule F is used to report farm income and ex-
pense. Use a different copy of Schedule F for each
farm you own.

Sched F \ N543

Car and truck expenses

The business portion of car or truck expenses, such
as, for gasoline, oil, repairs, insurance, tires, license
plates, etc.

Sched F \ N366

Chemicals

Chemicals used in operating your farm, such as in-
sect sprays and dusts.

Sched F \ N362

Conservation expenses

Your expenses for soil or water conservation or for
the prevention of erosion of land used in farming. To
take this deduction, your expenses must be consi-
stent with a plan approved by the Natural Resources
Conservation Service (NRCS) of the Department of
Agriculture.

Sched F \ N378 The cost or other basis of the livestock and other
items you actually sold.
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Cost of resale livestock/items

Sched F \ N367

Custom hire expenses

Amounts you paid for custom hire (machine work)
(the machine operator furnished the equipment). Do
not include amounts paid for rental or lease of equi-
pment you operated yourself.

Sched F \ N364

Employee benefit programs

Contributions to employee benefit programs, such
as accident and health plans, group-term life insu-
rance, and dependent care assistance programs. Do
not include contributions that are a incidental part of
a pension or profit-sharing plan.

Sched F \ N350

Feed purchased

The cost of feed for your livestock. Generally, you
cannot currently deduct expenses for feed to be con-
sumed by your livestock in a later tax year. See in-
structions for Schedule F.

Sched F \ N352

Fertilizers and lime

The cost of fertilizer, lime, and other materials ap-
plied to farm land to enrich, neutralize, or condition
it. You can also deduct the cost of applying these
materials. However, see Prepaid Farm Supplies, in
Pub 225, for a rule that may limit your deduction for
these materials.

Sched F \ N361

Freight and trucking

The costs of freight or trucking of produce or live-
stock.

Sched F \ N356

Gasoline, fuel, and oil

The costs of gas, fuel, oil, etc. for farm equipment.

Sched F \ N359

Insurance, other than health

Premiums paid for farm business insurance, such
as: fire, storm, crop, theft and liability protection of
farm assets. Do not include premiums for employee
accident and health insurance.

Sched F \ N346

Interest expense, mortgage

The interest you paid to banks or other financial in-
stitutions for which you received a Form 1098, for a
mortgage on real property used in your farming bu-
siness (other than your main home). If you paid in-
terest on a debt secured by your main home, and any
proceeds from that debt were used in your farming
operation, refer to IRS Pub 225.

Sched F \ N347

Interest expense, other

The interest you paid for which you did not receive
a Form 1098 (perhaps someone else did, and you are
liable too), for a mortgage or other loans for your
farm business.

Sched F \ N344

Labor hired

The amounts you paid for farm labor. Do not inclu-
de amounts paid to yourself. Count the cost of boar-
ding farm labor but not the value of any products
they used from the farm. Count only what you paid
house-hold help to care for farm laborers.
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Sched F \ N365

Other farm expenses

Include all ordinary and necessary farm expenses
not deducted elsewhere on Schedule F, such as ad-
vertising, office supplies, etc. Do not include fines
or penalties paid to a government for violating any
law.

Sched F \ N363

Pension/profit sharing plans

Enter your deduction for contributions to employee
pension, profit-sharing, or annuity plans. If the plan
included you as a self-employed person, see the in-
structions for Schedule C (Form 1040).

Sched F \ N348

Rent/lease land, animals

Amounts paid to rent or lease property such as pa-
sture or farm land.

Sched F \ N349

Rent/lease vehicles, equip.

The business portion of your rental cost, for rented
or leased vehicles, machinery, or equipment. But if
you leased a vehicle for a term of 30 days or mo-
re, you may have to reduce your deduction by an in-
clusion amount. For details, see the instructions for
Schedule C (Form 1040).

Sched F \ N345

Repairs and maintenance

Amounts you paid for repairs and maintenance of
farm buildings, machinery, and equipment. You can
also include what you paid for tools of short life or
minimal cost, such as shovels and rakes.

Sched F \ N351

Seeds and plants purchased

The amounts paid for seeds and plants purchased for
farming.

Sched F \ N357

Storage and warehousing

Amounts paid for storage and warehousing of crops,
grains, etc.

Sched F \ N353

Supplies purchased

Livestock supplies and other supplies, including
bedding, office supplies, etc.

Sched F \ N358

Imposte

Real estate and personal property taxes on farm bu-
siness assets; Social security and Medicare taxes
you paid to match what you are required to with-
hold from farm employees’ wages and any Federal
unemployment tax paid; Federal highway use tax.

Sched F \ N360

Utilities

Amounts you paid for gas, electricity, water, etc., for
business use on the farm. Do not include personal
utilities. You cannot deduct the base rate (including
taxes) of the first telephone line into your residence,
even if you use it for business.

Sched F \ N355

Vet, breeding, and medicine

The costs of veterinary services, medicine and bree-
ding fees.

Help Sched H \ H565

Schedule H - Household employees

Schedule H is used to report Federal employment
taxes on cash wages paid this year to household em-
ployees. Federal employment taxes include social
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security, Medicare, withheld Federal income, and
Federal unemployment (FUTA) taxes.

^ Sched H \ N567

Cash wages paid

For household employees to whom you paid $1,100
(as of 1999) or more each of cash wages that are su-
bject to social security and Medicare taxes. To find
out if the wages are subject to these taxes, see the
instructions for Schedule H.

^ Sched H \ N568

Federal tax withheld

Federal income tax withheld from total cash wages
paid to household employees during the year.

Help W-2 \ H458

Form W-2 - Wages earned and taxes withheld

Form W-2 is used by your employer to report the
amount of wages and other compensation you ear-
ned as an employee, and the amount of federal and
state taxes withheld and fringe benefits received.
Use a separate copy of Form W-2 for each employer.

^ W-2 \ N461

Federal tax withheld, self

The amount of Federal income tax withheld from
your wages for the year.

^ W-2 \ N507

Federal tax withheld, spouse

The amount of Federal income tax withheld from
your spouse’s wages for the year.

^ W-2 \ N463

Local tax withheld, self

The amount of local taxes withheld from your wa-
ges.

^ W-2 \ N509

Local tax withheld, spouse

The amount of local taxes withheld from your
spouse’s wages.

^ W-2 \ N480

Medicare tax withheld, self

The amount of Medicare taxes withheld from your
wages.

^ W-2 \ N510

Medicare tax withheld, spouse

The amount of Medicare taxes withheld from your
spouse’s wages.

^ W-2 \ N462

Social Security tax withheld, self

The amount of social security taxes withheld from
your wages.

^ W-2 \ N508

Social Security tax withheld, spouse

The amount of social security taxes withheld from
your spouse’s wages.

^ W-2 \ N464

State tax withheld, self

The amount of state taxes withheld from your wa-
ges.

^ W-2 \ N511

State tax withheld, spouse

The amount of state taxes withheld from your
spouse’s wages.

Help W-2G \ H547 Form W-2G is used to report certain gambling win-
nings.
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Form W-2G - gambling winnings

^ W-2G \ N550

Federal tax withheld

The amount of federal income taxes withheld from
gross gambling winnings.

^ W-2G \ N551

State tax withheld

The amount of state income taxes withheld from
gross gambling winnings.

Ripristina avvisi...
GnuCash visualizza degli avvisi quando si cerca di effettuare determinate operazioni, come rimuovere una
transazione o le suddivisioni da una transazione. La finestra di avviso presenta l’opzione di non visualizzare
più questi messaggi alla ripetizione dell’operazione. Le opzioni Ricordalo e non chiedermelo di nuovo e
Ricordalo e non chiedermelo di nuovo in questa sessione, permettono di disabilitarli. L’opzione Ripristina
avvisi permette di ripristinare gli avvisi predefiniti, cioè abilita la visualizzazione dei messaggi. Gli avvisi
possono essere abilitati in modo selettivo.

Cambiare la lingua
La lingua dell’interfaccia di GnuCash non è direttamente modificabile dalle preferenze del programma.

Il metodo per cambiare lingua del programma dipende dal sistema operativo in cui GnuCash viene ese-
guito.

Linux In genere è necessario impostare le variabili di sistema LANGUAGE e LANG prima
di avviare GnuCash. Per farlo occorre aprire una finestra di terminale ed eseguire
il seguente comando:

LANGUAGE=ll_LL LANG=ll_LL gnucash

ll_LL è la lingua con cui avviare GnuCash (de_DE per il tedesco, it_IT per
l'italiano ecc...)

Nota

In alcuni sistemi (per esempio Ubuntu) la codifica può far parte del nome,
come ll_LL.UTF-8.

MacOSX Per utilizzare una traduzione diversa da quella selezionata automaticamente, è pos-
sibile eseguire il seguente comando in Terminal.app:

defaults write $(mdls -name kMDItemCFBundleIdentifier -raw /Applica-
tions/GnuCash.app) AppleLanguages "(de, en)"

È possibile usare qualsiasi codice di lingua si desideri, in luogo di Tedesco (de) e
Inglese (en). Comunque, se il file per la traduzione non è presente, il comando non
funzionerà.

Per reimpostare i valori originali, eseguire:
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defaults delete $(mdls -name kMDItemCFBundleIdentifier -raw /Applica-
tions/GnuCash.app)

Finestre™ Se si sta eseguendo GnuCash 2.4.0 (o successivo) su Windows, è possibile impo-
stare la lingua dell’interfaccia modificando il file environment con un editor
di testo (per esempio Notepad). Di norma questo file è installato nella cartella c:
\Programmi\gnucash\etc\gnucash. Modificare il file in modo che le ul-
time righe siano come le seguenti:

# If you wish GnuCash to use a different language, uncomment the two parameters
# below and set LANG to your preferred locale
LANG=ll_LL
LANGUAGE={LANG}

ll_LL è la lingua con cui avviare GnuCash (de_DE per il tedesco, it_IT per
l'italiano ecc...)

Suggerimento

Maggiori e più aggiornate informazioni relative all’argomento possono essere reperite sulla pa-
gina delle impostazioni della lingua [http://wiki.gnucash.org/wiki/Locale_Settings] nel wiki di
GnuCash.

http://wiki.gnucash.org/wiki/Locale_Settings
http://wiki.gnucash.org/wiki/Locale_Settings
http://wiki.gnucash.org/wiki/Locale_Settings
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Appendice A. Suggerimenti e consigli
utili su GnuCash

Versione 1.0, dicembre 2006

Codici delle borse per i mercati Europei
Lista dei codici delle borse per i mercati Europei

Tabella A.1. Lista dei codici delle borse per i mercati Europei

Codice Mercato

BC Barcellona

BE Berlino

BI Bilbao

BR Brême

CO Copenhagen

D Dusseldorf

F Francoforte

DE Xetra (was FX)

H Hamburg

HA Hanover

L Londra

MA Madrid

MC Madrid (M.C.)

MI Milano

MU Monaco

O Oslo

PA Parigi

ST Stoccolma

SG Stuttgart

VA Valence

VI Vienna

Pseudo simboli da utilizzare per le quotazioni
TIAA-CREF

Tabella A.2. Pseudo simboli da utilizzare per le quotazioni TIAA-CREF

Nome Pseudo-simbolo

Mercato delle obbligazioni CREFbond
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Nome Pseudo-simbolo

Indice del capitale CREFequi

Capitali globali CREFglob

Growth CREFgrow

Obbligazioni legate all’inflazione CREFinfb

Mercato monetario CREFmony

Social Choice CREFsoci

Azioni CREFstok

Teachers PA Select Stock TIAAsele

Teachers PA Stock Index TIAAsndx

TIAA Real Estate TIAAreal

Fonti delle quotazioni - fonti individuali
Tabella A.3. Fonti individuali per le quotazioni

Nome

AEX

AEX Futures

AEX Options

AMFI India

ASE

ASX

BMO NesbittBurns

Deka Investments

DWS

Fidelity Direct

Finance Canada

First Trust Portfolios

Fund Library

Man Investments

Motley Fool

NZX

Platinum Asset Management

SEB

Sharenet

TD Waterhouse Canada

TD Efunds

TIAA-CREF

T. Rowe Price
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Nome

Trustnet

Union Investments

US Treasury Bonds

US Govt. Thrift Savings Plan

Vanguard

VWD

Yahoo

Yahoo Asia

Yahoo Australia

Yahoo Brasile

Yahoo Europa

Yahoo Nuova Zelanda

(Zuerich Investments. ??)

Fonti delle quotazioni - fonti multiple
Tabella A.4. Fonti multiple per le quotazioni

Nome

Asia (Yahoo, ...)

Australia (ASX, Yahoo, ...)

Brasile (Yahoo, ...)

Canada (Yahoo, ...)

Canada Mutual (Fund Library, ...)

Dutch (AEX, ...)

Europa (Yahoo, ...)

Grecia (ASE, ...)

India Mutual (AMFI, ...)

Fidelity (Fidelity, ...)

First Trust (First Trust, ...)

Nasdaq (Yahoo, ...)

Nuova Zelanda (Yahoo, ...)

NYSE (Yahoo, ...)

Sud Africa (Sharenet, ...)

T. Rowe Price

U.K. Unit Trusts

USA (Yahoo, Fool ...)
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Appendice B. GNU Free
Documentation License

Versione 1.1, marzo 2000
Diritto d'autore © 2000 Free Software Foundation, Inc.

Free Software Foundation, Inc. 59 Temple Place, Suite 330, Boston, MA02111-1307USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it
is not allowed.

0. PREAMBLE
The purpose of this License is to make a manual, textbook, or other written document «free» in the sense of
freedom: to assure everyone the effective freedom to copy and redistribute it, with or without modifying it,
either commercially or noncommercially. Secondarily, this License preserves for the author and publisher
a way to get credit for their work, while not being considered responsible for modifications made by others.

This License is a kind of «copyleft», which means that derivative works of the document must themselves
be free in the same sense. It complements the GNU General Public License, which is a copyleft license
designed for free software.

We have designed this License in order to use it for manuals for free software, because free software
needs free documentation: a free program should come with manuals providing the same freedoms that
the software does. But this License is not limited to software manuals; it can be used for any textual work,
regardless of subject matter or whether it is published as a printed book. We recommend this License
principally for works whose purpose is instruction or reference.

1. APPLICABILITY AND DEFINITIONS
This License applies to any manual or other work that contains a notice placed by the copyright holder
saying it can be distributed under the terms of this License. The «Document», below, refers to any such
manual or work. Any member of the public is a licensee, and is addressed as «you».

A «Modified Version» of the Document means any work containing the Document or a portion of it, either
copied verbatim, or with modifications and/or translated into another language.

A «Secondary Section» is a named appendix or a front-matter section of the Document [139] that deals
exclusively with the relationship of the publishers or authors of the Document to the Document’s overall
subject (or to related matters) and contains nothing that could fall directly within that overall subject. (For
example, if the Document is in part a textbook of mathematics, a Secondary Section may not explain any
mathematics.) The relationship could be a matter of historical connection with the subject or with related
matters, or of legal, commercial, philosophical, ethical or political position regarding them.

The «Invariant Sections» are certain  Secondary Sections [139] whose titles are designated, as being
those of Invariant Sections, in the notice that says that the Document [139] is released under this License.

The «Cover Texts» are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover
Texts, in the notice that says that the Document [139] is released under this License.

A «Transparent» copy of the  Document [139] means a machine-readable copy, represented in a format
whose specification is available to the general public, whose contents can be viewed and edited directly
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and straightforwardly with generic text editors or (for images composed of pixels) generic paint programs
or (for drawings) some widely available drawing editor, and that is suitable for input to text formatters or
for automatic translation to a variety of formats suitable for input to text formatters. A copy made in an
otherwise Transparent file format whose markup has been designed to thwart or discourage subsequent
modification by readers is not Transparent. A copy that is not «Transparent» is called «Opaque».

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input
format, LaTeX input format, SGML or XML using a publicly available DTD, and standard-conforming
simple HTML designed for human modification. Opaque formats include PostScript, PDF, proprietary
formats that can be read and edited only by proprietary word processors, SGML or XML for which the
DTD and/or processing tools are not generally available, and the machine-generated HTML produced by
some word processors for output purposes only.

The «Title Page» means, for a printed book, the title page itself, plus such following pages as are needed
to hold, legibly, the material this License requires to appear in the title page. For works in formats which
do not have any title page as such, «Title Page» means the text near the most prominent appearance of the
work’s title, preceding the beginning of the body of the text.

2. VERBATIM COPYING
You may copy and distribute the Document [139] in any medium, either commercially or noncommer-
cially, provided that this License, the copyright notices, and the license notice saying this License applies
to the Document are reproduced in all copies, and that you add no other conditions whatsoever to those of
this License. You may not use technical measures to obstruct or control the reading or further copying of
the copies you make or distribute. However, you may accept compensation in exchange for copies. If you
distribute a large enough number of copies you must also follow the conditions in section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display copies.

3. COPYING IN QUANTITY
If you publish printed copies of the Document [139] numbering more than 100, and the Document’s
license notice requires Cover Texts [139], you must enclose the copies in covers that carry, clearly
and legibly, all these Cover Texts: Front-Cover Texts on the front cover, and Back-Cover Texts on the
back cover. Both covers must also clearly and legibly identify you as the publisher of these copies. The
front cover must present the full title with all words of the title equally prominent and visible. You may
add other material on the covers in addition. Copying with changes limited to the covers, as long as they
preserve the title of the Document [139] and satisfy these conditions, can be treated as verbatim copying
in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the first ones listed
(as many as fit reasonably) on the actual cover, and continue the rest onto adjacent pages.

If you publish or distribute Opaque [139] copies of the Document [139] numbering more than 100,
you must either include a machine-readable Transparent [139] copy along with each Opaque copy, or
state in or with each Opaque copy a publicly-accessible computer-network location containing a complete
Transparent copy of the Document, free of added material, which the general network-using public has
access to download anonymously at no charge using public-standard network protocols. If you use the
latter option, you must take reasonably prudent steps, when you begin distribution of Opaque copies in
quantity, to ensure that this Transparent copy will remain thus accessible at the stated location until at least
one year after the last time you distribute an Opaque copy (directly or through your agents or retailers)
of that edition to the public.



GNU Free Documentation License

141

It is requested, but not required, that you contact the authors of the Document [139] well before redi-
stributing any large number of copies, to give them a chance to provide you with an updated version of
the Document.

4. MODIFICATIONS
You may copy and distribute a Modified Version [139] of the Document [139] under the conditions
of sections 2 and 3 above, provided that you release the Modified Version under precisely this License,
with the Modified Version filling the role of the Document, thus licensing distribution and modification
of the Modified Version to whoever possesses a copy of it. In addition, you must do these things in the
Modified Version:

• A. Use in the Title Page [140] (and on the covers, if any) a title distinct from that of the Docu-
ment [139], and from those of previous versions (which should, if there were any, be listed in the
History section of the Document). You may use the same title as a previous version if the original pu-
blisher of that version gives permission.

• B. List on the Title Page [140], as authors, one or more persons or entities responsible for author-
ship of the modifications in the Modified Version [139], together with at least five of the principal
authors of the Document [139] (all of its principal authors, if it has less than five).

• C. State on the Title Page [140] the name of the publisher of the Modified Version [139], as
the publisher.

• D. Preserve all the copyright notices of the Document [139].

• E. Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.

• F. Include, immediately after the copyright notices, a license notice giving the public permission to
use the Modified Version [139] under the terms of this License, in the form shown in the Addendum
below.

• G. Preserve in that license notice the full lists of  Invariant Sections [139] and required Cover
Texts [139] given in the Document’s [139] license notice.

• H. Include an unaltered copy of this License.

• I. Preserve the section entitled «History», and its title, and add to it an item stating at least the title,
year, new authors, and publisher of the Modified Version  [139]as given on the Title Page [140]. If
there is no section entitled «History» in the Document [139], create one stating the title, year, authors,
and publisher of the Document as given on its Title Page, then add an item describing the Modified
Version as stated in the previous sentence.

• J. Preserve the network location, if any, given in the Document [139] for public access to a Trans-
parent [139] copy of the Document, and likewise the network locations given in the Document for
previous versions it was based on. These may be placed in the «History» section. You may omit a net-
work location for a work that was published at least four years before the Document itself, or if the
original publisher of the version it refers to gives permission.

• K. In any section entitled «Acknowledgements» or «Dedications», preserve the section’s title, and
preserve in the section all the substance and tone of each of the contributor acknowledgements and/or
dedications given therein.

• L. Preserve all the Invariant Sections [139] of the Document [139], unaltered in their text and
in their titles. Section numbers or the equivalent are not considered part of the section titles.
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• M. Delete any section entitled «Endorsements». Such a section may not be included in the Modified
Version [139].

• N. Do not retitle any existing section as «Endorsements» or to conflict in title with any Invariant
Section [139].

If the Modified Version [139] includes new front-matter sections or appendices that qualify as Seconda-
ry Sections [139] and contain no material copied from the Document, you may at your option designate
some or all of these sections as invariant. To do this, add their titles to the list of Invariant Sections [139]
in the Modified Version’s license notice. These titles must be distinct from any other section titles.

You may add a section entitled «Endorsements», provided it contains nothing but endorsements of your
Modified Version [139] by various parties--for example, statements of peer review or that the text has
been approved by an organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text [139], and a passage of up to 25
words as a Back-Cover Text [139], to the end of the list of Cover Texts [139] in the Modified Ver-
sion [139]. Only one passage of Front-Cover Text and one of Back-Cover Text may be added by (or
through arrangements made by) any one entity. If the Document [139] already includes a cover text
for the same cover, previously added by you or by arrangement made by the same entity you are acting
on behalf of, you may not add another; but you may replace the old one, on explicit permission from the
previous publisher that added the old one.

The author(s) and publisher(s) of the Document [139] do not by this License give permission to use
their names for publicity for or to assert or imply endorsement of any Modified Version  [139].

5. COMBINING DOCUMENTS
You may combine the Document [139] with other documents released under this License, under the
terms defined in section 4 above for modified versions, provided that you include in the combination all of
the Invariant Sections [139] of all of the original documents, unmodified, and list them all as Invariant
Sections of your combined work in its license notice.

The combined work need only contain one copy of this License, and multiple identical Invariant Sec-
tions [139] may be replaced with a single copy. If there are multiple Invariant Sections with the same
name but different contents, make the title of each such section unique by adding at the end of it, in pa-
rentheses, the name of the original author or publisher of that section if known, or else a unique number.
Make the same adjustment to the section titles in the list of Invariant Sections in the license notice of the
combined work.

In the combination, you must combine any sections entitled «History» in the various original documents,
forming one section entitled «History»; likewise combine any sections entitled «Acknowledgements», and
any sections entitled «Dedications». You must delete all sections entitled «Endorsements.»

6. COLLECTIONS OF DOCUMENTS
You may make a collection consisting of the Document [139] and other documents released under this
License, and replace the individual copies of this License in the various documents with a single copy that
is included in the collection, provided that you follow the rules of this License for verbatim copying of
each of the documents in all other respects.

You may extract a single document from such a collection, and dispbibute it individually under this Li-
cense, provided you insert a copy of this License into the extracted document, and follow this License in
all other respects regarding verbatim copying of that document.
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7. AGGREGATION WITH INDEPENDENT WOR-
KS

A compilation of the Document [139] or its derivatives with other separate and independent documents
or works, in or on a volume of a storage or distribution medium, does not as a whole count as a Modified
Version [139] of the Document, provided no compilation copyright is claimed for the compilation. Such
a compilation is called an «aggregate», and this License does not apply to the other self-contained works
thus compiled with the Document , on account of their being thus compiled, if they are not themselves
derivative works of the Document. If the Cover Text [139] requirement of section 3 is applicable to
these copies of the Document, then if the Document is less than one quarter of the entire aggregate, the
Document’s Cover Texts may be placed on covers that surround only the Document within the aggregate.
Otherwise they must appear on covers around the whole aggregate.

8. TRANSLATION
Translation is considered a kind of modification, so you may distribute translations of the Docu-
ment [139] under the terms of section 4. Replacing  Invariant Sections [139] with translations requi-
res special permission from their copyright holders, but you may include translations of some or all Inva-
riant Sections in addition to the original versions of these Invariant Sections. You may include a translation
of this License provided that you also include the original English version of this License. In case of a
disagreement between the translation and the original English version of this License, the original English
version will prevail.

9. TERMINATION
You may not copy, modify, sublicense, or distribute the Document [139] except as expressly provided
for under this License. Any other attempt to copy, modify, sublicense or distribute the Document is void,
and will automatically terminate your rights under this License. However, parties who have received co-
pies, or rights, from you under this License will not have their licenses terminated so long as such parties
remain in full compliance.

10. FUTURE REVISIONS OF THIS LICENSE
The Free Software Foundation [http://www.gnu.org/fsf/fsf.html] may publish new, revised versions of the
GNU Free Documentation License from time to time. Such new versions will be similar in spirit to the
present version, but may differ in detail to address new problems or concerns. See http://www.gnu.org/
copyleft/ [http://www.gnu.org/copyleft].

Each version of the License is given a distinguishing version number. If the Document [139] specifies
that a particular numbered version of this License «or any later version» applies to it, you have the option
of following the terms and conditions either of that specified version or of any later version that has been
published (not as a draft) by the Free Software Foundation. If the Document does not specify a version
number of this License, you may choose any version ever published (not as a draft) by the Free Software
Foundation.

Addendum
To use this License in a document you have written, include a copy of the License in the document and
put the following copyright and license notices just after the title page:

http://www.gnu.org/fsf/fsf.html
http://www.gnu.org/fsf/fsf.html
http://www.gnu.org/copyleft
http://www.gnu.org/copyleft
http://www.gnu.org/copyleft
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Copyright Cristian Marchi, 2011

Permission is granted to copy, distribute and/or modify this document under the terms
of the GNU Free Documentation License, Version 1.1 or any later version published by
the Free Software Foundation; with the Invariant Sections [139] being LIST THEIR
TITLES, with the Front-Cover Texts [139] being LIST, and with the Back-Cover
Texts [139] being LIST. A copy of the license is included in the section entitled «GNU
Free Documentation License».

If you have no Invariant Sections [139], write «with no Invariant Sections» instead of saying which
ones are invariant. If you have no Front-Cover Texts [139], write «no Front-Cover Texts» instead of
«Front-Cover Texts being LIST»; likewise for Back-Cover Texts [139].

If your document contains nontrivial examples of program code, we recommend releasing these examples
in parallel under your choice of free software license, such as the  GNU General Public License [http://
www.gnu.org/copyleft/gpl.html], to permit their use in free software.

http://www.gnu.org/copyleft/gpl.html
http://www.gnu.org/copyleft/gpl.html
http://www.gnu.org/copyleft/gpl.html
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